
  

  

  

  

  

  

 

  

  

  

COMMUNITY PANELS USER GUIDE 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 C14 Revision 5 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- ii - 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Copyright © 2009 by Confirmit. All Rights Reserved. 

This document is intended only for registered Confirmit clients. No part of the contents of this document 
may be reproduced or transmitted in any form or by any means without the prior written permission of 
Confirmit. 

Confirmit makes no representations or warranties regarding the contents of this manual, and specifically 
disclaims any implied warranties of merchantability or fitness for any particular purpose. The information 
in this manual is subject to change without notice. 

The companies, names and data used or described in the examples herein are fictitious. 

The information herein describes Confirmit Community Panels and its features as of November 2009. New 
features may be introduced into Confirmit Community Panels after this date. Go to www.confirmit.com or 
check “News” on the Customer Extranet for the latest updates. 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- iii - 

Table of Contents 

Table of Contents ........................................................................................................................... 3 

What’s New in this Issue? .............................................................................................................. 8 

1. Introduction ................................................................................................................................. 1 
1.1. Recommended Limits ............................................................................................................ 1 

2. General Information ................................................................................................................... 3 
2.1. How to Access Community Panels ........................................................................................ 3 
2.2. The Search Facility ................................................................................................................ 3 
2.3. Password Policy .................................................................................................................... 4 

3. The Menus ................................................................................................................................... 6 
3.1. The Panel Setup Menu .......................................................................................................... 6 
3.2. The Panel Utilities Menu ........................................................................................................ 6 
3.3. The Panel Management Menu .............................................................................................. 7 
3.4. The Sample Management Menu ........................................................................................... 7 

4. The Panel Setup Menu ............................................................................................................... 9 
4.1. Designer ................................................................................................................................ 9 

4.1.1. The Panel Variables Toolbox ........................................................................................ 10 
4.1.1.1. How to Add an Object to the Tree .......................................................................... 10 
4.1.1.2. How to Delete an Object from the Tree ................................................................. 11 
4.1.1.3. How to Undelete an Object .................................................................................... 11 
4.1.1.4. The Survey History > Core Fields .......................................................................... 11 

4.1.2. The New Objects Toolbox ............................................................................................ 11 
4.1.3. The Secondary Project Toolbox ................................................................................... 12 
4.1.4. The Question Details Page ........................................................................................... 13 

4.1.4.1. Question Properties ............................................................................................... 13 
4.1.4.2. Characteristic ......................................................................................................... 15 

4.2. Database Generation........................................................................................................... 15 
4.3. Community Panel Definition Export ..................................................................................... 16 

4.3.1. How to Export a Panel Definition .................................................................................. 16 
4.3.2. How to Import a Panel Definition .................................................................................. 16 

4.4. Designer Log ....................................................................................................................... 16 
4.5. Active Languages ................................................................................................................ 17 
4.6. Legacy Jobs Import ............................................................................................................. 17 

5. The Panel Utilities Menu .......................................................................................................... 19 
5.1. Overview .............................................................................................................................. 19 

5.1.1. The General Tab ........................................................................................................... 19 
5.1.1.1. The Project Tasks Page ........................................................................................ 21 

5.1.2. The Permissions Tab .................................................................................................... 22 
5.1.2.1. How to Add Users to the Permissions Tab ............................................................ 23 
5.1.2.2. How to Remove Users from the Permissions Tab ................................................. 24 
5.1.2.3. Access Permission Levels ..................................................................................... 24 

5.1.3. The Active Languages Tab ........................................................................................... 24 
5.2. Community Portals .............................................................................................................. 25 

5.2.1. Accessing Community Portals ...................................................................................... 25 
5.2.2. How to Add a Community Portal to your Panel ............................................................. 26 

5.2.2.1. How to Create a New Community Portal for a Panel ............................................. 26 
5.2.2.2. How to Import a Community Portal ........................................................................ 26 
5.2.2.3. How to Set a Portal as Default ............................................................................... 27 
5.2.2.4. How to make the Portal Dynamic ........................................................................... 27 

5.2.3. Community Portal Languages ...................................................................................... 28 
5.2.3.1. How to Add a Language to the Portal .................................................................... 28 
5.2.3.2. How to make the Portal Language Dynamic .......................................................... 30 

5.2.4. The Community Portal Designer ................................................................................... 31 
5.2.4.1. The Page Masters Folder ...................................................................................... 32 
5.2.4.2. The Themes Folder ............................................................................................... 33 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- iv - 

5.2.4.3. Styles ..................................................................................................................... 37 
5.2.4.4. View Stylesheet Contents ...................................................................................... 38 
5.2.4.5. The Pages Folder .................................................................................................. 39 
5.2.4.6. Visual Components ................................................................................................ 43 
5.2.4.7. The Visual Components Toolbox ........................................................................... 46 

5.2.5. Properties on a Community Portal ................................................................................ 51 
5.2.5.1. Managing your Community Portals ........................................................................ 52 
5.2.5.2. Editing your Page Masters and Portal Pages ........................................................ 54 

5.3. Panel Activity Log ................................................................................................................ 57 
5.3.1. The Overview Tab ........................................................................................................ 57 
5.3.2. The Activity Logs Tab ................................................................................................... 57 
5.3.3. The Logging Details Page ............................................................................................ 58 

5.4. Database Cleanup ............................................................................................................... 59 
5.5. Survey Synchronization ....................................................................................................... 60 

5.5.1. Closing Surveys ............................................................................................................ 60 

6. The Panel Management Menu ................................................................................................. 61 
6.1. Single Panelist Editor ........................................................................................................... 61 

6.1.1. Search .......................................................................................................................... 61 
6.1.2. Select Columns............................................................................................................. 61 
6.1.3. Advanced Filter ............................................................................................................. 62 
6.1.4. Clear Advanced Filter ................................................................................................... 63 
6.1.5. The Panelist Editor Tabs .............................................................................................. 63 

6.1.5.1. The Details Tab ..................................................................................................... 63 
6.1.5.2. The All Surveys Tab .............................................................................................. 64 
6.1.5.3. The Completed Surveys Tab ................................................................................. 65 
6.1.5.4. The Surveys Started Not Completed Tab .............................................................. 65 
6.1.5.5. The Surveys Not Started Tab ................................................................................ 65 

6.2. Multiple Panelist Editor ........................................................................................................ 65 
6.3. Current Rule ........................................................................................................................ 68 

6.3.1. The General Tab ........................................................................................................... 68 
6.3.2. The Source Tab ............................................................................................................ 69 

6.3.2.1. Source Type > File................................................................................................. 69 
6.3.2.2. Source Type > Database ....................................................................................... 71 
6.3.2.3. Source Type > Panel Database ............................................................................. 71 
6.3.2.4. Source Type > Survey ........................................................................................... 72 
6.3.2.5. Source Type > BitStream Files .............................................................................. 73 

6.3.3. The Action Tab ............................................................................................................. 74 
6.3.3.1. The Code Completion Functionality ....................................................................... 75 
6.3.3.2. The Script Tab ....................................................................................................... 75 
6.3.3.3. The Global Variables Tab ...................................................................................... 75 
6.3.3.4. The Global Script Tab ............................................................................................ 76 
6.3.3.5. The Post Script Tab ............................................................................................... 76 

6.3.4. The Target Tab ............................................................................................................. 77 
6.3.4.1. Target Type > File.................................................................................................. 77 
6.3.4.2. Target Type > Database ........................................................................................ 78 
6.3.4.3. Target Type > BitStream Files ............................................................................... 78 
6.3.4.4. Target Type > Panel Database .............................................................................. 78 
6.3.4.5. Target Type > None ............................................................................................... 79 
6.3.4.6. Target Type > Snapshot Database ........................................................................ 79 

6.3.5. How to Duplicate a Rule ............................................................................................... 79 
6.3.6. How to Execute a Rule ................................................................................................. 80 
6.3.7. Validating an Action Script ............................................................................................ 80 
6.3.8. How to Export a Rule .................................................................................................... 80 

6.4. Current Rule Set .................................................................................................................. 81 
6.4.1. The General Tab ........................................................................................................... 81 
6.4.2. The Rule Management Tab .......................................................................................... 82 

6.4.2.1. How to Add a Rule to the Rule Set ........................................................................ 82 
6.4.3. The Report Tab ............................................................................................................. 83 

6.5. Rule List ............................................................................................................................... 84 
6.5.1. How to Create a New Rule ........................................................................................... 85 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- v - 

6.5.2. How to Import a Rule .................................................................................................... 86 
6.6. Rule Set List ........................................................................................................................ 86 

6.6.1. How to Create a New Rule Set ..................................................................................... 87 
6.7. Aggregated Variable List ..................................................................................................... 87 

6.7.1. How to Create a New Aggregated Variable .................................................................. 87 
6.8. Panelist Credits ................................................................................................................... 89 

6.8.1. How to Export Panelist Credits ..................................................................................... 89 
6.8.2. How to Import Panelist Credits ..................................................................................... 89 

6.9. The Panel Settings .............................................................................................................. 90 

7. The Sample Management Menu .............................................................................................. 93 
7.1. Current Job .......................................................................................................................... 93 

7.1.1. The Job Information Tab ............................................................................................... 94 
7.1.1.1. The Tool bar .......................................................................................................... 94 
7.1.1.2. The Data Fields and Areas .................................................................................... 94 
7.1.1.3. Procedures in the Job Information Tab .................................................................. 95 

7.1.2. The Exclusions Tab ...................................................................................................... 97 
7.1.2.1. The Auto Exclusion Tab ......................................................................................... 98 
7.1.2.2. The Manual Exclusion Tab .................................................................................... 99 
7.1.2.3. Procedures in the Exclusions Tab ....................................................................... 100 

7.1.3. The Filter Tab ............................................................................................................. 106 
7.1.3.1. The Data Fields ................................................................................................... 106 
7.1.3.2. Procedures in the Filter Tab................................................................................. 107 

7.1.4. The Sample Definition Tab ......................................................................................... 108 
7.1.4.1. The Right-Click Menu .......................................................................................... 109 
7.1.4.2. The Sub Samples Folder Editor Page ................................................................. 109 
7.1.4.3. The Sub Sample Editor Page .............................................................................. 110 
7.1.4.4. The Group Set Editor Page.................................................................................. 111 
7.1.4.5. Procedures in the Sample Definition Tab ............................................................ 112 

7.1.5. The Sample File Fields Tab ........................................................................................ 115 
7.1.5.1. The Sample File Fields Tab Toolbar .................................................................... 116 
7.1.5.2. Procedures in the Sample File Fields Tab ........................................................... 116 

7.1.6. The Execution Tab ...................................................................................................... 117 
7.1.6.1. The Job Execution Area ...................................................................................... 118 
7.1.6.2. The Job Runs Area .............................................................................................. 119 
7.1.6.3. Procedures in the Execution Tab ......................................................................... 119 
7.1.6.4. After the Job has been Executed ......................................................................... 128 
7.1.6.5. The Task Definition Properties Dialog ................................................................. 132 

7.1.7. The Reporting Tab ...................................................................................................... 133 
7.1.7.1. The Job Reporting Area ....................................................................................... 133 
7.1.7.2. The Job Runs Area .............................................................................................. 136 

7.2. Current Matrix .................................................................................................................... 141 
7.2.1. The General Tab ......................................................................................................... 141 
7.2.2. The Dimensions Tab ................................................................................................... 142 

7.2.2.1. Nominal Collapsing .............................................................................................. 144 
7.2.2.2. Ordinal Collapsing ............................................................................................... 144 
7.2.2.3. Non-Collapsing Adjust Targets ............................................................................ 145 
7.2.2.4. Non-Collapsing Keep Targets .............................................................................. 145 

7.2.3. The Weights Tab ........................................................................................................ 145 
7.2.4. The Report Tab ........................................................................................................... 147 
7.2.5. Procedures in the Current Matrix Tab ......................................................................... 148 

7.2.5.1. How to Duplicate a Matrix .................................................................................... 148 
7.2.5.2. How to Validate a Matrix ...................................................................................... 148 
7.2.5.3. How to Create a New Dimension ......................................................................... 148 
7.2.5.4. How to Create a Weight Set ................................................................................ 150 
7.2.5.5. How to Delete a Weight Set ................................................................................. 151 
7.2.5.6. How to Export a Matrix ........................................................................................ 151 

7.3. Job List .............................................................................................................................. 152 
7.3.1. The Job List Filters ..................................................................................................... 152 
7.3.2. The Job List Toolbar ................................................................................................... 153 
7.3.3. Procedures in the Job List Window ............................................................................. 153 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- vi - 

7.3.3.1. How to Create a New Job .................................................................................... 153 
7.3.3.2. How to Import a Job ............................................................................................. 154 
7.3.3.3. How to Delete a Job ............................................................................................ 154 

7.4. Active Job List ................................................................................................................... 155 
7.4.1. The Search Fields ....................................................................................................... 155 
7.4.2. The List Columns ........................................................................................................ 155 
7.4.3. The Active Job Details Page ....................................................................................... 155 

7.5. Matrix List .......................................................................................................................... 156 
7.5.1. Procedures in the Matrix List Window ......................................................................... 157 

7.5.1.1. How to Create a New Matrix ................................................................................ 157 
7.5.1.2. How to Import a Matrix ......................................................................................... 158 

7.6. Scheduling ......................................................................................................................... 159 
7.6.1. The Sampling Jobs List .............................................................................................. 159 
7.6.2. The Inactive List.......................................................................................................... 160 
7.6.3. Procedures in the Scheduling Window ....................................................................... 161 

7.6.3.1. How to Abort Execution of a Sampling Job .......................................................... 161 
7.6.3.2. How to Change the Job Schedule Settings ......................................................... 161 

7.7. Concurrent Sampling ......................................................................................................... 162 
7.7.1. Background ................................................................................................................ 162 
7.7.2. The Concurrent Sampling Window ............................................................................. 162 
7.7.3. How to Run a Concurrent Sampling Job ..................................................................... 163 

7.7.3.1. The Execute Job Properties................................................................................. 163 
7.8. Multiple Sample Upload ..................................................................................................... 164 
7.9. Tester Template List .......................................................................................................... 165 

7.9.1. How to Create a New Tester Template ....................................................................... 165 
7.10. Sampling Settings ............................................................................................................ 166 

7.10.1. The General Tab ....................................................................................................... 167 
7.10.2. Refresh Survey History Job Information ................................................................... 169 
7.10.3. The Categorization Tree Tab .................................................................................... 169 

7.10.3.1. How to Add Groups and Categories to a Panel ................................................. 169 
7.10.4. The Property Definitions Tab .................................................................................... 170 

7.10.4.1. How to Create a New Property Definition .......................................................... 171 
7.10.4.2. How to Define a Property Item ........................................................................... 171 

7.10.5. The Sample File Field Templates Tab ...................................................................... 171 
7.10.5.1. How to Create a New Template Definition ......................................................... 172 

7.10.6. The Survey Rule Templates Tab .............................................................................. 172 
7.10.6.1. How to Create a New Survey Rule Template .................................................... 172 

8. The Snapshot Panel ............................................................................................................... 174 
8.1. How to Create a Snapshot Panel ...................................................................................... 174 
8.2. How to Set Up and Run a Snapshot Task ......................................................................... 175 

9. The Reporting Menu ............................................................................................................... 178 
9.1. Report List ......................................................................................................................... 178 

9.1.1. The Report > General Tab .......................................................................................... 178 
9.1.2. The Report > View Tab ............................................................................................... 179 
9.1.3. MS Report Builder ...................................................................................................... 180 

9.1.3.1. Installing MS Report Builder ................................................................................ 180 
9.1.4. How to Create a New Report ...................................................................................... 181 
9.1.5. Create Default Reports ............................................................................................... 183 

9.2. Cube Management ............................................................................................................ 183 
9.2.1. OLAP Cubes ............................................................................................................... 184 
9.2.2. The Cube Details > General Tab ................................................................................ 184 
9.2.3. The Cube Details > Dimensions Tab .......................................................................... 185 
9.2.4. The Cube Details > Measures Tab ............................................................................. 185 
9.2.5. How to Create or Edit a Cube ..................................................................................... 186 

10. Changes Made to the Survey ............................................................................................... 191 
10.1. How to Attach a Panel to the Survey ............................................................................... 191 
10.2. Registering a New Panelist .............................................................................................. 191 

10.2.1. Checking for Previous Registration ........................................................................... 192 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- vii - 

10.2.2. Updating the Information .......................................................................................... 192 
10.2.3. Removing the Respondent Data from the Survey..................................................... 193 

10.3. Updating Existing Panelist Information ............................................................................ 193 
10.3.1. Fetching the Existing Information .............................................................................. 193 
10.3.2. Updating the Existing Information ............................................................................. 194 
10.3.3. Remove the Respondent Data from the Survey ....................................................... 194 

10.4. Updating the Survey History Variables ............................................................................ 194 
10.5. Standard Surveys Associated with a Panel ..................................................................... 194 

INDEX .......................................................................................................................................... 196 
 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- viii - 

What’s New in this Issue? 

Changes in this revision of the Confirmit Community Panels User Guide are as follows: 

• The text in the Page Masters Folder section is corrected  (go to The Page Masters Folder on page 32 for 
more information). 

• The tab descriptions under Single Panelist Editor have been edited (go to The Panelist Editor Tabs on 
page 63 for more information). 

  

Note: The general layout and language in this document is continually being corrected, adjusted and 
improved to ensure the user has the best possible source of information. Only NEW information and 
details of functionality that has changed since the previous issue are listed here - minor corrections to 
the text and document layout are not listed. 

Important 
We need your feedback so we can improve this document and provide you with the information you 
require. If you have any comments or constructive criticism concerning the content or layout of this 
documentation, please send an email to documentation@confirmit.com. Please include in your email the 
section number and/or heading text of the section to which your comment applies. 
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1. Introduction 
Collecting feedback via the Internet gives tremendous possibilities. You can interview your employees and your 
customers, and conduct surveys towards your markets, for example mapping the profiles of the people visiting 
your website. Within the Market Research industry, many agencies also use Panels to collect data and conduct 
research. 

A panel is a group of people, possibly several million, who have agreed to be available to answer surveys. When 
a prospective panelist first registers in the panel, he/she will typically answer a registration survey that will log 
personal and other information such as work-related and household details. This information will allow the 
research company to pick out of the panel samples of panelists who are suitable to answer particular surveys. For 
example, if you are conducting a marketing survey for a client company that manufactures dog food, you will 
probably wish to include only dog-owners in your sample. You can import people directly into the panel if you 
already have their information. 

In Confirmit you can build a library of panelist interfaces, called Community Portals, through which registered and 
potential panelists can read about your panels and register themselves if necessary. Those who are already 
registered (members) can log into the Community Portal to answer new or previously started surveys, view their 
survey list, update their profile, view their points etc. All these actions are conducted via the same interface. 

A Panel can also be used by a company to hold information about its employees and/or customers. You can then 
send specific people surveys based on the information in the Panel. For example, if you want to send a seminar 
registration survey to all employees working in a particular city and a particular department, and who have not 
already attended that seminar, then the panel will give you a sample containing the people matching these 
criteria, and upload the list to the seminar registration survey. 

1.1. Recommended Limits 
Note: The Community Panels functionality includes no built-in limits. However, due to the time and 
resources used when processing large databases, you are strongly recommended to keep within the 
following maximum values: 

• Number of panelists – is dependent on the type of license you have: 

o On Premise - up to 10 million. 

o On Demand - up to 5 million. Panels larger than this must be approved in advance by the Confirmit On 
Demand Operations team - contact support@confirmit.com, or an On Premise installation should be 
considered. 

• Survey history – up to 100 million records. 

• Maximum number of variables – 1000. 

• Sampling (Memory on batch server, read from BitStream server and SQL server) – a maximum of 8 
dimensions. 

• Maximum number of cells in the sampling matrix – 100.000. This is calculated by: the number of segments 
per dimension, multiplied (e.g. if the matrix has 8 dimensions, where the number of segments is n1 in 
dimension 1, n2 in dimension 2 etc. the total number of cells will be n1*n2*n3*n4*n5*n6*n7*n8) = max 
100.000. 

• Be aware that large BitStream generations will use considerable server processing resources, and can 
cause delays for other users. Large BitStream generations should therefore be performed during off-peak 
hours. 

• BitStream file set generation affects the BitStream server during generation and sampling, and will affect 
the SQL server (reading) to a lesser degree. Therefore: 

o Limit the number of open text fields included when sampling. BitStream files should only include the 
fields to be used in filtering and sampling matrices, not the fields you need for the respondent file. 

o Open text fields that are to be part of the BitStream files should be limited to 4 characters. 

o Note that Open text fields are not supported as segments in the sampling matrix. 

o To optimize the panel database: use Boolean data types and numeric precodes whenever possible, 
and numeric ranges between 0 and 255 should be specified. 

• The “Panelist Registration Survey” flag in Project Overview should only be used for surveys used for 
panelists signing up for the panel and updating their profile. It must not be used regular data collection 
(research projects/surveys). 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 2 - 

• “Sample Only” surveys (add-on) are intended only for access panel providers that sell sample to 3rd 
parties, for surveys for which the access panel provider does not run the data collection. The surveys used 
to redirect panelists to external survey links and update status upon survey completion can contain up to 5 
additional questions (for example for rating the survey experience etc.), but are not to be used for regular 
additional data collection. 

Note: The actual limits will depend on the hardware configuration currently in use. Contact Confirmit 
Support for further information. 
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2. General Information 
2.1. How to Access Community Panels 
You have two ways of accessing the Community Panels functionality: 

• Go to the Home > Community Panels menu command. 

• Click the Community Panels item in the Quick Access pane. 

In both cases, the Community Panel List page opens. 

 

Figure 1  Example of the Community Panels List page 

This page lists the panels currently available to you. These may be panels that you have created or imported, or 
panels that others have created and given you permission to access. The panel details presented in this list are 
as follows: 

• Panel ID – the unique identification number for the panel. This is allocated automatically by Confirmit 
when the panel is first created. This is the link used to access the panel. 

• Panel Name – the identifying name of the panel, given by the person who created it. 

• Company – the company registered as the “owner” of the panel. 

• Created By – the name of the person who created the panel. 

• Created – the date and time the panel was created. 

• Keywords – you can register keywords for a panel to make it simpler to locate when the panel list is 
extensive. 

To open a panel, click on its blue Panel ID link. The Panel Overview page (go to Overview on page 19 for more 
information) (also accessible via the Panel Utilities > Overview menu command) for the selected panel opens. 

2.2. The Search Facility 
In an established company the list of registered panels may run into thousands, and a search through the list for 
the one panel that you wish to use could be time-consuming. Confirmit therefore provides you with a set of filters 
so you can reduce a long list to a manageable size. 

• Panel Category – Click the down arrow beside the field to open a drop-down list of the panel categories, 
select the appropriate category from the list and click Search. The list is reduced to only those panels that 
have the selected category. 

Note: You do not need to type the entire name or number into the appropriate field – in most cases the 
first few characters will tend to reduce the list considerably. 

• Panel ID – type in part or all of the required panel’s ID number. 
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• Panel Name – type in the company name.  

• Company – allows you to search for panels according to the company under which it is registered. 

• Created By – allows you to search for panels created by specific users. 

• Created– Select an operator and a date to search for, for example any panels created on or before a 
certain date. 

• Keywords – type a key word into the field to search for all panels with that word registered as a keyword. 

2.3. Password Policy 
As part of the continuous effort to ensure that Confirmit complies with the highest standards of security, the 
following password policy applies from the introduction of Confirmit 14, for end users (CAPI interviewers, report 
viewers, Analysts and Designers) and Authoring users (Express, Professional and Translator). 

General: 
System messages are provided (with translations to the usual common languages) for these settings. The 
appropriate error messages will be displayed when users choose passwords that do not comply with the site 
settings.  

In Confirmit Version 14, the Authoring (Express and Professional), Reportal and Community Portal modules all 
have ‘Forgotten Password’ functionality. This allows end users to trigger an email so they receive an activation 
link that opens a page where they can reset their password. Refer to the Confirmit Authoring User Guide for 
further details. 

All passwords are hashed and not transmitted in plain text. From Confirmit 14, passwords of panelists in 
Community Panel and Basic Panel will be also be hashed. Consequently, passwords will not be available in plain 
text for any system users. Instead, users will be sent an activation link to open a page where they can choose 
their own password.  

Panelists: 
The changes to the password policy for Panelists are optional, and users must actively enable the restrictions for 
Basic and Community Panels (go to The Panel Settings on page 90 for more information). Users may then define 
custom settings for a panel. Panelist passwords will be hashed, meaning that passwords will not be available in 
plain text. When panelists use the “Forgot password” feature, they will be sent an activation link which will open a 
page where they can reset their password.   

On-Demand users: 
The passwords for all areas of Confirmit must satisfy the same minimum requirements for complexity. Wherever 
passwords can be changed or set within the application, they will be validated against these rules before the 
change is accepted. The passwords will have to comply with these rules from the first time they are changed after 
the Confirmit 14 release. 

• Password history - the new password must be different from the last 12 passwords. 

• Minimum age - the user will have to wait 24 hours after changing the password before being allowed to 
change it again. 

• Maximum number of login attempts - after 5 invalid login attempts the account will be locked. The user 
will not be allowed to login again until the account is reactivated by the system administrator. 

• Uppercase characters - the password must contain at least 1 uppercase letter. 

• Non-alpha characters - the password must contain at least 1 character that is not a letter (a..z, A..Z). 

• Password length - the password must contain at least 8 characters. 

• Password expiry days - the password will expire after 60 days. (This will not apply for login to the CAPI 
console.) 

For Authoring users, it is possible to enforce even stricter requirements through certain company settings. Contact 
Confirmit support if you wish to implement a stricter policy.   

On-Premise users: 
The following configurable settings will be enforced for all On-Premise users with the release of Confirmit 14. If 
the Company Administrator selects to use the settings, users will have to comply with these settings when 
changing their password: 
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• Password history - the new password must be different from the last X passwords. 

• Minimum age - the user will have to wait X hours after changing the password before being allowed to 
change it again. 

• Maximum number of login attempts - after X invalid login attempts the account will be locked. The user 
will not be allowed to login again until the account is reactivated by the system administrator. 

• Non-alpha-numeric characters - a required minimum number of characters that are not numbers (0..9) 
or letters (a..z, A..Z). 

• Uppercase characters - a required minimum number of uppercase letters. 

• Non-alpha characters - a required minimum number of characters that are not letters (a..z, A..Z). 

• Password length - a required minimum number of characters in the password. 

• Password expiry days - the password will expire after a number of days. (This will not apply for login to 
the CAPI console.) 

• Password strength - in addition to a combination of the above settings, a regular expression may be 
used to enforce an even stricter policy. 

For Authoring users, it is possible to enforce even stricter requirements through certain company settings. The 
server documentation that will be provided with the release will contain more detail. 
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3. The Menus 
To open a panel, click on the blue Panel ID link in the Community Panel List. The Panel Overview page for the 
selected panel opens, and the Panel menus become available. 

3.1. The Panel Setup Menu 
The Panel Setup menu contains the menu commands required by the user while designing and editing the 
Community Portals database. 

Note: The design and creation of a Community Portal database is essentially the same as for a “normal” 
questionnaire database. This document therefore describes only the differences between a Community 
Portal database and a questionnaire database, and the additional procedures required. For further 
information on designing and creating a database, refer to the Confirmit Authoring User Manual. 

 

Figure 2  The Panel Setup menu commands 

The menu commands are as follows: 

• Designer – the database definition page (go to Designer on page 9 for more information). 

• Database Generation – generates and updates the database (go to Database Generation on page 15 for 
more information). 

• Community Panel Definition Export – export the database definition to another server (go to Community 
Panel Definition Export on page 16 for more information). 

• Designer Log – a “read-only” log of the main events occurring in the panel (go to Designer Log on page 
16 for more information). 

• Active Languages – select the languages to be used (go to Active Languages on page 17 for more 
information). 

3.2. The Panel Utilities Menu 
The Panel Utilities functions allow you to create and manage your panels. 

Once you have accessed the Community Panels functionality (go to How to Access Community Panels on page 3 
for more information) the Panel Utilities menu appears as shown below. 

 

Figure 3  The Panel Utilities menu commands 

The menu commands are as follows: 

• Overview – provides general information on the selected panel (go to Overview on page 19 for more 
information). 

• Community Portals – contains the commands you use to create and edit your Community Portals  (go to 
Community Portals on page 25 for more information). 

• Panel Activity Log – logs activity on the panel  (go to Panel Activity Log on page 57 for more 
information). 

• Database Cleanup – removes deleted questions from the Panel database  (go to Database Cleanup on 
page 59 for more information). 
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• Survey Synchronization – initiates a new task that checks all surveys associated with the current panel, 
and updates the panel if/when there are changes. This is to keep the panel data up-to-date so samples 
can be selected appropriately. This task can (should) be made recurring so it occurs automatically  (go to 
Survey Synchronization on page 60 for more information). 

3.3. The Panel Management Menu 
The Panel Management menu contains the commands used to create and edit the rules that define the panels 
and specify the panelists. 

 

Figure 4  The Panel Management menu commands 

The menu commands are as follows: 

• Single Panelist Editor – enables you to edit individual panelist’s details  (go to Single Panelist Editor on 
page 61 for more information). 

• Multiple Panelist Editor – enables you to edit the details of several/many panelists simultaneously  (go to 
Multiple Panelist Editor on page 65 for more information). 

• Current Rule – shows the details of the rule currently selected in the Rule List  (go to Current Rule on 
page 68 for more information). 

• Current Rule Set – provides details of the rule set currently selected in the Rule Set List  (go to Current 
Rule Set on page 81 for more information). 

• Rule List – displays a list of the available rules. Click on a rule to open it (go to Rule List on page 84 for 
more information). 

• Rule Set List – displays a list of the available rule sets  (go to Rule Set List on page 86 for more 
information). 

• Aggregated Variable List – lists variables you have created to be used in aggregate queries to update 
the Panelist table based on information in the Survey History table  (go to Aggregated Variable List on 
page 87 for more information). 

• Panelist Credits - allows you to import and export panelist credits (go to Panelist Credits on page 89 for 
more information). 

3.4. The Sample Management Menu 
A Sample is a group of panelists selected from the panel using sampling criteria. The sampling criteria are set 
such that the sample is suitable to be respondents for a particular survey. For example, a sample selected to 
reply to a survey produced on behalf of a car manufacturer might comprise of males between the ages of 20 and 
30 who live in a particular part of the country and who drive a particular make of car. 

The Sample Management functions allow you to create and manage samples. 

 

Figure 5  The Sample Management menu commands 

The menu commands are as follows: 

• Current Job – opens the Current Job window. This window provides general information about the 
selected job. Use this window to define and edit the criteria for the job  (go to Current Job on page 93 for 
more information). 

• Current Matrix – this window shows the details of the matrix currently selected in the Matrix List  (go to 
Current Matrix on page 141 for more information). 

• Job List – lists all the sampling jobs that you currently have “in progress”  (go to Job List on page 152 for 
more information). 
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• Active Job List – lists all the sampling jobs that are currently “in production”  (go to Active Job List on 
page 155 for more information). 

• Matrix List – lists all the matrices currently available in your Confirmit database  (go to Matrix List on page 
156 for more information). 

• Scheduling – lists the jobs that are awaiting execution and those that have been run (go to Scheduling on 
page 159 for more information). 

• Concurrent Sampling – enables you to run several sampling jobs simultaneously so scarce panelist 
resources can be allocated fairly across the jobs (go to Concurrent Sampling on page 162 for more 
information). 

• Multiple Sample Upload – enables you to upload several jobs simultaneously (go to Multiple Sample 
Upload on page 164 for more information). 

• Tester Template List – templates that enable you to add rows to the respondent database that you can 
then populate with “dummy” respondent information such that you can test the survey and the system 
setup before you send it out to the actual respondents  (go to Tester Template List on page 165 for more 
information). 

• Sampling Settings – allows you to set default values and rules for the panel  (go to Sampling Settings on 
page 166 for more information). 

The following chapters in this manual describe the menu commands’ functionality, and the processes and 
procedures conducted via these menu commands. The menu commands are described in the order in which they 
appear in the menus. 
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4. The Panel Setup Menu 
The Panel Setup menu contains the menu commands required by the user while designing and editing the 
Community Portals database. 

Note: The design and creation of a Community Portal database is essentially the same as for a “normal” 
questionnaire database. This chapter therefore describes only the differences between the functions, 
procedures and properties available when creating a Community Portal database and those available 
when creating a questionnaire database. For further information on designing and creating a database, 
refer to the Confirmit Authoring User Manual. 

 

Figure 6  The Panel Setup menu commands 

4.1. Designer 
Select this menu command to open the Designer page. Use this page to create and edit the panel database. The 
page is divided into two main areas: 

• The Toolbox column –the toolboxes that appear in the left column in the Designer page provide an 
overview of the panel database and the objects available for use while creating or editing it. The toolboxes 
are displayed and available throughout the process. The toolbox is divided into three sections: 

o The Panel Variables toolbox – shows the layout of the current database. Edit the database here, 
adding, deleting and/or moving objects as necessary. After any changes are made, the database must 
be re-generated (go to Database Generation on page 15 for more information). Note that each 
“question” in the Panel Variables toolbox will become a column in the database. 

o The New Objects toolbox – lists the objects you can use in the database. Drag and drop objects from 
here to the Panel Variables toolbox. 

o The Secondary Project toolbox - you have the possibility to copy questions from other panels into 
the current panel. This can be done in the Secondary Project toolbox. Projects in this toolbox will be 
displayed in Read Only mode. 

• The Question Details area – double-click on a question in the Panel Variables toolbox to show the details 
of that question in the Question Details area. Use the tabs and data fields in this area to set up each 
question in the database. 
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Figure 7  Example of the Professional Designer page 

For further information, refer to the Confirmit Authoring User Manual. 

4.1.1. The Panel Variables Toolbox 
This toolbox is where you create and edit the panel database. 

You build your database in the toolbox by creating Objects (questions, i.e. the database columns). All Objects 
placed between the survey name (here “User Manual Community Panel”) and the yellow “Scales and Lists” folder 
will be used in the database. The objects available for you to use are listed in the New Objects toolbox. The 
database columns will be listed in the order in which they are placed in this tree. 

4.1.1.1. How to Add an Object to the Tree 
There are five methods of creating objects: 

• Insert Inside – use to create the first question in a panel database, or to create an object inside another, 
typically folders. Right-click on the panel/folder name and choose Insert Inside, then select from the 
resulting list the object you wish to create. 

• Insert After – use to create objects in a project after an existing object. Right-click on the object after 
which you wish to create the new object, choose Insert After, then select from the resulting list the object 
you wish to create. 

• Drag and Drop – use standard Windows drag-and-drop techniques to copy objects from the New Object 
toolbox into the Panel Variables toolbox. 

• Duplicate – copies an existing question. This would be useful if you have two or more questions that are 
similar in layout and/or content. Create and set up the first question, then duplicate it and edit the copy as 
required. 

• Dragging/Copying from the Secondary Projects toolbox - you can copy questions into the current 
questionnaire by dragging them from the secondary project toolbox and dropping them into the 
questionnaire tree. Before copying, you can view the Secondary Project objects in Edit mode. 

You can use any of the above methods to create any object in the database. For further information, refer to the 
Confirmit Authoring User Manual. 
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4.1.1.2. How to Delete an Object from the Tree 
To delete an object, select it and press the <DEL> key on your keyboard, or right-click on the object and select 
Delete from the menu. This will remove the selected objects from the routing, and set the Deleted flag on the 
objects to true. 

4.1.1.3. How to Undelete an Object 
If you delete a question from the tree and later wish to reinstate it, you can do this as long as the question has not 
been removed completely by the Database Cleanup function (go to Database Cleanup on page 59 for more 
information). 

1. In the Panel Variables toolbox, right-click on the Panel name text and select Show Deleted from the 
menu. 

This shows any deleted questions. 

2. Right-click on the question and select Undelete. 

Or 

Right-click on the question and select Properties from the menu, then uncheck the Deleted box in the 
questions Properties page. 

4.1.1.4. The Survey History > Core Fields 
The "Core fields" are the default fields that are always included in the database. These are as follows: 

• SurveyStatus – indicates the current status of the panelist in the survey. The options are: 

o Reserved – the panelist is selected for a job but the invitation email has not yet been sent (a short-
term status). 

o Invitation Sent – an invitation to participate in the survey has been sent to the panelist but the 
panelist has not yet accessed the survey. 

o In Progress – the panelist has started the survey but has not yet completed it. 

o Completed – the panelist has completed the job. 

o Stopped By System – the panelist has been screened by the system. 

• ReservedDate – the date the panelist was reserved for the job. 

• InvitationDate – the date the panelists are given access to the survey. 

• StartDate – the date the panelist first opens the survey. 

• CompletedDate – the date the panelist completes the survey. 

• SubSampleNumber – refers to the sub-sample number code the panelist was selected under. 

• GroupNumber – refers to the group number code the panelist was selected under. 

• JobIsClosed – specifies whether or not the job is closed. 

4.1.2. The New Objects Toolbox 
This toolbox contains the templates for the objects that can be used in the database. Note that the range of 
options available here is much reduced from that available in the standard Confirmit Authoring. 

 

Figure 8  The objects available in the New Objects toolbox 
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4.1.3. The Secondary Project Toolbox 
In Professional Designer you have the possibility to copy questions from other projects into the current project. 
This can be done in the Secondary Project toolbox. Projects in this toolbox will be displayed in Read Only mode. 

 

Figure 9  The Secondary Project toolbox 

To find the panel you wish to add, open in this toolbox and click the Project, B.P. (Basic Panel) or C.P. 
(Community Panel) button as appropriate. To remove a questionnaire tree/project from the toolbox, click the 
Clear button. 

When you click the Project, B.P. or C.P. buttons, a pop-up window displaying all projects or panels is displayed. 

 

Figure 10  Example of the Project List pop-up 

In this pop-up window, search for and select the panel from which you want to reuse questions, and click OK. The 
Panel Variables tree opens in the Secondary Project toolbox. 
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Figure 11  Example of the Secondary Project questionnaire tree 

Now you can copy questions into the current panel by dragging them from the secondary project toolbox and 
dropping them into the tree. Before copying, you can view the Secondary Project objects in Edit mode. 

4.1.4. The Question Details Page 
The Question Details page is where you add text and answer options to the question. The functionality here is 
identical to that in a standard Confirmit survey. Refer to the Confirmit Authoring User Manual for further 
information. 

4.1.4.1. Question Properties 
The question objects in the Panel Variables toolbox have a range of properties and settings that you can 
customized via the property sheets. The property sheet will always display the type and name/title of the active 
object. To open the Properties pane for a question: 

• In the Panel Variables toolbox, right-click on the question and select Properties. 

Or 

• Double-click on the question or right-click on it and select Edit to open the Question Details page, then 
click the Show/Hide Properties button in the Details page toolbar. 

 

Figure 12  The Properties pane for a Single question 

Note: The Properties pane contains different properties depending on the type of question and the 
property selections made. The list below describes all the properties that may appear. 

The properties available are: 

• Field Width – specifies the number of characters assigned to responses to this question in the database 
and when exporting to fixed-width ASCII files. The default Field Width for Single questions is 32 
characters. If the Field Width is not defined for an Open text question, it will be unlimited. If defined, the 
respondent will be prevented from entering more characters than the specified in Field width. 
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• Indexed – if selected, an index is created on this field in the database the next time you generate the 
database. Indexes improve performance in areas such as 1) aggregated and verbatim reporting when 
filtering on fields with indexes, 2) searching in individual reporting and in survey data editing (when search 
fields are indexed), and 3) data imports where the key field is indexed. Note that indexes should be used 
only when needed, as responses take longer to store the more indexes there are. This can lead to a 
performance reduction during interviewing. Also, the database will be unavailable for other processes the 
first time it is regenerated after the index property is set. Confirmit Support therefore recommends against 
setting new indexes and regenerating a survey while respondents are answering the survey. 

• Numeric – check to specify that the field shall only accept numerical characters. 

• Total Digits – specify the total number of digits the field can contain. 

• Decimal Places – specify the maximum number of decimal places allowed. 

• Lower/Upper Limit – specify an upper and/or a lower limit for the number. 

• Lower/Upper Limit Type – specify the limit type; either = or <=/>= as appropriate. 

• Data Edit Access Required – this is the editing access permission level that users must have to be able 
to edit the date for this question in the database column. Users with editing access permissions lower than 
this level will not be able to edit the data for this question. Go to the Panel Utilities > Panel Overview page 
> Permissions tab to allocate the appropriate permission levels to the users. (go to Access Permission 
Levels on page 24 for more information). The options here are: 

o Low – all users with normal access permission can edit the data in this column. 

o Medium – only users with access levels Medium or High can edit the data in this column. 

o High – only users with access level High can edit the data in this column. 

• Boolean – applicable for Single questions. If selected, the question can have only two options, and the 
precodes must be 0 and 1. If you set an existing question to Boolean and that question had more than two 
answer options, then all the options except the first two will be deleted. 

• Characteristic – the group to which the data column is to be allocated  (go to Characteristic on page 15 
for more information). The options are: 

o Normal – columns for which you expect the majority of operations will be reading of the data 
contained. 

o Recoded – columns for which you expect the majority of operations will be writing of data. 

o Space Consuming – columns for which you expect the data contained will usually take a lot of space 
in the database, for example free-test fields. 

o Loop Support – defines a column as “Job-specific” information. Some information in the database is 
related to the survey job rather than to the specific panelist. When a number of panelists are selected 
for the same job, then that job information could be repeated for every panelist. To avoid expanding 
the database with repeated information, job-specific information is held in a separate section of the 
database. That section is then referred to for each panelist it applies to. 

• Date – defines the data from this open question (free text) as a date. The data in this column must then be 
in the specified format, and the system will expect it to be in that format so it will not need to analyze the 
data. 

• Accept Leading Zeros – check this box if you want the field in the expression builder to accept leading 
zeros. 

• Unique – check if every field in the column is to be unique. Use this for passwords, login names etc. 

• Default Value - type a value into this field to specify the value as default. The respondent will then be 
given this answer unless they enter a different answer. 

• Question Category - define a category for the question. A Reportal user can then filter on the question 
categories when using hitlists in single view in Reportal. Refer to the Reportal User Guide for further 
details. 

• Deleted – will be checked if the question has been deleted from the Panel Variables toolbox  (go to How 
to Delete an Object from the Tree on page 11 for more information). Uncheck to undelete the question (go 
to How to Undelete an Object on page 11 for more information). Note that you can view deleted questions 
by right-clicking on the Community Portal name in the tree and selecting Show Deleted. Deleted 
questions will then be shown “pale” until Hide Deleted is selected. 
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Note: Some questions are required in a database by default, and these questions will be added 
automatically when you create a new database. As the information contained in these questions is 
required, some of the properties for these questions are not accessible and cannot be changed. 

4.1.4.2. Characteristic 
To improve accessibility and reduce processing times, the database is divided into sections. The sections group 
the columns together depending on the type of processing expected to be most usual in the columns. For 
example, for some columns most of the processing will involve reading the data contained, while for other 
columns most of the processing will involve writing data to the column. Other columns are expected to use a lot 
more file space than others, as a “free text” character uses eight times more space than a Boolean character. Use 
the Characteristic property to specify which group the column will be allocated to. 

When the database needs to process information, it will go first to the group containing the columns with the 
appropriate characteristic. For example, if a database process is to write some data to a column, then the system 
will look for that column first in the Recode group. If the system finds the column in that group then it will perform 
the process. If it does not find the column there, then it will look in the other groups. This procedure will save 
considerable processing time, as otherwise the system must look through the entire database each time it needs 
to conduct a process. 

4.2. Database Generation 
This menu command activates the database generation function. The Community Panel database is used to 
administrate the panelists. If changes are made to the database, then it must be re-generated for those changes 
to be incorporated. 

This menu command only generates the database or regenerates it after changes have been made. To create or 
edit the database, go to Panel Setup > Designer (go to Designer on page 9 for more information). 

1. Go to the Panel Setup > Database Generation menu command. 

The page shown below  is displayed. 

 

Figure 13  The Generate database Options tab 

2. Select whether you wish to generate a new database or update the existing database (if the database has 
not been generated previously then the “Update existing database” option will not be available). 

Note: If you select Update Existing Database, the database and the new data are checked before the 
update commences. In the event an error is found, then the process is stopped before any changes are 
made. If no errors are found then the new data will be added to the existing database – no existing data 
will be deleted. 

Note: If a database already exists for the project and you select Create New Database, the old database 
will be overwritten and any data in the old database will be deleted. 

3. Click Generate Database. 

The database is created/updated. A Task pane opens, containing a progress bar and a task status list. 
When the database has been generated, the text Task Completed will be displayed at the bottom of the 
task status list. 

In the event you have deleted questions from the database during editing, see also section Database Cleanup. 

Note: Only the database is created; there is no web interview as in Confirmit Designer. Note also that in 
Community Panels there is no Test database available. 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 16 - 

4.3. Community Panel Definition Export 
You can export Community Panel definitions (the project coding) using XML. This enables you to transfer panel 
definitions from one Confirmit server to another. When you export a panel definition, the definition file is attached 
to an email, which is sent to the address specified in the Email Recipient field in the dialog box. 

4.3.1. How to Export a Panel Definition 
1. Go to the Panel Setup > Community Panel Definition Export menu command. 

The Survey Definition Export dialog opens. 

 

Figure 14  The Survey Definition Export dialog box 

2. Check that the Email recipient is correct, type any comments into the Comment field as appropriate, then 
click OK. 

The Task page is displayed, showing a progress bar, the task ID and the status. On completion, the 
progress bar is at 100% and an OK button appears. 

3. Click the OK button to close the task page and return to the Community Panel List page. 

An email is sent to the specified recipient containing the project definition XML file. This file can now be 
imported into another server. 

4.3.2. How to Import a Panel Definition 
To import a panel definition that has been exported from another server: 

1. In the Confirmit Authoring Home page, go to the Home > Import Survey Definition menu command. 

The Survey Definition Import dialog opens. 

 

Figure 15  The Survey Definition Import dialog 

2. Browse to the XML file you wish to import, then click OK 

A Task pane opens containing a progress bar and a task status list. When the project definition file has 
been imported, the text Task Completed will be displayed at the bottom of the task status list. 

3. Click OK to close the Task pane. 

The panel will now be listed on the Community Panel List, accessed by going to the Home > Community 
Panels menu command. Once the panel is imported, you can import and attach a portal to it. 

4.4. Designer Log 
The system records actions executed on a project basis. The Designer Log provides an overview of all changes 
that have been made on the project since it was first created. The system records the exact time when changes 
are made, the user who makes the changes, and specifies details of the change. 

This page is for information only - no changes can be made to the information. 
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Figure 16  Example of the Designer Log page 

4.5. Active Languages 
This menu command opens the Active Languages page. This page lists the languages selected for the Portal on 
the General tab (go to The General Tab on page 19 for more information). 

In the General tab you can select as many languages as required for the Portal, but while you are working in 
Community Panels, to keep the pages to a manageable size, a maximum of five languages can be displayed at 
one time. This limit applies anywhere where the languages are listed, such as in the database question details 
pages. Note that the maximum of five languages only refers to what you see whilst working in Confirmit; the 
panelists will see their selected language. 

In the Active Languages page, check the boxes for the (up to five) languages you wish to show then click Save. 
To hide a language, click again in the box to remove the tick, and save.  

 

Figure 17  Example of the Active Languages pane 

The functionality on this tab is also available via the Panel Utilities > Overview > Active Languages tab (go to 
The Active Languages Tab on page 24 for more information).  

4.6. Legacy Jobs Import 
If you are the Panel Administrator (you created the panel or have been given Administrator permission for it) and 
in addition have the SYSTEM_COMPANY_ADMINISTRATOR permission, then the Panel Setup menu will also 
include the Legacy Jobs Import item. This functionality is intended for new Confirmit Community Panel clients 
who have previously used a different panel-management product, and allows you to import legacy jobs into the 
Confirmit panel from the other system. The imported legacy jobs can then be used for exclusion purposes. 
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Note: The legacy jobs imported must be in XML format, and the job number must match the survey 
history data existing in the Confirmit panel. 

Contact Confirmit Support for further details. 
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5. The Panel Utilities Menu 
The Panel Utilities menu contains additional utilities that will be useful to the designer while creating and/or editing 
the Community Portals database. 

 

Figure 18  The Panel Utilities menu 

5.1. Overview 
When you access a panel via its link in the Community Panels list, you come first to the Panel Overview page. 
This page provides general information about the panel, presented on three tabs. 

• The General tab. 

• The Permissions tab. 

• The Active Languages tab. 

5.1.1. The General Tab 
This tab displays general information about the panel. 
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Figure 19  Example of the Panel Overview General tab for a panel 

 The information presented on this tab is as follows: 

• Panel ID – the unique identification number for the panel. This is allocated automatically by Confirmit 
when the panel is first created and cannot be changed. 

• Panel Name – the identifying name of the panel, given by the person who created it. You can change the 
name here. 

• Company – the company registered as the “owner” of the panel. This can be changed here if you have 
the necessary permission. Click the down-arrow beside the field and select the required company name 
from the list. 

• Description – a description of the panel, for future reference. Type in text here. 

• Languages – the language(s) selected for the panel. To add a language, select it in the Available column 
and click the >> button to move it to the Selected column. The selected languages are then listed in the 
Active Languages tab (go to The Active Languages Tab on page 24 for more information). 

• Categories and Keywords – the keywords registered for the project as listed in the Keywords column on 
the Community Panels List page (go to How to Access Community Panels on page 3 for more 
information). To add a keyword, select it in the Available column and click the >> button to move it to the 
Selected column. 

• New Keyword – use this field to add keywords to the Available list. Type the required word into the field 
and click Add. 

• Creator – the name of the user who created the project. This cannot be changed. 

• Created – the date and time when the project was created. This cannot be changed. 
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• Last Modified - the date and time when the project was last modified. This is updated automatically by 
Confirmit and cannot be changed manually. 

• Status – the current status of the project. This is updated automatically as the project progresses. 

• Deployment – the type of deployment selected. 

• Enforce HTTPS… – check this option to enforce HTTPS use in Advanced Reporting, accessing reports 
via the Enduser interface, for this project. 

• Snapshot Panel - if you have created a snapshot database to take snapshots of this panel (go to The 
Snapshot Panel on page 174 for more information), select the snapshot panel here so that the data can 
be copied. 

• Project Tasks button – opens the Tasks management page (go to The Project Tasks Page on page 21 
for more information). 

• Recurring Tasks button - if this panel has recurring rules that are active, then this button will appear. 
Click the button to open the Tasks Management page. In this page you can disable the recurring tasks or 
edit them as required (go to How to Set Up Recurring Tasks on page 122 for more information).  

5.1.1.1. The Project Tasks Page 
The Tasks page allows you to check the status of any tasks requested for this panel. 

Note: You can view all tasks by deleting the Project ID from the search criteria field and clicking Search. 

To access this page: From the Panel Overview page > General tab, click the Project tasks button at the bottom 
of the page. The Tasks page opens at the Search tab. Confirmit users who have Administrator permission to a 
project will be able to see and search for all batch tasks that have been set up for this panel. 

You can also access this page by going to the Quick Access pane > Tasks menu command. This will route list 
all tasks, but you can view only the tasks for one particular project by typing the project ID into the appropriate 
search field (go to How to Change the Execution Settings on page 127 for more information). 

The page comprises six tabs: 

• Scheduled tab- lists all the tasks that are scheduled to run. 

• Executing tab - lists the tasks that are currently executing. 

• Completed tab - lists all the tasks that have already run and are completed. 

• Aborted tab - lists all the tasks that have already run but which have aborted for some reason. 

• Recurring tab - lists any tasks that are recurring. 

• Search tab - lists all the tasks, enabling you to conduct searches more easily. 

 

Figure 20  Example of the Task page 

The In the event the task list is extensive, you can search through the list using a number of criteria: 

• Task Type - if you know the type of task, select from the drop-down list. 

• Company - if you know which company created the task, select it from the drop-down list. 

• Server - the server the task is/was run on. Select from the drop-down list. 
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• Recurring - If you know whether or not the task is recurring, select as appropriate here. 

• Period - if you know when the task was run, select the period from the drop-down list. 

• Report Number - if you know the number of the report the task was associated with, type it in here. 

• Task ID – the ID number given to the batch job by the system. Click on the header to sort the list. 

• User ID – the login ID for the user initiating the task. Click on the header to sort the list. 

• Project ID – the system-generated project number. Click on the header to sort the list. 

• Task type – the type of task to be performed. Click on the header to sort the list. 

• Schedule – the schedule date (the date the task was initiated). Click on the header to sort the list. 

• Status – select a status from the drop-down list. Click on the header to sort the list. For Completed and 
Aborted tasks, only the tasks run during the past 7 days will be shown. Completed and Aborted tasks that 
are older than 7 days are deleted. 

• Company - the registered company of the user who initiated the task. 

• Server - the server on which the task is/was run. 

Click on the Task ID number to go to the task details window. Here is displayed information about the particular 
task, and you can disable the task, set up or change the recurrence pattern (go to How to Set Up Recurring Tasks 
on page 122 for more information), check the details etc. The details presented differ for the different task types. 
The figure below shows an example of the dialog for a sampling task. 

 

Figure 21  Example of a Task Details window 

• Click Close Window to return to the Tasks page. 

Note: Confirmit sets a limit on the time a task can run before it is aborted. This is to avoid unnecessary 
strain on the server if there is an error in the file. However, this may also result in heavy tasks (for 
example based on long questionnaires) being stopped before they are completed. In the event this 
becomes a problem, ask your Confirmit administrator to adjust the time limitation. 

ASP only - Contact Confirmit Professional Services for assistance: support@confirmit.com 

5.1.2. The Permissions Tab 
The user who creates the panel is the panel administrator and owner, and a panel is initially invisible to all other 
Confirmit users. You can give access permission to other users via this tab. All Confirmit users in your 
organization will be listed in the tab, and you as the panel administrator may set up other Confirmit accounts with 
permissions to view the new panel. 
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ASP only: Personnel at Confirmit may be granted access for support purposes. 

Initially, only users and groups within your organization are listed on the page. Add other users by supplying 
Confirmit with the users’ correct user keys. 

 

Figure 22  Example of the Permissions tab 

5.1.2.1. How to Add Users to the Permissions Tab 
Typically, an external user will send you his or her user key by email. Paste this key into Confirmit as follows: 

1. Click the Add other users button below the list. 

The Enter keys of new users dialog opens. 

2. Paste the new user’s key into the field and click Add. 

Note: Ensure there is no space after the last character in the user key. 

 

Figure 23  User Key Entry Window 

The dialog box closes and you are returned to the Permissions tab. The new user is added to the list under Other 
Users. 

You must now allocate the appropriate Permissions levels to the new user. 
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5.1.2.2. How to Remove Users from the Permissions Tab 
To remove a user from the Other Users list: 

1. Click the Remove other users button below the list. 

A dialog opens listing the users in the Other Users list. 

 

Figure 24  The Remove Users dialog 

2. Select the user or users you wish to remove from the list and click Remove. 

Note: You can only remove users from the Other Users list. Users in the “Users in own company” list can 
only be added and removed by the company system administrator. 

5.1.2.3. Access Permission Levels 
The panelist data is held in columns in the database; one column for each “question” (go to Designer on page 9 
for more information). The data in the various columns can be viewed by any user, but can only be changed by a 
user if that user has the appropriate permission level for that column. Each individual column can have one of 
three access levels; Low, Medium or High, the level for the column being defined by the database designer in the 
Question Properties pane (go to Question Properties on page 13 for more information). Each user is given access 
permission to one of these same levels here in the Permissions tab. 

• Low – the default access level. None of the Data Edit Access checkboxes are selected. The user can 
read all the data columns, and change data in columns that have Low write access. The user cannot 
change data in columns having Data Edit Access Medium or High. 

• Medium – the Data Edit Access Medium checkbox is selected. The user can read all the data columns, 
and change data in columns that have Low or Medium Data Edit Access but cannot change data in 
columns having the Data Edit Access High setting. 

• High – the Data Edit Access Medium and High checkboxes are selected. The user can read or change all 
the data columns. 

5.1.3. The Active Languages Tab 
This tab lists all the project languages in a multilingual project, that have been selected on the General tab (go to 
The General Tab on page 19 for more information). To reduce the volume of information that must be presented 
on your display, you can work with up to five languages at one time. Select and deselect the languages you wish 
to work with by checking/unchecking the relevant check-box. Note that the maximum of five languages only refers 
to what you see whilst working in Confirmit; the panelists will see their selected language. 
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Figure 25  The Active Languages tab 

The functionality on this tab is also available via the Panel Setup > Active Languages menu command (go to 
Active Languages on page 17 for more information). 

5.2. Community Portals 
In Confirmit you can build your own library of panelist interfaces (Community Portals), through which your 
panelists (and potential panelists) can read about your panels and register as new panelists. Those who have 
already become panelists (members) can log into the Community Portal to answer new or previously-started 
surveys, view their survey list, update their profile, view their points, etc. All these actions are conducted via the 
Community Portals menu. 

A panel functions in the same way as a normal survey. Typically, a panel consists of mapping and profile 
questions such as demographic questions, work-related and household questions. The panelists register 
themselves in your Panel, or you can import people directly into your Panel if you already have their information. 
Based on their information inside the Panel (community), you can then recruit relevant respondents to specific 
surveys. A Community Portal is the interface (homepage) through which your panelists log in to participate in 
surveys, check their point status, change their profile, etc. 

Community Portals can only be used together with Confirmit Panels. 

5.2.1. Accessing Community Portals 
1. On the Community Panel List page, click on the appropriate Panel ID to open the Panel you wish to work 

with. 

2. Go to the Panel Utilities > Community Portals menu command. 

The Community Portal List page opens. This page lists all the portals that you have access to. The current 
portal (if any) is shown in bold. 

3. To open a Community Portal in the Designer page, click on the Portal Name, or move the mouse pointer 
onto the Portal name to display a down-arrow button beside the name, click the button to display a drop-
down menu and select Designer. 

 

Figure 26  Accessing a Community Portal for editing 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 26 - 

The menu options are: 

• Designer – opens the Community Portal Designer page. This menu command has the same effect as 
clicking directly on the Portal name. 

• View - opens the panel in viewing mode, as the panelist will see it, in a new window. 

• Duplicate – makes a copy of the selected Portal. You can then re-name and edit the copy to make 
variations of the original. 

• Export – allows you to export a Community Portal to another Confirmit server. 

5.2.2. How to Add a Community Portal to your Panel 
A Community Portal can only be activated on a Confirmit Panel. You can do this in two ways: 

• Create a new Community Portal (go to How to Create a New Community Portal for a Panel on page 26 for 
more information). 

• Import an existing Community Portal template to your panel (this is the most common approach)(go to 
How to Import a Community Portal on page 26 for more information). 

Note that the direct panelist link will be displayed under Panel Management together with the link to the panel 
registration survey. 

5.2.2.1. How to Create a New Community Portal for a Panel 
1. Go to the Panel Utilities > Community Portal List menu command. 

The Community Portal List page opens. 

2. Click the New Community Portal button located towards the upper-right corner of the page. 

The Properties dialog box opens. 

 

Figure 27  The Community Portals Properties dialog box 

3. Type a name for the new Community Portal into the Name field and click Next. 

The Select Template page opens, listing the templates available. Note that if you choose Finish here, 
then an empty Portal Designer page opens and you must then create the portal "manually". 

4. Select the desired template from the list and click Finish. 

The Community Portal Designer page opens with the new portal as defined by the selected template. Use 
this page and the toolbox provided to design and edit the portal as required. 

5.2.2.2. How to Import a Community Portal 
You can also import Community Portals created on other Confirmit installations (go to How to Export a 
Community Portal on page 53 for more information). 

Note: You must first have a Panel into which the Portal can be imported. 

1. Go to the Panel Utilities > Community Portal List menu command. 

The Community Portal List page opens. 

2. Click the Import Community Portal button located towards the upper-right corner of the page. 

The File to Upload selection dialog box opens. 
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Figure 28  The File to Upload selection dialog box 

3. Click Browse to open a standard Windows file selection dialog. 

4. Browse to and select the portal file you wish to import, then click Open. 

The portal is imported to this Panel. 

5.2.2.3. How to Set a Portal as Default 
To make a portal the default portal: 

1. Go to the Panel Utilities > Community Portals menu command, and from the Community Portal List 
select the portal you wish to make default. 

2. In the Community Portal toolbox, right-click on the portal and select Set as Default Portal. 

 

Figure 29  Setting a portal as Default 

The text (DEFAULT) is displayed after the portal name in the toolbox, and the portal name is displayed in 
bold text in the Community Portal List. 

5.2.2.4. How to make the Portal Dynamic 
You can control which portal is displayed when a panelist logs in such that for example the portal layout depend 
on the country of origin specified in the user's details. The variable that is used to specify which portal is to be 
displayed is set in the default portal. To do this: 

1. Decide which variable in the panel is to control the portal used, or create the variable as necessary.   

This variable must include all the possible options for which you wish to provide different portals for. This 
example uses the Country variable, so will display a portal depending on the country selected by the 
panelist. The panel question should ask for example "In which country do you live?" 

2. Go to the Panel Utilities > Community Portals menu command to open the Community Portals List 
window, and select the default portal. 

3. In the Community Portal toolbox, right-click on the portal name (the top item in the toolbox) and select 
Properties from the menu or double-click on the portal name, to open the Properties page for the portal. 

4. Set the Portal Code Variable property to the variable you wish to use as the controller (in this case 
country). 
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Figure 30  Setting the Portal Code Variable property 

5. Set the Portal Code property to the precode for the "default" country and save the changes. 

6. Go to the Properties pages for the other portals that are to be made available, and set the Portal Code 
property to the precode of the appropriate answer. I.e. If a particular portal is to be presented when the 
panelist's country is France, then set the precode for the France answer into the Portal Code field for that 
portal. Note that for the "secondary" portals, the Portal Code Variable will already be set to that selected 
above for the default portal. 

7. Save the changes. 

Once the panelist has completed the panel questionnaire and provided an answer to the Country 
question, when the panelist later logs in, he/she will automatically be presented with the portal specified by 
the variable.  

Note: Once the Portal Code has been set for a portal, then it can be displayed by adding the querystring 
parameter "pc" to the portal url. for example, add ...&pc=1 to the url to use the portal with the code 1. 

5.2.3. Community Portal Languages 
The Community Portal pages and texts can be made available to the respondents in any language and any 
number of languages. You can also make the portal language dynamic, so the portal will automatically adopt the 
language specified in the user details. 

5.2.3.1. How to Add a Language to the Portal 
1. In the Community Portal toolbox, right-click on the Portal name (the top item in the toolbox) and select 

Properties from the menu or double-click on the Portal name. 
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The Properties page for the portal opens. 

 

Figure 31  Example of the Properties page for a Portal 

2. Click the … button beside the Portal Languages property. 

The Portal Languages window opens with the currently selected languages listed in the Selected Items 
column. 
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Figure 32  The Portal Languages window 

3. In the Available Items column, scroll to the language you wish to add to the portal, and click on it to select 
it. You can select as many languages as you require. 

4. Click the >> button to move the selected language(s) to the Selected Items column. 

5. Select a language in the Selected Items column and click the << button to remove that language. 

6. On completion, click OK. 

The window closes and the selected languages are added to the Portal. 

Note: A search facility is available in the upper part of the window. If this is not visible, click the chevron 
button beside Find to open it. 

Text fields for the selected languages will now be available in the Portal and page Properties pages. You must 
now fill in the text fields for the Portal and the various pages for the languages you have selected (go to Page 
Properties on page 41 for more information). 

5.2.3.2. How to make the Portal Language Dynamic 
You can make the portal language dynamic such that the portal will use the language specified in the user's 
details. To do this: 

1. Create a language variable in the panel using the language codes (refer to Appendix B of the Authoring 
User Guide for details) as the precodes of the options. 

This variable will need to include as answer options all the possible languages that you wish to provide to 
the panelists. It should ask for example, "In which language would you like to view the portal?" 
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Figure 33  Example of the language variable 

2. Go to the Panel Utilities > Community Portals menu command to open the Community Portals List 
window, and select the portal you wish to work with. 

3. In the Community Portal toolbox, right-click on the Portal name (the top item in the toolbox) and select 
Properties from the menu or double-click on the Portal name, to open the Properties page for the portal. 

4. Set the portal's Language Code Variable property to the variable you created in point 1 of this procedure, 
as shown below. 

 

Figure 34  Setting the Language Code Variable property 

5. Save the changes. 

Once the panelist has completed the panel questionnaire and provided an answer to the language 
variable, when the panelist logs in, he/she will automatically be presented with the language specified in 
the variable.   

Note: The dynamic portal language functionality will not work if the Language Selector component is 
included in the panel. If the Language Selector component has been used then you will need to go 
through the panel and remove all instances of the component from the page master and all pages. 

5.2.4. The Community Portal Designer 
The Community Portal Designer is where you create and make changes to your portal pages. The toolbox 
contains the Page Masters (go to The Page Masters Folder on page 32 for more information), Themes (go to The 
Themes Folder on page 33 for more information), and Pages (go to The Pages Folder on page 39 for more 
information). The Visual Components toolbox contains the elements that you can use on a page  (go to Visual 
Components on page 43 for more information). 

In the figure below, the Community Portal toolbox contains a Page Master, a Theme and four Pages. In addition 
there are four pages inside the Members Only folder (go to Folders and Structure on page 42 for more 
information). 
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Figure 35  The Portal Designer toolboxes 

The Community Portal has a right-click menu. The options in this menu allow you to publish the portal (go to How 
to Publish a Community Portal on page 52 for more information), set the portal as default (go to How to Set a 
Portal as Default on page 27 for more information), export the portal etc. 

5.2.4.1. The Page Masters Folder 
A Page Master is a template that provides an overall look-and-feel to the pages in the Community Portal. You can 
create as many Page Masters as you need for a Portal. The first Page Master in the list will be used as the 
default, and will be applied to all pages in the Portal unless other Page Masters are specified for particular pages. 
A portal page will always adopt the look-and-feel of the Page Master specified. 

5.2.4.1.1. How to Create a Page Master 
To create a new Page Master, right-click on the Page Masters folder name text beside the folder icon to open the 
drop-down menu, and choose Insert Page Master (Inside). A blank Page Master is added to the portal. If you 
want to base a new Page Master on an existing one, then right-click on the Page Master you wish to copy, and 
choose Duplicate. 
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5.2.4.1.2. How to Edit a Page Master 
To open a Page Master for editing, double-click the name of the Page Master In the toolbox, or right-click on it 
and choose Edit. The page designer opens at the Layout tab. 

 

Figure 36  Example of a Page Master 

On the Layout tab, you specify which Visual Components (page elements) are to be included on the page, and 
where they are to be located. 

To define the look-and-feel for each of the Visual Components, double-click the component or right-click on it and 
choose Properties (go to Visual Components on page 43 for more information). 

Go to the Preview tab to preview the current version of the Page Master. Remember to save any changes you 
may have done before previewing the Page Master. 

For more information on using HTML tables, free-from text, and images on your portal pages, see Editing your 
Page Masters and Portal Pages. 

5.2.4.2. The Themes Folder 
A theme is a collection of different Styles, each holding a specific layout definition. Inside a Community Portal you 
can have as many different themes as you wish, but only one can be active at a time. You can specify one theme 
to be the default, and this theme will then be used whenever no other theme is specified. You can however select 
other themes to be used for specific pages and components. 

To set a theme as default, right-click on the theme and select Set as Default. Confirmit will display the text 
“DEFAULT” next to the default theme in the Community Portal toolbox. 
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Figure 37  The default theme 

You can allow the panelists to select a theme so they can "personalize" their portals. To give the panelists this 
possibility, place a Theme Selector component into the master page for the portal (go to Visual Components on 
page 43 for more information). If a panelist chooses not to select a different theme, then the portal will be 
presented using the default theme. 

You can also have Confirmit select the theme to be used depending on a panelist's answer to a question in the 
panelist questionnaire. For example you could have Confirmit use different themes for males and females under 
and over the age of 20. In this case you use the Theme Code property to set up the specifications(go to The 
Theme Code Property on page 34 for more information) 

Once you have set up the Theme Code functionality, you can define in the email link that the panelist uses to 
open the portal the theme to be used (go to Adding a Theme Code to the Email Link on page 37 for more 
information). 

5.2.4.2.1. The Theme Code Property 
You can program Confirmit to select a theme automatically for a panelist depending on answers given in the 
questionnaire. This involves using the Theme Code property, which causes the default theme to be overwritten. 

Note: If a Theme Selector component is included on the Master page for the portal, then the theme 
specified in the Theme Selector will over-write the theme specified by the Theme Code. You are therefore 
recommended to remove the Theme Selector component (if one exists) from the page master before 
starting this procedure. 

1. Ensure that the Themes folder in the Community Panels toolbox contains the themes you wish to be 
available for the panelists. 

2. In the panel questionnaire (Panel Setup menu), include a single question and give it a logical name, for 
example "ThemeCode". 

3. Add the theme options as the answers to this question, and set the precodes for the answers to be 
something specific. 

For example, if the themes available are to be "Green" and "Orange", then it would be logical to set the 
question's answers to "Green" and "Orange", and the precodes to "g" and "o" respectively as in the figure 
below. 
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Figure 38  Example of a Single question in the panelist questionnaire to set the theme for a panelist 

As the theme selection is to be automatic, the question would normally be "hidden". 

4. Generate the database for the panelist questionnaire. 

5. In the Panel Utilities > Community Portals page, select the portal you wish to work with. 

6. In the Community Portal toolbox, double-click on the Portal node or right-click on it and select Properties. 

The Properties page for the portal opens. 

7. Click the down-arrow beside the Theme Code Variable field and select the variable (question) that you 
have created earlier, as shown in the example below. 
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Figure 39  Selecting the Theme Code Variable property for the portal 

8. Save the changes. 

9. In the Community Portals toolbox, the Themes folder contains the available themes. Double-click on a 
Theme or right-click on it and select Properties. 

The Properties page for the theme opens as shown below. 

 

Figure 40  The Properties page for the Green theme 

10. In the Theme Code field, type the precode for the theme as specified earlier in the procedure. 

In the example above, the precode for the Green theme was set to g. 

11. Save the changes. 
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You can now go into the Panel Management > Single Panelist Editor page and set the ThemeCode variable to 
the desired theme for specific panelists, and you can also of course use a panel rule to set the theme for sets of 
panelists simultaneously. 

5.2.4.2.2. Adding a Theme Code to the Email Link 
Once you have set up the Theme Code functionality (go to The Theme Code Property on page 34 for more 
information) you can add a Theme Code to the email link that is sent to the panelists. To do this, type: 

tc=<precode> 

onto the end of the link that is to be sent to the panelist. 

This can also be done automatically using scripting and piping, but this is only for advanced users and the details 
are beyond the scope of this manual. 

Note: Adding a Theme Code to the email link will automatically over-ride all other theme selections. 

5.2.4.3. Styles 
Click the plus sign in front of each Theme to see all the styles for that Theme. The figure below shows the styles 
available in the Green theme. When the Green theme is in use, the Visual Components (and free-form text) can 
be assign any of these look-and-feel definitions. 

To set a Style for a Visual Component: 

1. Double-click the component on the page, or right-click and choose Properties. 

The component Properties pane opens. 

2. One of the properties listed is the Style Name. Click the down-arrow button beside the property to open a 
drop-down list of the available styles, and select the required style from the list. 

3. Click Apply or Apply and Close to apply the change. 

4. On completion, save the changes. 

 

Figure 41  Applying a style for a Visual Component 

Each style has its own set of properties as appropriate for the style’s requirements. Below is the properties pane 
for the pagetitle style. As this style is a “Text” component, it requires a number of font properties. 
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Figure 42  Style properties 

When you change a setting, Confirmit provides an instant preview of the style so that you can see how the 
change affects the style. Also, when making changes to a style, each alteration (setting) is listed below the 
preview so that you can see which settings have been set for that style (go to Visual Components on page 43 for 
more information). 

5.2.4.4. View Stylesheet Contents 
You can view all the styles for a theme on one sheet. 

• Right-click on a Theme and choose View Stylesheet Contents. 

Confirmit will then list all the styles for that Theme. This can be useful if you want to quickly find the definitions of 
all styles, typically for use outside this theme. 
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Figure 43  Viewing the Stylesheet Contents 

5.2.4.5. The Pages Folder 
The third main folder inside the Community Portal toolbox is the “Pages” folder. This is where you set up the 
portal pages. 

5.2.4.5.1. How to Create a New Page 
To create a new page in the Portal: 

1. In the Community Portal toolbox, right-click on the Pages folder text to open a drop-down menu. 

2. Select Insert Page (Inside). 

Or: Right-click on an existing page and choose Duplicate. 

5.2.4.5.2. How to Edit a Page 
Double-click on a page in the Community Portal Pages folder to open the page for editing. The Community 
Portal Designer page opens for the selected page. This is where you select the Visual Components that are to be 
used on the page, and position them on the page. 

A new page has been created in the Pages folder, called in this case Example Page (go to How to Create a New 
Page on page 39 for more information). This page will now be used to provide worked examples of the various 
procedures used when editing a page. 

On this page it has been decided to show some text (the text element), an external link, a link to the page called 
“Home”, and an image will be inserted across the bottom of the page. 
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1. The first step is to set the Page Master (go to The Page Masters Folder on page 32 for more information): 

Right-click on the page and select Properties from the drop-down menu. The Properties pane opens. The 
first property in the list is Page Master. 

Right-click on the down-arrow beside the Page Master field to open a drop-down list of the page masters 
available, and select the desired page master from the list. 

If several languages have been defined for the Portal, then on this Properties page you can also type in 
translations of the title and description for the non-default languages. 

Save the changes. 

The “Page Area” element determines where the page (portal page) is located on the overall page (Page 
Master) (go to How to Create a Page Master on page 32 for more information). 

In other words, overall browser views are set up as Page Masters. The individual portal pages are set up 
under “Pages”, and you assign a Page Master for each page (if you do not, the default Page Master will 
be used). The portal pages will always appear on the screen where the Visual Component “Page Area” is 
located. 

2. Set the Page as Default / Login 

In the same way as one Theme is set to be default, one page is also set as the default page. This will then 
be the first page that the respondent sees when he/she goes to the Community Portal. In most cases this 
will be the starting page (home page). 

Right-click the page and choosing Set as Default. Confirmit will show the default page each time a new 
visitor enters the portals. 

The page you wish to use as the login page must also be specified. To do this, right-click the page and 
selecting Set as Login. Confirmit will display the text “LOGIN” next to the login page in the Community 
Portal toolbox. 
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Figure 44  Setting the Login page 

5.2.4.5.3. Page Properties 
To open the Properties pane for a portal page, right-click on the page in the Community Panel toolbox and 
choose Properties from the menu, or when the page is open for editing click the Show/hide Properties button in 
the Editing pane toolbar. The properties pane opens alongside the page. 
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Figure 45  Example of a Page Properties page 

The page properties are as follows: 

• Page Master – defines the layout for that page (go to The Page Masters Folder on page 32 for more 
information). 

• Name – the name of the page. You can edit this at any time. 

• Protected – check this box if you want this page to be accessible only to people who are logged in. If a 
page is not protected all visitors can see the page. 

• Navigator Item – defines when the page is to be visible in the menu bar (go to Folders and Structure on 
page 42 for more information). 

• Visible – leave this box checked if you wish the page to be visible in the menu bar all the time. If the box 
is unchecked, then the page will not show. 

• Visible when not logged in– leave this box checked if you want the page to be visible to all visitors to the 
site. Uncheck the box to hide the page from those who are not logged in. 

• Title – the portal can be made available in any number of languages. These languages are selected when 
the portal is first created, or can be added later (go to Community Portal Languages on page 28 for more 
information). The respondents can select the language (from the list available) in which the Portal is 
presented. The Title property provides one field for each language selected. Type into the fields the page 
titles in the various languages. 

• Description – here you specify for each language the text you wish to appear when a respondent points 
to the page on their screens (mouse-over). 

5.2.4.5.4. Folders and Structure 
Folders are used inside the “Pages” section to create a menu structure for the portal pages. Each folder will be 
presented as a clickable submenu for the panelists. 

To insert a new folder: 

1. Right-click on an existing folder and select either Insert Folder (Inside) or Insert Folder (After) as 
appropriate. 
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2. Once you have created the folder, create pages inside the folder or place them there using drag-and-drop. 
Note that you can have folders within folders. 

In the figure below, note how the pages Example Page, Home, Join Community, FAQs, Contact Us, and About 
are displayed as separate pages on the menu bar. The folder “Members Only” creates a drop-down menu which 
leads to the pages inside the folder. The Lost Password page does not appear here because the Visible property 
in the page's Properties page has been unchecked. The login page is only displayed when someone attempts to 
enter a restricted page. 

 

Figure 46  Using a folder to create a menu layout 

5.2.4.6. Visual Components 
The Visual Components are “prefabricated” elements you can use on the portal pages. Page Masters and 
“normal” pages have different sets of Visual Components available, reflecting the pages’ different functions. 

The procedure for inserting Visual Components is the same for Page Masters and Pages. Note that the Visual 
Components you insert into a Page will all be located within the Page Area component that is positioned on the 
Page Master. 

5.2.4.6.1. How to Add an HTML Table to the Page 
When you first create a page, it will be empty. To simplify the positioning of components on a page, it is 
recommended that the first thing you create on the page is a table. You can then place the various components 
within the table cells, and use the cell properties to define the positions of the components. An existing page will 
normally already have a table. 

1. Double-click on the appropriate page in the Community Portal toolbox Pages folder, or create a new page 
(go to How to Create a Page Master on page 32 for more information). 

The Page Editor for the page opens. 
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Figure 47  The blank page editor 

2. To create the table, click the Table button  (A in the figure below) in the page editor toolbar to open 
the table selector, move the pointer to the right and down until the required number of rows and cells are 
selected, then click in the lower-right selected square. 

 

Figure 48  Creating a 3x3 HTML Table 

While working in the Portal Designer, a dotted grid is displayed as a visual guide so you can see the table 
and cell boundaries while editing. The table will not be visible on the portal page. If you wish to see the 
page without this grid, either select preview, or click the Show/hide grid button (B in the figure above). 

3. Right-click in the table and select Table Properties from the drop-down menu to open the Properties 
page for the table. 

4. Right-click in a cell and select Cell Properties from the drop-down menu to open the Properties page for 
the selected cell. 

5. In the right-click menu you can also add and delete rows and columns for the table. 

6. On completion, click Save to save the changes. 
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Figure 49  The resulting 3x3 table 

5.2.4.6.2. How to Add a Visual Component to the Page 
A page can include any number of visual components. From the Visual Components toolbox, which contains all 
the various page elements, we will now drag a component and drop it in the upper left cell. 

1. Go to the Visual Components toolbox, click on the component you wish to insert, and drag it up to the 
appropriate field in the table. 

Or: 

Right-click in the appropriate cell, choose Insert Component, then select the desired component from the 
drop-down list. 

 

Figure 50  Dragging a Visual Component into the table 
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In the example, a Login Status component is being dragged into the upper-left cell of the table. On 
completion the Editing Page will look as shown in the figure below. 

 

Figure 51  The table with the component in place 

You can now open the component’s, the cell’s and/or the table’s Properties pages and set up the 
component as required. 

2. On completion, click Save to save the changes. 

5.2.4.7. The Visual Components Toolbox 
Page Masters and “normal” pages have different sets of Visual Components in the toolbox, reflecting the pages’ 
different functions. The following sections describe all the components available. 

Each Visual Component has a Properties page that contains properties particular to that type of component. The 
Properties page enables you to select the characteristics for the specific component, and in many cases what 
information the component displays and how it is displayed to the panelist. To open the Properties page for a 
component, double-click on the component or right-click and select Properties. Refer to the Confirmit Authoring 
User Manual for further information on the properties. 

5.2.4.7.1. Page Area 
The Page Area component determines where the page (portal page) is located on the overall page. This 
component is only available for a Page Master. 
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Figure 52  A Page Master with the Page Area element 

5.2.4.7.2. Login 
The Login element displays the username and password text-fields and the associated Login button to the 
panelists. 

 

Figure 53  Example of the Login component in use 
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5.2.4.7.3. Login Name 
The Login Name element displays the panelist’s username (normally the email address) after he or she logs in. In 
the figure below, the Login Name element is being set up. Here, a custom text (Format String) is defined so when 
for example Peter Jones logs in with his username “peterj@firm.com”, the text displayed in the page becomes 
“Welcome peterj@firm.com!” 

The “username” is the only element that can be piped into the Login Name component. 

 

Figure 54  Setting up the Login name component 

5.2.4.7.4. Login Status 
The Login Status component allows you to place a hyperlink to a login page anywhere in your portal. This 
element is often used in combination with the property “Show Login Status When Logged In” on the Login 
component. If this property is checked on the Login component, and the Login component is always displayed on 
screen (normally part of the Page Master), then the Login Status component may not be used. 

5.2.4.7.5. Password Recovery 
This component allows the panelist to ask that his or her password be sent to their email address. This requires 
that the panelist has previously registered. 

5.2.4.7.6. Change Password 
This component provides the panelist with a link to a page on which they can change their password. The panelist 
can click the link at any time. 

5.2.4.7.7. Navigator and Navigator Path 
The Navigator component determines where on the page the menu is displayed. The Navigator path component 
shows the panelists the history of pages visited. 

5.2.4.7.8. Language Selector 
If the portal is created in more than one language, then the panelists and other visitors to the site must be able to 
choose which language the portal is presented in. In this case the selector is located in the upper left corner of the 
page. 
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Figure 55  Example of the Language Selector in use 

5.2.4.7.9. Theme Selector 
If more than one theme is available to the portal, then you can provide the Theme Selector component to allow 
the panelists and other visitors to choose which of the themes is used for their portal. In the example shown 
below, the selector is located in the upper left corner of the page (ringed) and the “Green” theme is selected (go to 
The Themes Folder on page 33 for more information). 

 

Figure 56  Example of the Theme Selector in use 

5.2.4.7.10. Surveys List 
This component presents a list of the surveys the panelist is involved with, and can present additional information 
on each survey in the list. Each Surveys List component on a page can display one type of list, for example “All 
completed surveys” or “All surveys that are not yet started”. If you wish to present several types of list to the 
panelist, then you must add one Surveys List component to the page for each type of list you wish to present. 
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5.2.4.7.11. Credit Balance 
Confirmit keeps track of points earned for panelist participation. Use the Credit Balance component to display the 
current number of points earned by the panelist. In the example below, when panelists go to the View Your Points 
page, they will see the sentence “You have N points in your account.” The variable N displays the credit balance, 
starting at zero. 

 

Figure 57  Example of the Credit Balance component in use 

Note: You can import and export panelist credits (go to Panelist Credits on page 89 for more information). 

5.2.4.7.12. Edit Profile 
Your panelists should have the opportunity to update their profiles. This component places a link on the portal 
page that, when clicked, takes the panelist to the survey they answered when signing up as a panelist. Here they 
can update their details so that when you next sample the panel for respondents for a particular survey, the group 
of respondents found for that survey is optimized. 

Note: You can use different surveys to update different parts of the panelist database. The link must then 
refer to the appropriate survey, so you must type the survey’s ID number into the Profile Survey ID field. 

 The survey will appear where the Edit Profile component is placed on the page. 

Note that you can have the Edit Profile survey open as an "In-line" frame. This allows you to embed the survey 
into any web page without having to use iFrames. To do this: 

1. Double-click on the Edit Profile visual component to open the Designer page for that component. 

2. Right-click on the Edit Profile component on the page and select Properties from the drop-down menu. 

The Properties page opens. 
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Figure 58  The Edit Profile component Properties page 

3. Check the Use Inline Frame box. 

4. Click Apply or Apply and Close to save the changes. 

5.2.4.7.13. Edit Profile Link 
This is basically the same as the Edit Profile component, but takes the panelist away from the portal page and 
opens the registration survey in the window. Once the panelist has worked through the survey, it is closed and 
he/she is returned to the portal. 

Note: You can use different surveys to update different parts of the panelist database. The link must then 
refer to the appropriate survey, so you must type the survey’s ID number into the Profile Survey ID field. 

5.2.4.7.14. External link 
You can insert hyperlinks on your portal pages. To do this, drag the Visual Component “External link” onto a 
page, then double-click the element (or right-click and choose Properties) to set the properties for the element. 
One property that must be set is the URL for the link. 

5.2.4.7.15. Link Target 
Use this component to embed an external link on a portal page. If/when the panelist clicks this link, the external 
site will open in the portal page. 

5.2.4.7.16. Text 
Use the Text component to display text on a portal page. Note that you can enter text directly onto a page (go to 
Free Text on page 56 for more information), however If you do the text will be the same for all panelists, 
regardless of language. If you use the Text element, you can to specify text for each language selected for the 
portal, and Confirmit will display the text in the language chosen by the panelist via Language Selector (go to 
Language Selector on page 48 for more information). 

5.2.5. Properties on a Community Portal 
To set properties on the portal level, right-click on the portal name, and choose Properties or double-click on the 
portal name. The Properties page opens. 
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Figure 59  Setting the properties on the portal level 

• The portal name is displayed at the top of the property sheet. You can change the name by typing a new 
name into the field. 

• Default Language - specify which of the Portal Languages is to be the default. This language will be used 
as the first-entry language and whenever another language has not been chosen. 

• Portal Languages - select the languages you wish the panelists to be able to select between. In the 
example above, English, French and German are selected. 

• Theme Code Variable - specify the question to be used as the deciding element when Theme Codes are 
to control the theme used by the portal (go to The Theme Code Property on page 34 for more 
information). 

• Titles - specify the title that is to be used for each language. These will be displayed to the panelists and 
other visitors. 

5.2.5.1. Managing your Community Portals 
You can create as many Community Portals as you require. However, only one portal can be publicly active at a 
time on each panel. You would normally build your portals inside the panels so that you have full control of how 
the portals will look. 

5.2.5.1.1. How to Publish a Community Portal 
Several Community Portals can be published for a panel at one time. The name of the default portal is presented 
in bold text. The default portal is the portal that will be used if no other is specified. 

 

Figure 60  Example of the Community Portals List, the default portal in bold 

When a portal is published, the Community Portal URL becomes available from the Project Management page > 
Overview tab and any changes you make to the Community Portal become public. The date and time a portal 
was last published are displayed in the published column. 

To publish a portal: 

1. In the Community Portal toolbox, right-click on the portal name to open the drop-down menu. 
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2. Choose Publish from the menu. 

If you wish to remove a portal from public view then you can "Unpublish" it. Once the portal has been published 
then the Unpublish option becomes available in the right-click menu. If a portal has been specified for as 
particular set of panelists, and that portal is later unpublished, the those panelists will be presented with the 
default portal. 

5.2.5.1.2. Testing your Community Portal 
While working with the portals, you may need to test how different portals function together with your panel. 
Confirmit recommends that you have all relevant portals added to the panel. You can then try the different 
alternatives in Preview. 

If you wish to make changes to a portal to for example try a different look or setup, you would probably save 
considerable time by duplicating an existing portal instead of creating a new one and starting from the beginning. 

5.2.5.1.3. Managing your Community Portal within your Panel 
To list all portals that are added to the active panel, go to the Panel Utilities > Community Portal List menu 
command in Confirmit. 

The list shows when each portal was created and by whom. The currently published portal for this panel is listed 
in bold, and the time when the portal was last published is also shown. 

5.2.5.1.4. Managing your Community Portal Templates 
The same Community Portal can be used on many different panels simultaneously. Whenever you save a portal 
as a template (go to How to Save a Portal as a Template on page 53 for more information) the portal is stored as 
a general (global) portal template, which can later be added to other panels. 

A list of all such global Community Portal templates is found under the Home > Templates > Community Portal 
menu command. 

 

Figure 61  Example of a Community Portal template list 

When you enter a template, you can right-click on the template name and select Permissions from the menu. A 
list of all Confirmit users in your company is then displayed, so you can decide who in your company should have 
access to use this particular template. 

5.2.5.1.5. How to Save a Portal as a Template 
To save a portal as a template for later use: 

• Right-click on the portal name and choose Save as Template. 

An identical copy of the current portal is then saved as a template. You can make changes to the copy or 
the original without the other being affected. 

5.2.5.1.6. How to Export a Community Portal 
If you wish to make a Community Portal available to another server, you can export it as an XML file. The file is 
then sent by email to a specified email address, whereupon the recipient can import it into the other server. 

1. In the Community Portal toolbox, right-click on the portal name and select Export from the menu. 

The Properties dialog opens. 
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Figure 62  The Properties dialog when exporting a portal 

2. Type the recipient’s email address into the field, then click OK. 

The Task page is displayed, showing a progress bar, the task ID and the status. On completion, the progress bar 
is at 100% and an OK button appears. An email is sent to the specified recipient, with the compressed XML file 
attached. The recipient can then save and de-compress the file, then import it into the server  (go to How to 
Import a Community Portal on page 26 for more information). 

5.2.5.2. Editing your Page Masters and Portal Pages 

Note: Confirmit is not installed on your computer locally like an application such as MS PowerPoint 
normally is. In addition, no plug-ins or ActiveX components need to be downloaded for you to gain full 
functionality. Working in Confirmit means working 100% in a browser window. All formatting is done 
using HTML and style sheets. You use HTML table or style properties to position elements on the page 
instead of moving them to a precise point as in for example PowerPoint. 

The normal method of setting up a portal page (positioning the Visual Components) is to use HTML tables (go to 
How to Add an HTML Table to the Page on page 43 for more information). A page can consist of one table or a 
combination of tables within tables. Place the various Visual Components (page elements) and images you wish 
to use, inside the appropriate table cell. 

Alternatively, you can specify each Visual Component’s position and layout by using style settings (CSS)  (go to 
Styles on page 37 for more information). 

5.2.5.2.1. Adding Rows and Columns to the Table 
You can add as many rows and columns as required to an HTML table. To add rows and/or columns, right-click 
the cell within which you wish to add a row or column, and select Insert Row/Column from the drop-down menu. 

5.2.5.2.2. Deleting Table Cells, Rows and Columns 
To delete unwanted cells, rows and/or columns, right-click in the cell you wish to delete (or a cell in the row or 
column), and choose Delete Cell/Row/Column as appropriate. 

5.2.5.2.3. Table Properties 
To set the properties for the table, right-click anywhere within the table and select Table Properties from the 
drop-down menu. 

 

Figure 63  The Table Properties page 
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The Table Properties page contains properties that are applied to the entire table. Note that similar properties are 
also available for the individual cells in the table, and if you set cell properties, then these will take precedence 
over the table properties. 

To set the background color of your table, type in the color code in the BackgroundColor text field, or double-
click in the box to the right of the BackgroundColor property. A color picker chart then opens, from which you can 
choose a color. To activate your settings choose Apply or Apply and Close. 

 

Figure 64  Editing the background color 

You can also specify the width and height of your table. The dimensions can be input as either pixels or 
percentage of the full screen. If you wish to use screen percentage, then you must type in the % character after 
the value. Otherwise the setting will default to pixels. 

In the table properties above, Cell padding, Cell spacing and Borders are set in pixels. 

Cell Spacing specifies how far apart you want the cells to be within the table, while Cell Padding is how far from 
the cell walls you want the text (or other contents) inside the cell to appear. 

5.2.5.2.4. Cell Properties 
To edit the properties of a table cell, right-click in the cell and choose Cell Properties from the menu. The 
property list shown below will appear. 

 

Figure 65  Cell properties 
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Here you can change the background color, width and height(go to Table Properties on page 54 for more 
information). Be aware that changing these settings might influence the formatting or appearance of the other 
cells in the same row or column. 

If you wish to stretch a cell across more than one row or column, input values in the Colspan and/or Rowspan 
properties to specify the number of rows/columns you want the cell to span. 

The Horizontal and Vertical alignment properties define where in the cell any elements you add to that cell will 
be placed. 

5.2.5.2.5. HTML Mode 
When building your portal pages, you would normally work in WYSIWYG mode (what-you-see-is-what-you-get). 
Users who are familiar with HTML coding can switch to HTML mode at any time. To toggle between the modes, 
click the Toggle Editor button at the left end of the toolbar. 

The figure below shows the table in HTML mode. You can at any time toggle back to WYSIWYG mode by clicking 
the same button. 

 

Figure 66  Example of the HTML editing mode 

Important: 
When working in HTML mode, do not alter or remove the code that refers to Visual Components (page 
elements). 

5.2.5.2.6. Free Text 
You can type free text into a portal page by adding it to a table cell or directly to the page itself. You can also 
copy-and-paste text into the table cells. To further edit (format) your text, use the buttons in the toolbar. These are 
standard text-editing functions. 

Note: Common keyboard shortcuts can also be used, for example CTRL-B for bold, CTRL-U for underline, 
CTRL-I for italic etc. Enter inserts a paragraph break (<p></p>) and Shift-Enter inserts a line break (<br>). 
If you paste pre-formatted text into a page from other web pages or from a text editor application such as 
MS Word, the text will keep the formatting. 

5.2.5.2.7. Images 
You can insert images/pictures directly into a portal page. 

If you are in HTML mode (go to HTML Mode on page 56 for more information)enter the HTML code (img tag) at 
the location where you want to insert the image. 

If you are in WYSIWYG mode you can copy and paste an image onto the page. You can also drag the image 
from a website or browser and drop it in the required position on a page. Be aware that if the image you wish to 
use is a hyperlink, then you must copy and paste it into the report, not drag-and-drop it, because dragging-and-
dropping an image that is a link will result in the browser trying to open the page the link points to instead of 
pasting in the picture. In this case the images will not be moved to the Confirmit site, there will just be an image 
tag referring to the original location of the image. 

You can also right-click in a table cell and select Insert Image. This will open the property frame towards the right 
side of the screen, where you can specify source (the URL to the image), width, height, border, alt (alternative 
text, for use when image is not displayed), image alignment, and horizontal and vertical spacing. 
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5.3. Panel Activity Log 
This menu command provides access to a page that logs activity in the panel. This will be primarily activity with 
Panel Rules and Sampling. The page has two tabs: 

• Overview - provides a general overview of the numbers and types of the various activities that have 
occurred. 

• Activity Logs - provides details of the activities. 

5.3.1. The Overview Tab 
This tab provides an overview of the various activities that have occurred in the panel during a specified period. 

 

Figure 67  Example of the Panel Activity Log Overview tab 

The time and date when each activity occurred is logged. Use the From and To date fields to specify the time 
period for which you wish to view the activity (either type the dates into the fields or click the icons to open date 
selection calendars). Note that the From and To fields operate on both the Overview and Activity Log tabs 
simultaneously - any activities listed in the Overview are also listed in the Activity Log. 

During the time period specified in the example shown in the figure above there have been a total of 17 activities. 
These include 12 job executions, 11 of which were successful and one of which resulted in an error, 2 sample 
uploads and 3 rule changes all of which were successful. 

Click on the appropriate activity result link (for example in the figure above the red 1 in the Error column) to go to 
the Activity Log tab and view the details for that activity. 

Go to the Activity Log tab to see the detail list of all the activities. 

5.3.2. The Activity Logs Tab 
The Activity Logs tab lists the activities that have occurred in the panel during the specified period. 
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Figure 68  Example of the Activity Log tab 

The time and date when each activity occurred is logged. Use the From and To date fields to specify the time 
period for which you wish to view the activity (either type the dates into the fields or click the icons to open date 
selection calendars). Note that the From and To fields operate on both the Overview and Activity Log tabs 
simultaneously - any activities listed in the Overview are also listed in the Activity Log. 

In the event the list is extensive, you can search it using a number of criteria to reduce it to manageable 
proportions. The search criteria are as follows: 

• Status – the status of the activity. This can be: 

o All – shows all activities. 

o OK – shows all activities that were concluded correctly. 

o Abort – shows only those activities that were aborted before completion. 

o Error – shows only those activities that were stopped due to an error. 

• Log ID – select an operator and type in a number to, for example, show all activities after a specified Log 
ID number. To reset, clear the field and click Search. 

• Username – type in the first characters of a username to show only those activities that were initiated 
while that user was logged on. To reset, clear the field and click Search. 

• Rule Set – type in the first characters of a rule set to show only those activities that included that rule set. 

• Recurring – select Yes or No to show only those activities that are recurring tasks or only those that are 
not recurring, respectively. Select All to reset. 

• Activity Type – select the type of activity that you are interested in. 

You can sort the list by the various columns - click on the appropriate column header, and click again to reverse 
the order. 

Click on a blue Log ID link to open the Logging Details page for that activity. 

5.3.3. The Logging Details Page 
Click on a Log ID link on the Activity Logs tab to open the Logging Details page for that activity. This page gives 
you detailed information on the activity, as shown in the example below. 
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Figure 69  Example of the Logging Details page 

Click on the Close button in the upper-left corner of the page to close the page and return to the Activity Logs tab. 

5.4. Database Cleanup 
When working with the database, if you delete a question (a column) and regenerate the database, the question 
and its data will no longer be visible or available in the database. However the data that was held in the column 
will not be removed from the database file in the first instance, it will merely be hidden. This is for two reasons: 

• With a large database the operation to delete the data will take a considerable amount of time and 
resources and will have a significant impact on the server performance during the time the deletion is in 
progress. It is therefore more practical to “save up” a number of deletion operations and run them 
simultaneously, thereby only causing one disturbance in the server instead of several. 

• If you should later wish to “undelete” the column, you can do this relatively easily while the data remains in 
the database (go to How to Undelete an Object on page 11 for more information). 

Note: Once you have performed a Database Cleanup, the questions and associated data will be removed 
permanently from the database. You cannot then “undelete”. 

The Database Cleanup function completely removes deleted questions/columns, and the associated data, from 
the database. Once the data is deleted by the Cleanup function, if you later need that data then you must re-
import it. 

1. Go to the Panel Utilities > Database Cleanup menu command. 

The Database Cleanup page opens. This page contains a list of the questions that have been deleted 
from the database. 

2. Check the boxes beside those questions you wish to delete permanently from the database. 

3. Click Delete Columns. 

A confirmation box with the selected questions listed appears. 

4. Click Delete to remove the questions and data permanently from the database. 
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5.5. Survey Synchronization 
The Survey Synchronization function checks all surveys associated with the current panel, and updates the panel 
if/when there are changes. This function keeps the panel data up-to-date so samples can be selected 
appropriately. 

For example: If a panelist is sent a survey and responds immediately, then the panel database can be updated 
such that the panelist is made available to be sent another survey. If on the other hand the panelist does not 
respond, then that person will not be available for further surveys until a predefined time after the current survey 
closes. 

Note: The survey rule used to synchronize the database must have Survey as the source and Panel DB as 
the target. 

Important: 
Surveys using batch statusing must include three “background” variables, named 'JobNumber' 
'RunNumber' and 'PanelistId'. They must be added as background variables in the survey tree, and they 
must be included in the fields uploaded in the sample/job. JobNumber should be an open question node 
with a suitable field width set, while RunNumber and PanelistId must be numerical open questions with a 
suitable number of digits. 

 You can set the time interval for the synchronization function as required. Note that several rules depend on this 
Survey Synchronization task to be run (go to How to Create a New Survey Rule Template on page 172 for more 
information). 

1. Go to the Panel Utilities > Survey Sync menu command. 

The dialog shown in the figure below opens. 

 

Figure 70  The Launch Survey Synchronization Task dialog 

2. Type in a comment as appropriate, and select whether you wish to run the task as soon as possible or to 
schedule it for later execution (if you schedule for execution later, you can set up a recurring task). 

3. Click OK. 

If you have selected to run the task as soon as possible, then the task is added to the queue. If you have 
selected to run the task later, then the Recurrence Pattern dialog opens (go to The Sampling Jobs List on 
page 159 for more information). 

5.5.1. Closing Surveys 
If a job arrives at its specified closing date and the survey to which the job is associated can be closed, Survey 
Sync will close the survey automatically. 

If an open survey is closed manually, Survey Sync will update the job such that it is no longer in production. 
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6. The Panel Management Menu 
This menu contains the functionality enabling you to edit panelist details and create and edit the rules employed 
to select samples from the panel. 

 

Figure 71  The Panel Management menu 

6.1. Single Panelist Editor 
This page lists the panelists registered in the database. In the upper pane, each panelist is presented as his/her 
response ID, in numerical order. In this pane you can specify the data columns that are to be displayed, and filter 
the list to focus on particular panelists. 

 

Figure 72  Example of a panelist list in the Edit window 

To select a panelist for editing, click the panelist’s Response ID number. The selected panelist’s details are then 
displayed in the Details pane in the lower part of the Confirmit window  (go to The Panelist Editor Tabs on page 
63 for more information). 

6.1.1. Search 
The Search facility enables you to conduct a simple search through the list for the required panelist, though you 
must know the panelist’s Response ID. 

To conduct a search for a panelist, select an operator, type the characters of the required panelist’s Response ID 
into the data field, then click Search. 

6.1.2. Select Columns 
Click Select Columns to open a window that allows you to specify which database columns are to be displayed 
in the Panelist Editor window. 
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Figure 73  Example of the Select Columns window 

To select columns: 

1. In the Available items column, click on the data column(s) you wish to be displayed in the list, to highlight 
them. 

Note: In the event the database contains a large number of columns, use the built-in search facility in the 
upper pare of the window to reduce the list to a manageable size. 

2. Click the >> button to move the highlighted items over to the Selected Items column. 

3. Click OK. 

The Panelist Editor window is updated automatically when you click OK. 

6.1.3. Advanced Filter 
Use this function to mount an advanced search for panelists, using logical expressions based on selecting a 
combination of specific answers provided by the panelists in the database columns. 

1. Click Advanced Filter. 

The filter window opens. The left column will contain a list of all the database columns. 
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Figure 74  Example of the Advanced Filter window 

2. Click on an item in the left column to select it. 

In the event the list is extensive, type characters into the Search field to reduce the list to a manageable 
size to enable you to find the question you are looking for. Once you have selected a question in the first 
column, the second column shows the possible answers for that question. 

The number/text/date field and the available operators change to suit the selected item. 

3. Select or type in data as appropriate into the field. 

4. Click Add Here to add the selected data to the expression. 

5. Select the required operator, and again click Add Here to add it to the expression. 

6. Repeat the steps until the desired expression is built. 

7. On completion, click OK to apply the expression to the panel. 

8. Click Search. 

The list of panelists is reduced to show only those who answer to the expression. 

You can now more easily find the panelists you need to edit the details for. 

6.1.4. Clear Advanced Filter 
Click this button to clear the expression from the advanced filter and reset the list of panelists. 

6.1.5. The Panelist Editor Tabs 
These tabs display the information relevant to the selected panelist. 

6.1.5.1. The Details Tab 
This tab shows the details of the selected panelist. 
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Figure 75  Example of the Details tab for a selected panelist 

To edit the details, click on the appropriate link in the Answer Text column. A separate Editing window opens. 
Here you can type in the new details. On completion, click OK to save the changes and close the window. 

 

Figure 76  Example of a panelist details editing window 

6.1.5.2. The All Surveys Tab 
This tab lists all the surveys the selected panelist has been involved with. This list is basically a combination of the 
lists in the remaining tabs in this area of the window. Note that this list also includes closed and/or deleted 
surveys, and surveys where the panelist has the status "Reserved". 
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6.1.5.3. The Completed Surveys Tab 
This tab lists all the surveys the selected panelist has completed. Note that this list also includes closed and/or 
deleted surveys, and surveys with the status "quota full" or "screened". 

6.1.5.4. The Surveys Started Not Completed Tab 
This tab lists all the surveys the selected panelist has started but not yet completed. Surveys with the status 
"quota full" or "screened" are not included here; these are included in the Completed Surveys list. 

Note that this list also includes closed and/or deleted surveys. 

Links to the surveys are provided. Click the link to open a new window with the URL to the survey, as shown in 
the example below. If you wish to view the survey, copy the URL into your browser. 

 

Figure 77  Example of the Survey Link window 

6.1.5.5. The Surveys Not Started Tab 
This tab lists all the surveys the selected panelist has been sent but has not yet started. A link to the survey is 
provided. Note that this list also includes closed and/or deleted surveys. 

6.2. Multiple Panelist Editor 
Use this function to edit the details of several/many panelists simultaneously. Note that the same changes will be 
made to the details of all panelists selected using this method. When you go to the Multiple Panelist Editor, the 
page shown in the figure below opens. 

 

Figure 78  Example of the Multiple Panelist Editor page 
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Note: If a rule already exists that will find the panelists you wish to edit (and only those panelists!), then 
you can click Select Rule and select that rule from the resulting list (go to Current Rule on page 68 for 
more information). 

Note: To simplify the scripting procedure you can download and use the Code Completion function. Refer 
to the Authoring User Guide for further details. 

To create a condition: 

1. Click Edit. 

The Expression Editor window opens as shown below. 

 

Figure 79  Example of the Expression Editor window 

o The left column lists all the questions/columns in the panelist database. 

o The second column lists the possible answers for the question/column selected in the first column. 

o The third column lists the operators and functions available for the question/column selected in the first 
column. 

o The Expression area displays the expression as you build it, both as the entered code and as 
“explanatory text” below the Expression field. 

Note: If you have the necessary knowledge/information you can type the expression directly into the 
Expression field. However by doing this you risk creating errors that will prevent the expression from 
functioning correctly. In most cases, the most efficient method of creating the expression is by using the 
procedure described below. 

2. In the left column, find the question/column you wish to add to the expression and click on it to select it. 

In the event the list is extensive, type characters into the Search field to reduce the list to a manageable 
size to enable you to find the question you are looking for. Once you have selected a question in the first 
column, the second column shows the possible answers for that question. 

3. In the second column, select or type in the answer you require. 

4. In the third column, select the required operator and function. 

5. In the expression area, click Add Here to copy the selected question and answer(s) into the expression. 

6. Repeat the procedure as required to build the desired expression. 
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Figure 80  Example of an expression under construction 

7. Click Validate to check the expression does not contain errors. 

Note: Errors will not be possible if you use the method described here, but can arise if you type the 
expression directly into the Expression field. 

8. On completion, click OK. 

The Expression Editor window closes and the expression is copied into the Condition field in the Panelist 
Editor window. 

9. Click Save to save the changes. 

 

Figure 81  The Panelist Editor with the condition 

You now have the condition (ringed above) that will find the panelists that you wish to edit. You must now define 
which answer you wish to change for these panelists, and what you wish to change the answer to. 

10. In the Available column, find and select the answer column you wish to edit. 

11. Click the >> button to transfer the selection to the Selected column. 

12. In the Action field, type in the change you wish to make. 
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Note: the syntax required here is the same as used in the Rule Editor functionality (go to Current Rule on 
page 68 for more information). 

13. Click Save to save the changes. 

14. When you are sure the condition will find the required panelists, and the change you have specified is 
correct, click Execute to run the condition. 

The system now checks through the panel looking for any panelists answering to the condition. Note that 
in a large panel this may take some time. On completion, a dialog box opens indicating how many 
panelists have been found answering to the condition. 

 

Figure 82  Example of a search result 

15. If you wish to update the panelist records, click Update. Otherwise, click Cancel. 

6.3. Current Rule 
Rules are used to change data and move/copy it from one place to another. For example you can use rules to 
update the database. 

The Current Rule page shows the details of the rule selected in the Rule List  (go to Rule List on page 84 for more 
information). When you select a rule in the Rule List, the Current Rule page opens at the General tab – see the 
next section. 

Note: Until you have selected a rule from the Rule List during the current session, the Current Rule menu 
command will take you to the Rule List. 

The following buttons are common for all the tabs in the page: 

• Back – takes you back to Rule list 

• Save – saves any changes made. 

• Duplicate – makes a duplicate copy of the rule. Use this if you need to make a rule that will be similar to 
an existing rule. You can then edit the copy. 

• Execute – once you have set up the rule and are sure it is correct, click this button to run the rule. 

• Validate Action Script – checks the script created in the Action tab to ensure there are no errors. 

• Export Rule – exports the rule so it can be imported into a different Panel server. 

6.3.1. The General Tab 
The Rule Details > General tab shows the details of the currently selected rule. Here you can change the rule’s 
Name, write in a Comment and set the Status. The remaining information cannot be edited. 
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Figure 83  Example of the Rule Details > General tab 

• Status – select the required status for the rule. The options are: 

o Enabled – select to allow the rule to be run “as required”. This is the default setting. 

o Disabled – select this option if you wish to prevent the rule from being run. This could be useful if you 
have a recurring task, and wish to stop using this rule in that task for a period but do not wish to 
change the task permanently. 

o One Run Only – select to specify that the rule is to be run only once. 

6.3.2. The Source Tab 
Use this tab to specify the data source on which the rule is to operate. The data to be moved or changed can 
come from a number of sources – select the Source Type. The subsequent screen layout depends on the Source 
Type selected. 

Note: A survey rule that is to be used to synchronize the panel database with a survey must have 
"Survey" as its source. 

6.3.2.1. Source Type > File 
Select this option if the data source is a file. The Source tab layout is then as shown in the figure below. 

 

Figure 84  The Source tab with File selected as the Source Type 
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• Formatting – data is copied out as a text file. Select comma-separated or tab-separated as required. 

• Locale – specify the area or country in which the data in the file is to be used. This will allow the system to 
format fields such as date fields according to local standards. 

• Unicode – check this box if the file is saved as Unicode. The Code Page property is then disabled. 

• Code Page – select the code used in the file. 

• Uploaded File - import files can either be uploaded directly in the browser, or placed on an FTP server 
and retrieved from there (see below). Select the required option. 

• Pick up from FTP Location - if your company has licensed the FTP add-on and it has been enabled, this 
option will be active. You can then fetch the file to be uploaded from Confirmit's FTP location. Confirmit's 
FTP address is specified as part of the enabling procedure and cannot be changed, so you must add only 
the file name to this field. If you select this option, then you can also decide what to do with the original file 
on the FTP site; leave it there or delete it (see below). Note that fetching from FTP can allow automation 
of data flows, since you can set up the system to pick up files automatically 

• File Handling - if you have selected to use the FTP option (see above), then you can decide what to do 
with the file on the FTP site after it is uploaded; leave it there or delete it. 

• Encrypted File - if your company has licensed the Encryption add-on and it has been enabled, the data 
transfer encryption functionality makes it possible to perform secure data transfers in Confirmit. If the 
source file has been encrypted by the sender using your PGP public key, you will need to decrypt the files 
using your private key. Note that an administrator setting makes it possible to force every Confirmit user 
within a company to use encryption and FTP server during data transfer.  

1. Make the required settings, save them, then click Upload File. 

A File Upload dialog opens. 

2. Browse to and select the file to be uploaded, then click OK to load the file. 

After the file is loaded, the Mapping Setting button appears. 

3. Click to open the Mapping page. 

 

Figure 85  Example of the Mapping page 

Field names in the uploaded file that are not the same as field names in the database must be mapped 
manually to the appropriate fields in the database. Any field names in the uploaded file that are identical to 
field names in the database will be mapped automatically. 
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4. Map any unmapped fields to the appropriate columns in the database. 

To do this, select the Unmapped File Field (ringed in the upper-right corner of the page), then select the 
Panel Database Field to which you want to map the File Field (ringed towards the left side of the page), 
then click Map Field (arrowed in the toolbar). Note that in this case, as the File Field is named the same 
as the Database Field, the mapping would have been performed automatically. 

5. On completion, click Back to return to the Source tab. 

6. Click Save to save the changes. 

Note: If you have more than one BitStream data source in a panel and use rules to update them (go to 
Target Type > BitStream Files on page 78 for more information), then when you need to update one 
BitStream set it is very important that you update all of them. If this is not done, then the “not-updated” 
BitStream files may be inconsistent and will then produce incorrect results. 

An example to illustrate the situation: 

Assume that you have two separate BitStream sets, A and B, and you have a number of sampling jobs working 
on each. When you run a sampling job on a BitStream set, this will cause the selected panelists to be noted in a 
table of “dirty” panelists – these are essentially panelists who have been selected for one or more jobs without the 
BitStream data source being informed (the BitStream data sources cannot know that a panelist has been selected 
for a job until the files are updated). When a sampling job is run, dirty panelists are detected by looking in the dirty 
table, so any panelists currently in the table will be checked and excluded/included as appropriate. If you now 
update BitStream set A, the panelists involved here will no longer be dirty, so will be removed from the dirty table. 
However BitStream set B has not been updated yet so still does not know about the dirty panelists. As these have 
now been removed from the dirty table they will not be noted, and there is a very real chance that when running 
another job on BitStream set B, panelists who should be excluded will be selected. 

6.3.2.2. Source Type > Database 
Select this option if the data source is a database. The Source tab layout is then as shown in the figure below. 
Note that the option is only available for a server installation, and is set up in the System Configuration.   

 

Figure 86  The Source tab with Database selected as the Source Type 

• Connection String – the connection string used to connect to the database. 

• Table Name – to select entire table, write in the table name. Otherwise, define a Query String if you only 
want part of the table. Here you must use SQL syntax. 

6.3.2.3. Source Type > Panel Database 
When you select Panel Database as the source type, the Source tab layout is as shown below. 
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Figure 87  The Source tab with Panel Database selected as the Source Type 

• Expression / Edit – click to open an expression editor window so you can create an expression to select 
the data you wish to be manipulated. The functionality in this window is the same as that for the Multiple 
Panelist Editor. For further details (go to Multiple Panelist Editor on page 65 for more information). 

• Survey History Variables – this option only becomes available if the Target type is File or Bitstream 
Files. Check the box and select the required variables. 

Note: When the Source Type is Panel Database and the Target is a File, you can format the values to be 
copied, for example the date format, field widths etc. 

6.3.2.4. Source Type > Survey 
Select this option if the data source is a survey. The Source tab layout is then as shown in the figure below. 

Note: A survey rule that is to be used to synchronize the panel database with a survey must have 
"Survey" as its data source. 
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Figure 88  The Source tab with Survey selected as the Source Type 

Note: The Execute button is not available for this Source Type selection. 

Note: When you select Source Type to be Survey, on the Target tab the Target Type parameter must be 
set to Panel Database and the Target Mode parameter must be set to Update  (go to Target Type > Panel 
Database on page 78 for more information). 

• Survey Status – select the required option. Additional fields will be activated depending on the selection. 
All options and fields are described below. 

o Complete – selects only data from surveys with the status Complete. 

o Incomplete – selects only data from surveys with the status Incomplete. 

o Non-starters – selects only data from surveys that have not been started (respondent data). 

o All Responses - selects all the response data. 

• Additional Survey Variables – type in the names of the questions you wish to retrieve from the survey, 
separated by comma. These fields can be used in the action script. To access the field in the script, the 
variables must be prefixed with ‘Survey.’. I.e. If you have selected interview_start as an Additional Survey 
Variable, you must write Survey.interview_start in the script to get the value for the current panelist. 
Click the Validate Action Script button to check the script. 

• Community Panel Variables – fields selected here are retrieved and can then be updated. Any variables 
selected here will be listed in the Available Fields column on the Action tab (go to The Action Tab on page 
74 for more information). 

• Survey History Variables – the fields in the Survey History table. 

Important: 
Surveys using batch statusing must include three “background” variables, named 'JobNumber' 
'RunNumber' and 'PanelistId'. They must be added as background variables in the survey tree, and they 
must be included in the fields uploaded in the sample/job. JobNumber should be an open question node 
with a suitable field width set, while RunNumber and PanelistId must be numerical open questions with a 
suitable number of digits. 

6.3.2.5. Source Type > BitStream Files 
Select this option if the data source is to be a BitStream file. The Source tab layout is then as shown below. 
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Figure 89  The Source tab with Bitstream Files selected as the Source Type 

• Datasource - this field contains a list of the available BitStream files. Select the required file to populate 
the Available list. In the figure above, Active Panelists is selected. 

• Expression / Edit – click to open an expression editor window so you can create an expression to select 
the data you wish to be manipulated. The functionality in this window is the same as that for the Multiple 
Panelist Editor. For further details (go to Multiple Panelist Editor on page 65 for more information). 

• BitStream variables - select the required variables. 

• Survey History Variables – check this box only if exporting data and then if the result will be files, or if 
you wish to generate BitStream files. 

6.3.3. The Action Tab 
Use the Action tab to specify actions that are to be performed on the data. The Action tab has four sub-tabs: 

• Script - write into this tab the actions that are to be run on the selected source records. The actions are 
run once for each record. 

• Global Variables - here you must define the script properties that will be available to all the records. 

• Global Script - any actions written in this tab are run once at the beginning of the process. 

• Post Script - any actions written in this tab are performed once after all the other actions have been 
performed. 

Note: You are not required to enter information into this tab. However, any scripting entered on this tab 
must be in JSCRIPT.NET format. Refer to MSDN.COM for further details. 

You can simplify your scripting task by downloading the Code Completion add-on. See below for details. 

Fields selected in the Source tab (go to The Source Tab on page 69 for more information) are listed in the 
Available Fields column. These fields are available as Strongly Typed Properties in the script code. 

If you wish to change data, write the required action into the Action field. 
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6.3.3.1. The Code Completion Functionality 
Code Completion is a downloadable 3rd-party add-on that means that you no longer need to remember or look up 
which properties belong to which classes and which parameters the various methods accept. Instead, these are 
available at the touch of a button. The add-on automatically color-codes key words, and provides lists of 
selectable options under specific conditions while scripting. 

Code Completion must be installed locally. Once downloaded and installed, you must contact Confirmit to have 
the add-on activated at company level. The Code Completion functionality is then available in Confirmit wherever 
script coding can be used. 

Refer to the Confirmit Authoring User Guide for further information. 

Note: Code Completion is offered as a Beta, to be used by clients at their own risk. Support for this 
functionality will be offered, but not to the same extent as for the rest of the Confirmit application. 

6.3.3.2. The Script Tab 
Into this tab you must type in the actions that are to be run for the selected source records. Each action will be run 
once for each selected record. 

 

Figure 90  Example of the Script tab 

Note that any variables selected in the Source tab are listed in the Available Variables column. 

6.3.3.3. The Global Variables Tab 
In this tab you must define any script properties that are to be available to the database records. 
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Figure 91  Example of the Global Variables tab 

6.3.3.4. The Global Script Tab 
Any actions written here are performed once at the beginning of the process. Here you could, for example, tell the 
system to send you an email to inform you that the scripting procedure is about to start. 

 

Figure 92  Example of the Global Script tab 

6.3.3.5. The Post Script Tab 
Write into this tab any actions that you wish to be performed once, only on completion of the other Script actions. 
An example here could be to tell the system to send you an email once the scripting process is complete. 
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Figure 93  Example of the Post Script tab 

6.3.4. The Target Tab 
Use the Target tab to select the target for the data defined in the Source tab (go to The Source Tab on page 69 
for more information). The fields available on the Target tab depend on the Target Type that you select. 

Note: A survey rule that is to be used to synchronize the panel database with a survey must have "Panel 
DB" as its target. 

6.3.4.1. Target Type > File 
The fields available when File is selected as the Target Type. 

 

Figure 94  The tab when File is selected 

• File Name – type in the name of the file the data is to be copied to. 

• Formatting – the data is copied out as a text file. Select Comma Separated, Tab Separated or Custom as 
required. 

• Custom Delimiter - if you have selected Custom, select the delimiter you wish to use. 

• Locale – specify the area or country in which the data in the file is to be used. This will allow the system to 
format fields such as date fields according to local standards. 

• File transfer - export files can either be sent by email or placed on an FTP server. FTP may be a good 
option for large volumes of data, since emails with large attachments may be blocked. FTP can allow 
automation of data flows, since files can then be picked up automatically by another system/process. Note 
that FTP transfer can be enforced as a company setting, in which case the email option will not be 
selectable. Refer to the Administrator manual for further details. 
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• Encrypt file - if your company has licensed the Encryption add-on and it has been enabled, the data 
transfer encryption functionality makes it possible to perform secure data transfers in Confirmit. If the 
source file has been encrypted by the sender using your PGP public key, you will need to decrypt the files 
using your private key. Note that an administrator setting makes it possible to force every Confirmit user 
within a company to use encryption and FTP server during data transfer. Check the box to use file 
encryption. 

• Email Address – the email address to which the file is to be sent. 

Note: When the Source Type is Panel Database and the Target is a File, you can format the values to be 
copied, for example the date format, field widths etc. 

6.3.4.2. Target Type > Database 
The fields available when Database is selected as the Target Type. 

 

Figure 95  The tab when Database is selected 

• Connection String – type in here the connection string used to connect to the database. 

• Table Name – type in here the name of the table into which the data is to be copied. 

• Mapping Setting – you can map fields from the source to the fields in the database table. 

6.3.4.3. Target Type > BitStream Files 
The fields available when BitStream Files is selected as the Target Type. 

 

Figure 96  The tab when BitStream Files is selected 

• File Name – type in here the name of the BitStream file into which the data is to be copied. 

• BitStream Name – type in here the name that is to be displayed for the BitStream files 

6.3.4.4. Target Type > Panel Database 
The Panel Database target type is used to update the database. 
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Figure 97  The tab when Panel Database is selected 

Note: A survey rule that is to be used to synchronize the panel database with a survey must have "Panel 
Database" as its target. 

• Target Mode – specify how the source data is to be added to the database. 

o Update – use if the source is a Panel database or if the Source is a file, and the file does include a 
Response ID column. 

o Import – use if the Source is a file, and the file does not include a Response ID column. 

o Import with key – use if the Source is a file, and the file does include a Response ID column. 

Note: When you select Source Type to be Survey (go to Source Type > Survey on page 72 for more 
information), on the Target tab the Target Type must be set to Panel Database and the Target Mode must 
be set to Update. 

6.3.4.5. Target Type > None 
This type of "target" needs an Action script (go to The Action Tab on page 74 for more information) but produces 
no data output. Use this option if you for example wish to test a rule, send emails, log rules etc. 

6.3.4.6. Target Type > Snapshot Database 
The Snapshot Database target type is used when rule is to copy data to a snapshot database (go to The 
Snapshot Panel on page 174 for more information). The fields available when Snapshot Database is selected as 
the Target Type are as shown below. 

 

Figure 98  The Target Type tab when Snapshot Database is selected 

• Project ID - the Snapshot project selected in the Overview page (go to Overview on page 19 for more 
information). 

• Column Mapping - when you duplicate a standard project to create a snapshot project, the variables will 
be identical. If however you have built a snapshot project or wish to base it on a different project then you 
may have different variables in the two projects. Click this button to open a Mapping window where you 
can map the panel database variables to the snapshot database variables as required. 

6.3.5. How to Duplicate a Rule 
To save time while creating a new rule, if you have an existing rule that is similar then you can duplicate it. 

1. In the Current Panel Rule page, click Duplicate. 

The Duplicate Panel Rule dialog opens. 
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Figure 99  The Duplicate Panel Rule dialog 

2. Type in a name for the new rule, then click Finish. 

The rule is duplicated, and will appear in the Panel Rules list. The Panel Rule Details page opens showing 
the new duplicate rule. You can now edit the new rule as required. 

6.3.6. How to Execute a Rule 
Run the rule to perform the actions that are specified. 

1. In the Current Rule page, click Execute. 

The rule is checked to ensure the required information is present. If it is acceptable, the Rule Execution 
Properties dialog opens. 

 

Figure 100  The Rule Execution Properties dialog 

2. Type any comments into the Comment field. 

3. In the Start Time field, select when you want the task to be run. 

4. Select ASAP to run the job as soon as it gets to the front of the task queue in the server. Select Schedule 
for Later Execution if you want the job to be run at a specific time in the future or if you want the job to be 
repeated at regular intervals. 

5. Click OK. 

If you have specified that the task is to run as soon as possible (ASAP) then a Task page opens showing 
a progress bar, the Task ID and the sequences being run and completed. 

If you have specified that the task is to be scheduled for later execution, then a Recurrence Pattern dialog 
opens (go to The Sampling Jobs List on page 159 for more information). 

On completion, the text Task Completed is displayed at the bottom of the sequence list. 

6. Click OK to close the Task page and return to the Panel Rule Details page. 

6.3.7. Validating an Action Script 
Click to check the script for compilation errors. If errors are found, they will be listed in a separate window. You 
must then correct the errors and validate again. 

6.3.8. How to Export a Rule 
You can export rules to other servers and/or panels. Proceed as follows: 

1. Save the rule to ensure all changes/updates are included. 

2. Click Export Rule. 
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The Export Rule dialog opens. 

 

Figure 101  The Rule Export dialog 

3. Edit the email address to which the rule is to be sent, and add a comment, as necessary. 

4. Click OK. 

An email is sent to the specified address with the rule attached. This rule must now be imported into the 
destination server (go to How to Import a Rule on page 86 for more information). 

6.4. Current Rule Set 
A Rule set is a collection of rules that are to be run as one. The rules are run in the order in which they are listed 
in the set. Go to the Panel Management > Current Rule Set menu command to open the latest rule set selected 
from the Rule Set List. If no rule set has been selected during the current session, then the Rule Set List will be 
displayed (go to Rule Set List on page 86 for more information). 

6.4.1. The General Tab 
The Rule Set Details page opens at the General tab. 

 

Figure 102  Example of the Rule Set Details page > General tab 
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• Rule Set ID – the identification number for the rule set. This number is generated automatically by 
Confirmit and cannot be changed. 

• Rule Set Name – the name given to the rule set when it was created/last edited. You can change this 
name as required. 

• Type – the type of rule set. The options are: 

o Ad Hoc – a rule set that is created for a specific use/event. 

o Recurring – a rule set created to perform a long-term job, that will normally recur at regular intervals. 

• Comment – a description of the rule set, to simplify identification. 

• Status – the status for the rule set. 

o Enabled –allows the rule to be run “as required”. This is the default setting. 

o Disabled – select this option if you wish to prevent the rule from being run. This could be useful if you 
have a recurring task, and wish to stop using this rule set in that task for a period but do not wish to 
change the task permanently. 

• Disable Sampling When Executing – check the box to prevent sampling being performed on the 
database while the rule set is being run. 

• Date information – for information only. 

6.4.2. The Rule Management Tab 
Use this tab to specify what is to occur in the event Confirmit discovers an error whilst the rule set is running. To 
set up the properties for a rule in the set, double-click on the rule in the left column to open the Details page. 

 

Figure 103  Example of the Rule Management tab 

• On error – select the function you wish to occur in the event Confirmit discovers an error whilst the rule 
set is running. The options are: 

o Continue – select this option if you wish the rule set to continue running. 

o Stop – select this option if you wish the rule set to be stopped. 

o Jump to – select this option if you wish the current rule to be stopped and the rule set to jump to 
another rule. If you select this option, you must then select the rule to which the set is to jump, from 
the list below the “on error” options. 

6.4.2.1. How to Add a Rule to the Rule Set 
1. Go to the Panel Management > Current Rule Set menu command. 

2. In the Rule Management tab, click the down-arrow beside the Rule field to open a drop-down list of the 
rules available (once a rule is added to the set, it is removed from the list). 
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Figure 104  Selecting a rule to add to the rule set 

3. Select the required rule from the list and click Add. 

The rule is added to the rule set. 

 

Figure 105  The rule added to the rule set 

4. Double-click on the rule to open its Details pane, then make the appropriate settings. 

5. On completion, click Save to save the changes. 

6.4.3. The Report Tab 
This tab provides an overview of the contents of the various rules selected in the Rule Management tab. 
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Figure 106  Example of the Report tab 

Click Printer Friendly Version to open the report in a new window, formatted to be printed out or saved. 

6.5. Rule List 
Go to the Panel Management > Rule List menu command to display a list of all the rules in this panel. From this 
tab you can create new rules, and import rules from other panels. 

 

Figure 107  The Panel Rule List 

Click on a Rule Name link to open the Current Rule page for that rule (go to Current Rule on page 68 for more 
information). 

In the event the Rule List is extensive, you can search for the required rule using the search criteria fields. Select 
or set the appropriate criteria and click the Search button towards the right end of the search bar. The fields are 
as follows: 

• ID - the automatically-generated identification number of the rule. Select the appropriate operator and type 
a number into the field. 

• Rule Name - the name of the rule, defined by the creator on the Current Rule > General tab. 
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• Source - the source to be used by the rule - defined by the creator on the Current Rule > Source tab. 

• Target - the target to be used by the rule - defined by the creator on the Current Rule > Target tab. 

• Rule Set Name - if the rule has been included in a Rule Set, then it will be indicated here. 

• Created By - the user name of the person who created the rule. 

• Last Executed - the date and time of when the rule was last executed. Select the appropriate operator, 
then click on the Calendar icon to open a calendar and select the desired date. 

• Last Executed By - the user name of the person who last executed the rule. 

6.5.1. How to Create a New Rule 
1. Click the New Rule Button towards the right end of the Panel Rule List toolbar. 

The Add New Panel Rule form opens at the General tab. Note that until you have named and saved the 
new rule, the other tabs in the form are inactive. 

 

Figure 108  The Add New Rule page 

2. In the Rule Name field, type in a name for your new rule. 

3. Type a comment/description into the Comment field so others can see what this rule is intended for. 

4. Select the status for the new rule. The options are: 

o Enabled – select to allow the rule to be run “as required”. This is the default setting. 

o Disabled – select this option if you wish to prevent the rule from being run. This could be useful if you 
have a recurring task, and wish to stop using this rule in that task for a period but do not wish to 
change the task permanently. 

o One Run Only – select to specify that the rule is to be run only once. 

5. On completion, click Save. 

The new rule is saved and will now appear in the Panel Rules list. The system allocates a Rule ID to the 
new rule, and this ID is displayed towards the top of the form. The form changes to the Panel Rule Details 
form (go to Current Rule on page 68 for more information), and the Source, Action and Target tabs 
become active. Go to these tabs and make the appropriate settings. 
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Figure 109  Example of the Panel Rule Details form 

Note: A rule that creates BitStream files from the panel database must be created before sub samples can 
be created (go to How to Create a New Sub Sample on page 112 for more information). For this rule, the 
Source must be Panel Database, the Target must be BitStream, and SurveyStatus must be selected in the 
Survey History Variables field. 

6.5.2. How to Import a Rule 
You can copy rules to other servers or panels by using the Rule Export / Import functionality (go to How to Export 
a Rule on page 80 for more information). Proceed as follows to import a rule into the current Panel or server. 

Note: The rule must be available as an .XML file (zipped or open) in a folder accessible from the current 
panel. The file will have been sent, attached to an email, from the originating server/panel. 

1. Go to the Panel Management > Rule List menu command to open the Rule List window. 

2. Click the Import Rule button towards the right end of the toolbar. 

The Rule Import dialog opens. 

 

Figure 110  The Rule Import dialog 

3. Browse to and select the file. 

4. Type a name for the rule into the Rule Name field. 

5. Click OK. 

The rule is imported and added to the Rule List. 

6. Click on the blue Rule Name link to open the rule in the Current Rule window (go to Current Rule on page 
68 for more information). 

6.6. Rule Set List 
Go to the Panel Management > Rule Set List menu command to display a list of the rule sets available. 
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Figure 111  Example of the Rule Set List 

Click on the blue Rule Set Name link for the desired rule set to select that rule set and open the Current Rule Set 
window (go to Current Rule Set on page 81 for more information). In the event the list is extensive, use the search 
functionality to reduce the list to a manageable size. 

6.6.1. How to Create a New Rule Set 
1. In the Rule Set List window, click the New Rule Set button towards the right end of the toolbar. 

The New Rule Set dialog opens. 

 

Figure 112  The New Rule Set dialog 

2. Type the name of the new rule set into the field, then click OK. 

The rule set is added to the list. 

3. Click on the blue Rule Set Name link for the rule set to select it and open the Current Rule Set window 
(go to Current Rule Set on page 81 for more information). Here you set up the rule set properties and add 
rules. 

6.7. Aggregated Variable List 
Aggregated Variables are variables specified by the user. These variables are used in aggregate queries to 
update the Panelist table based on information in the Survey History table. The Aggregated Variable List lists all 
the aggregated variables available for this user. 

 

Figure 113  Example of the Aggregated Variable List 

To open an Aggregated Variable, click on the blue Name link for that variable in the list. If the event the list is 
extensive, use the search functionality to reduce the list to a manageable size. 

6.7.1. How to Create a New Aggregated Variable 
1. Go to the Panel Management > Aggregated Variable List menu command. 

The Aggregated Variables window opens. 

2. Click on the New Aggregated Variable button towards the right end of the toolbar. 

The New Aggregated Variable dialog opens. 
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Figure 114  The New Aggregated Variable dialog 

3. Type a name for the variable into the Name field, then click Finish. 

The variable is created and added to the Aggregated Variable List, and the variable opens for editing. 

 

Figure 115  Example of the editing page for an Aggregated Variable 

• Name – the name of the selected virtual variable. You can edit this as required. 

• Aggregate Operator – select the type of operator you wish to use. Options are: 

o Count – counts the number of rows in the table that satisfy the condition, and outputs the result. 

o Avg – totals the values in the table fields that satisfy the condition, and outputs the average value. 

o Min – examines the values in the table fields that satisfy the condition, and outputs the minimum 
value. 

o Max – examines the values in the table fields that satisfy the condition, and outputs the maximum 
value. 

o Sum – totals the values in the table fields that satisfy the condition, and outputs the result. 

• Output Field Name – specify the field in the Survey History table that the condition is to be run on. Note 
that the fields available will depend on the Aggregate Operator selected. 

• Condition – click Edit to open a condition editor window, then create the required condition  (go to 
Multiple Panelist Editor on page 65 for more information). On completion, click Save to copy the condition 
to the Expression field. 

• Expression – the expression that will be used for the aggregated variable. This is arrived at by combining 
the selected Aggregate Operator and Output Field Name, and the Condition. 

• Comment – type in a comment or description for the variable. 
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• Date information – for information only. 

Once you have created and saved the Aggregated Variable, it will be available for use in the Community Panel 
Variables field in the Current Rule > Source tab  (go to Source Type > Panel Database on page 71 for more 
information). 

6.8. Panelist Credits 
This menu command enables you to import and export panelist credits (go to Credit Balance on page 50 for more 
information). The menu contains two options: 

 

Figure 116  The Panelist Credit menu 

6.8.1. How to Export Panelist Credits 
This procedure exports the panelist credits for all the panelists in the selected panel. To export panelist credits: 

1. Go to the Panel Management > Panelist Credit menu command and select Export. 

The Export Panelist Credits dialog opens. 

 

Figure 117  The Export Panelist Credits dialog 

2. Select the type of transfer you wish to perform; Email or via FTP. 

Note: The FTP transfer option is a chargeable add-on. This option will only be available if your company 
has the appropriate license. If so, the FTP site details will be specified automatically by Confirmit. 

3. If Email is selected, check the recipient email address is correct and edit as necessary. 

4. Specify the start time for the transfer. 

If you select Schedule for Later Execution, you can set the export to be a recurring task, that is, it will be 
performed automatically at specified time intervals. 

5. Click OK. 

The task runs at the specified time, and the panelist credits are exported as a zipped .txt file. 

6.8.2. How to Import Panelist Credits 
The panelist credits for a panel can be exported as a zipped .txt file, via email, or if you have the appropriate 
license, via FTP (go to How to Export Panelist Credits on page 89 for more information). If the file has been 
exported via email, save the file attachment to an appropriate folder in your network. 

1. Open the Panel to which you wish to import the panelist credit file. 

2. Go to the Panel Management > Panelist Credit menu command and select Import. 

The Import Panelist Credits dialog opens. 
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Figure 118  The Import Panelist Credits dialog 

3. If the file has been exported via email, select the Transfer Type to be Upload then browse to the file that 
is to be uploaded and select it. If the file has been exported to FTP, type the file name into the File Name 
field. 

Note: FTP export requires your company to license an add-on. The FTP site details will then be specified 
automatically by Confirmit. 

4. Select the Key Field that is to be used to identify the panelists to which each credit value is to be credited. 

This list is populated automatically from the fields available in the panel. 

5. Set the start time for the import task. 

Note: If the file is to be exported at regular intervals (using a recurring task) then you can also set the 
import to occur at corresponding intervals, thereby updating the credits automatically. In this case, 
ensure you allow a delay between the times set for the exports and the imports to allow for possible 
queues in the task server. 

6. Click OK. 

The import will be performed at the specified time(s). 

6.9. The Panel Settings 
You can define some custom settings for the panelists' password requirements. These are defined separately for 
each panel, so different panels can have different password requirements. 

Note: You must actively go to the Panel Settings page and make the settings for each panel. No changes 
will be made to the panel's password settings unless you do so. 

1. When in the Community Panel, go to the Panel Management > Panel Settings menu command. 
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Figure 119  The Panel Management > Panel Settings menu command 

The Panel Settings page opens. 

 

Figure 120  The Panel Settings page 

The options are as follows: 

• Password expiry days - specify how many days the password is to be valid after it has been changed. 
Use 0 to disable this functionality such that the password does not expire. 

• Password history - specify that the new password must be different from the last X passwords used. This 
prevents the panelist merely using the same password over and over again. Use 0 to disable this 
functionality such that the same passwords can be reused. 

• Minimum age - specify the number of minutes the user must wait after changing the password before 
they are allowed to change it again. Use 0 to disable this functionality. 

• Minimum required length - specify the minimum number of characters (of all types) that a password 
must have. Use 0 to disable this functionality such that a password can be of any length. 

• Minimum required non alpha characters - specify the minimum number of non alpha characters a 
password must have. This will force the panelist to use numerical and/or other characters in the password, 
thereby making it more difficult to guess. Use 0 to disable this functionality such that the panelist can use 
only alpha characters if so desired. 
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• Minimum required non alpha numeric characters - specify the minimum number of non alpha-numeric 
characters (for example #¤%& etc) that must be included in the password. Use 0 to disable this 
functionality. 

• Minimum required uppercase characters - specify the minimum number of upper-case characters that 
must be included in the password. Use 0 to disable this functionality. 

• Password similar to username - check the box if the password is to be validated against the username 
to ensure that the password and username are not identical. Leave the box unchecked to disable this 
functionality, thereby allowing the panelist to use their username also as their password. 

2. When you have made the required changes, click Save to save them. 

(go to Password Policy on page 4 for more information). 
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7. The Sample Management Menu 
A Sample is a group of people who have been selected from a Panel to participate in a particular survey. The 
members of the sample will have specific characteristics that make them suitable for that survey. 

When a person agrees to be a panelist, they complete a questionnaire to provide their personal details and other 
information that the survey company (your company) may require. There could be hundreds of questions. These 
could include such details as where the panelist lives, whether they drive and/or own a car and if so what type, 
whether they have any children and if so how many, their ages, sexes, what types of schools they attend, whether 
they have any pets and if so what types etc. The panelist’s answers to these questions are entered into a 
database and later used to determine the panelist’s suitability to participate in a particular survey. For example, if 
a company that manufactures dog-food has asked for a survey to be conducted to analyze dogs’ preferences in a 
particular town, there is not much point in including a panelist who does not own a dog or who lives in a different 
town. 

Additional criteria, such as whether the prospective panelist has recently participated in a survey of a particular 
category, or participated in a survey of any category, within a specified period, can also be included in the sample 
selection process. These “exclusion” criteria will help to prevent panelists becoming overworked and perhaps 
bored with answering surveys. You can also use similar functionality to re-include potential panelists who were 
previously excluded automatically for other reasons. 

Confirmit’s Sample Management function uses the panelists’ details in the database and the additional criteria to 
select the appropriate panelists for a particular survey. 

The panelists that are selected for a survey are “booked” in the system for a defined period from the moment that 
the job for which they have been selected is executed. The selected panelists are flagged in the database, and 
will be available to be included in jobs that are executed later according to the mailing dates and exclusion rules 
for those jobs. 

The sections in this chapter describe the functionality available through the Confirmit Sample Management menu, 
and the procedures required to make use of that functionality.  

Note: The Community Panel functionality may be purchased as a separate add-on module within 
Confirmit. 

 

Figure 121  The Confirmit Sample Management menu 

Click on Sample Management to access the sub-menu commands. The Job List is automatically displayed below 
the menu. Click on a job in the list to select it and go to the Current Job window. 

7.1. Current Job 
A sampling job is a group of sampling definitions with common properties that is to be scheduled and executed as 
one job. This produces a sample file as output, and some reports on the outcome of the sampling job. The 
sampling job will operate on a subset of the panel defined by a “global criteria” (a global filter, for example only 
panelists from a particular state). 

The Current Job window provides general information about the selected job and enables you to define and edit 
the criteria for the job. To open this window, go to the Sample Management > Current Job menu command. The 
window contains seven tabs: 

• Job Information – define the basic details for the job. 

• Exclusions – define any date-related automatic and manual exclusions, and manually relax exclusions 
that have been applied automatically. 

• Universal Criteria – create the background panelist-selection expression. 

• Sub Samples – a survey may need groups of respondents with different characteristics. The Sub 
Samples function allows you to create such groups. 

• Additional Items – specify which columns of information about the selected panelists are to be included 
in the resulting text file. 

• Execution - confirm the panel selection and book the panelists for the job. 
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• Reporting – view, and print as necessary, reports on the outcomes of the sampling jobs.. 

7.1.1. The Job Information Tab 
This tab provides basic information about the current job. 

 

Figure 122  Example of the Job Information tab 

7.1.1.1. The Tool bar 
• Save – click to save the changes you have made to the job. The button flashes while Confirmit has 

unsaved changes. 

• Duplicate – makes a copy of the current job so you can create a new job to the same specifications. You 
will be required to give the new job a different job number, and the Job Status will be reset to Work In 
Progress, but all other details will be identical to the original job. Once the job has been duplicated and 
given a new number, you can then edit the job as required. 

• Export Job – exports the job definition (not matrices) to a text file and sends the file to the stated email 
address. This function can be used by customers with their own servers to copy jobs from one server to 
another. 

• Validate Job – tests the job to ensure there are no logical inconsistencies that would cause the procedure 
to fail when the panelists are actually being selected. 

7.1.1.2. The Data Fields and Areas 
• Job Number – a unique identification number for the job. The number is generated when the job is first 

created, though it can be changed if necessary. 

• Description – a free-text description of the job to simplify identification later. You can edit the description 
at any time. 
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• Mailing Date - a calendar that enables you to set and change the mailing date (go to How to Set the 
Mailing Date on page 100 for more information). 

• Status – the current status for the job. The job status is changed automatically by the system when for 
example the job is uploaded, when it is emailed etc. 

• Properties – you can define properties for the jobs (for example “Complexity”), and specify options for the 
property (for example “Low”, “Medium” and “High”) (go to The Property Definitions Tab on page 170 for 
more information). You can then specify the property and option for each job, and these can be used 
when eliminating panelists for jobs (go to The Auto Exclusion Tab on page 98 for more information). 

• Data Source - a list of the available BitStream files used as a base for sampling. 

• External Fields – allows you to upload additional information on an individual panelist or for a group of 
panelists. This information will be in the form of text files that must be created outside of Confirmit and 
uploaded. The file should be tab-delimited with PanelistId as the key column, followed by the external 
fields (go to How to Upload a File on page 96 for more information). 

• External Survey Links - allows you to upload a repository of unique links to an external survey. The links 
will be added to the Sample file and can be uploaded to a Confirmit project that handles the statusing and 
redirecting for the Sample Only job.  

• Category – A panel's category is specific to that panel. Use this area to define the category or categories 
to which the job is to apply. The Panel Categories list is a logical hierarchy of all the registered categories 
(go to The Categorization Tree Tab on page 169 for more information). 

7.1.1.3. Procedures in the Job Information Tab 

7.1.1.3.1. How to Duplicate a Job 
1. Click the Duplicate button in the blue Job Information tab toolbar. 

The Duplicate Job dialog opens. 

 

Figure 123  The Job Import dialog box 

2. Type a unique job number for the duplicate job into the data field. 

3. Click OK. 

The new job opens in the Confirmit window, is listed in the Sample Management > Job List window 
under its job number, and can be selected and edited as required. 

7.1.1.3.2. How to Export a Job 
1. Click the Export Job button in the blue Job Information tab toolbar. 

The Job Export dialog opens. The default email address (that of the current user) is included as default in the 
Email Recipient field. 

 

Figure 124  The Job Export dialog box 

2. If necessary, change the email address to that of the intended recipient. 
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3. Type a comment if required. 

4. Click OK. 

The new job opens in the Confirmit window, is listed in the Sample Management > Job List window 
under its job number, and can be selected and edited as required. 

7.1.1.3.3. How to Upload a File 
You can upload text files of additional information on panelists or external survey links. The upload procedure is 
the same for both types of file. 

Note: The text file must be of .txt format and must be named matchfile.txt. The link file must be of .txt 
format with 'Link' as the only column header and all the links below 

1. In the External Fields area, click the Upload File link. 

The Upload Settings dialog box opens. 

 

Figure 125  The Upload Settings dialog box 

2. In the dialog box click Browse. 

A standard File Selection window opens. 

3. Browse to and select the required file, then click Open. 

The file path and name is added to the File to Upload data field. 

4. Click OK to complete the upload, or Cancel to return to the Job Information tab. 

7.1.1.3.4. How to Check the Job 
You can check the current job at any time during the construction process, to ensure it will function correctly and 
to view a list of any errors or problems. 

1. Click the Validate Job button in the Job Information tab toolbar. 

An information dialog opens with a list of any errors or problems that the job may contain. 

 

Figure 126  Example of a verification message list 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 97 - 

You must now work through the list and correct the problems. 

2. Click OK to close the list dialog. 

Once all the errors have been corrected, when you click the Validate Job button the “Sampling Job is 
Valid” message box is displayed as shown below. 

 

Figure 127  The Job is Valid message box 

7.1.1.3.5. How to Select a Category 
If the Available Categories list is extensive or contains many similarly-named categories located in different 
branches of the hierarchy, you may wish to perform a search to locate the category you are looking for. To find 
panel categories: 

1. Type an appropriate combination of characters into the data field at the top of the Available Categories 
column. Wildcards are not necessary. 

2. Click Search. 

Confirmit will find and display all the instances of that combination of characters that are to be found in the 
Panel Categories hierarchy. 

For example if you type Product into the field and click Search, Confirmit will find all categories with the 
word Product anywhere in the category name. Note that you do not need to type in complete words. For 
example, type ll into the field and click Search to find all categories with ll anywhere in the name, such as 
any category with the word small in its name, or grill, or rolls…. 

If after typing in the first search criteria the list is still long, you can perform a search through the first set of 
results by repeating the procedure using other search criteria. 

To reset the search filter and restore the entire hierarchy to perform a new search, click Clear. 

3. Once you have found the required category, click on it to select it, then click the >> button located 
between the columns. 

The selected category is moved from the Available Categories column to the Selected Categories column. 

Note: You can select as many categories as you wish. 

To remove a category from the Selected Categories list, click on it to select it and then click the << button 
located between the columns. The category is returned to the Available Categories list. 

4. On completion, click Save to save the changes. 

Note: The Save button flashes while the system contains changes that have not yet been saved. 

7.1.2. The Exclusions Tab 
You may wish to exclude potential panelists from a job for various reasons. For example you may wish to avoid 
using panelists who have recently been asked to reply to a survey of a particular category, or those who have 
recently been asked to reply to a survey of any category. The Exclusions tab enables you to set time-frames 
around the job’s planned mailing date, within which such panelists will be excluded. 

The Exclusions tab contains two sub-tabs: 

• Auto Exclusion – panelists are excluded automatically if they conform to the general rules set here. 

• Manual Exclusion – you can set additional exclusion rules and/or relax some rules. 
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7.1.2.1. The Auto Exclusion Tab 
The Auto Exclusion function is controlled by dates. Here you can select the type of exclusion you wish to use; 
Category and/or Date, and set the dates within which you wish the exclusion rules to apply.  

 

Figure 128  The Auto Exclusion tab 

The Auto Exclusion tab controls three functions: 

• Category exclusion – excludes potential panelists if they have the selected status and have been used in 
a sample for a survey of the same category within the specified dates. 

• Date exclusion – excludes potential panelists if they have the selected status and have been used in a 
sample for any survey within the specified dates. The panelist may have been invited to participate in a 
survey, they may or may not have responded to that invitation, or they may have already been included in 
a different sample for a survey that is still being planned. 
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In both cases the exclusion dates are applied around the Mailing Date – the date on which you plan to 
email the survey invitations to those panelists who are finally selected. The darker shaded date is the 
selected Mailing Date (set at the top of the tab (go to How to Set the Mailing Date on page 100 for more 
information), while the lighter shaded area covers the days selected in the Days Before and Days After 
fields for the appropriate calendar. 

• Property exclusion  – a Property Definition (go to The Property Definitions Tab on page 170 for more 
information) can be activated so it can be used in the exclusion. This excludes potential panelists if they 
have the selected property and Survey Status. Click Add to add a property definition (go to How to Set the 
Property Elimination Function on page 103 for more information). 

Select either: 

• Exclude all jobs - select this to exclude all panelists from all jobs. You can then go to the Manual 
Exclusion tab and relax the exclusion for specific jobs. Use this function if you want to send for example a 
follow-up survey to the same panelists as for an earlier survey. 

Or: 

• Specify Auto Exclusion - select this to exclude panelists using Category, Date and/or Property 
Exclusion, then set up the exclusions as required. 

7.1.2.2. The Manual Exclusion Tab 
You may wish to include some potential panelists in your survey who have been excluded by the Auto Exclusion 
function, or you may wish to exclude panelists who have previously been involved with particular jobs, in addition 
to any exclusion generated by the Auto Exclusion function. The Manual Exclusion tab provides you with these 
possibilities. 

The tab is divided horizontally into two lists: 

• Available Job - the jobs currently registered in your database, which are available to be excluded or 
relaxed. 

• Manually Excluded and Included Jobs – jobs selected manually from the Available Jobs list to be 
excluded or relaxed. 

To simplify management, the lists are automatically divided into “pages” with 30 jobs on a page. Scroll through the 
current page using the scroll bar at the right side of the list, and move through the pages by clicking on the Page 
arrow buttons at the lower-right corner of the list. 

 

Figure 129  Example of the Manual Exclusion tab 
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7.1.2.2.1. The Job Filters 
In an established company the list of registered jobs may run into thousands, and a search through the list for the 
one job that you wish to select for exclusion or relaxation could be time-consuming. Confirmit therefore provides 
you with a set of filters so you can reduce a long list to a manageable size. 

 

Figure 130  The joblist filter fields 

The filters are as follows: 

• Category – this field lists the categories selected in the Job Information tab. Click the drop-down arrow to 
open the list and select the required category, then click Search. 

• Job Number – type in the number of the job you are looking for, then click Search. You can use the * 
character as a wildcard, and type in part of the number. For example, type in 123 to find all jobs where the 
job number starts with 123, such as job number 123456. Typing in *123 will find all jobs with the number 
123 somewhere in the job number, such as job number 45123678. 

• Description – type in the description of the job you are looking for, then click Search. You do not need to 
type in the entire description, and you can also use the * wildcard. For example, if the job you are looking 
for has the text “Confirmit Customer Survey 1” in the description field, typing in confirm, *sur, or even just 
*1 will find the job. However bear in mind that the simpler the search criteria is, the more jobs the search is 
likely to find. 

• Outgo – allows you to search for jobs according to the number of respondents who were invited to 
participate in the survey. Click the drop-down arrow beside the operator field and select the required 
operator, then type the appropriate number into the field to the right of the drop-down arrow. When you 
are ready, click Search. For example, select the <= operator and type in 1000 to list all the jobs that were 
mailed to 1000 people or fewer. 

• Mailing Date – allows you to search for jobs according to the date on which they were mailed. Click the 
drop-down arrow beside the operator field and select the required operator, then click on the calendar icon 
beside the field and select the date. When you are ready, click Search. For example, select the <= 
operator and a date to list all the jobs that were mailed on or before the selected date. 

7.1.2.3. Procedures in the Exclusions Tab 

7.1.2.3.1. How to Set the Mailing Date 
The panelists that are selected for a survey are 'booked' in the system for a defined period from the moment that 
the job for which they have been selected is executed. The selected panelists are flagged in the database, and 
will be available to be included in jobs that are executed later according to the mailing dates and exclusion rules 
for those jobs. To set the mailing date for a job: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Job Information tab. 

3. Click on the calendar icon to the right of the Mailing Date field. 

The calendar opens. 

 

Figure 131  The calendar 
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4. Using the arrow buttons, browse to the appropriate year and month, then click on the desired date to 
select it. 

Note that today’s date is highlighted in red, and the selected date (if a date is already selected) is outlined. 
To close the calendar without selecting a date, click outside the calendar. 

When you click on a date, the calendar closes and the date is entered into the Mailing Date field. The time 
intervals you set in the Exclusions tab are then applied around the selected Mailing Date. 

5. Click Save to save the changes. 

7.1.2.3.2. Exclude All Jobs 
This check box is on the Auto Exclusion tab. Check this box to exclude all panelists for all jobs. You can then go 
to the Manual Exclusion tab and relax the exclusion for specific jobs. Use this function if you want to send for 
example a follow-up survey to the same panelists as for an earlier survey. 

7.1.2.3.3. How to Set the Category Exclusion Function 

Note: Go to the Job Information tab to select the category(ies) with which this job is to be associated. 

If you wish to exclude potential panelists if they have been invited to participate in a survey with the same 
category(ies) as this survey, within a specified time period, proceed as follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Exclusion tab. 

3. Check the Category Exclusion box. 

The Category Exclusion function is activated. 

 

Figure 132  The Category Exclusion function 

4. In the Days Before… and Days After… data fields, specify the number of days which, if a panelist has 
been included in another panel of the same category during this period, they are to be excluded from this 
survey. 

5. Click the drop-down arrow beside the Survey Status field to open a list of the statuses and select the 
desired option. 

The options are: 
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o Reserved – excludes all potential panelists who are already reserved for other projects in the 
specified categories and date range. 

o Invited – excludes potential panelists if an invitation has been sent to them to participate in a survey in 
one of the specified categories. 

o In Progress – excludes potential panelists if they are in progress with a survey of the specified 
categories. 

o Completed – excludes all potential panelists who have completed a survey in the specified categories 
within the specified date range. 

o Stopped by System – excludes potential panelists who have been invited to participate in a survey in 
the specified categories during the specified time period, if those panelists have been stopped from 
completing those surveys by Confirmit. 

o All – excludes all potential panelists who have been invited to participate in any survey of the specified 
categories during the specified period. 

6. Click Save to the save the changes. 

7.1.2.3.4. How to Set the Date Exclusion Function 
If you wish to exclude potential panelists if they have been invited to participate in any survey within a specified 
time period around the mailing date for this survey, proceed as follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Exclusion tab. 

3. Check the Date Exclusion box. 

The Date Exclusion function is activated. 

 

Figure 133  The Date Exclusion function 

4. In the Days Before… and Days After… fields, specify the period during which, if a potential panelist has 
been included in any other panel, they are to be excluded from this panel. 

5. Click the drop-down arrow beside the Survey Status field to open a list of the statuses. 

6. Select the desired option. 

The options are: 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 103 - 

o Reserved – eliminates all potential panelists who are already reserved for other projects in the 
specified date range. 

o Invited – eliminates potential panelists if an invitation has been sent to them to participate in a survey 
within the specified date range. 

o In Progress – eliminates potential panelists if they are in progress with a survey within the specified 
date range. 

o Completed – eliminates all potential panelists who have completed a survey within the specified date 
range. 

o Stopped by System – eliminates potential panelists who have been invited to participate in a survey 
during the specified time period, if those panelists have been stopped from completing those surveys 
by Confirmit. 

o All – eliminates all potential panelists who have been invited to participate in any survey during the 
specified period. 

7. Click Save to the save the changes. 

7.1.2.3.5. How to Set the Property Elimination Function 
If you wish to exclude potential panelists who are or have been involved with jobs with particular properties, 
proceed as follows: 

Note: This requires that the appropriate properties have been defined (go to The Property Definitions Tab 
on page 170 for more information). 

1. Go to the Sample Management > Sampling Settings menu command. 

The Sampling Settings window opens. 

2. Go to the Property Definitions tab. 

A list of the available Property Definitions is displayed, as shown in the example below. 

 

Figure 134  Example of the Property Definitions list 

3. Click on the Name of the Property Definition you wish to use, to open the Property Definition page for that 
property. 

The page shown in the example below opens. 

 

Figure 135  Example of the Definition page for a property 
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4. Check the Use In Exclusion box, and other boxes as required. 

Note: Only one Property Definition can be used for exclusion in a job. Once the Use In Exclusion box is 
checked for a Property Definition, the box cannot be accessed for another definition. 

5. Click Save and close. 

6. Go to the Sample Management > Current Job menu command, then go to the Exclusions tab. 

7. On the Auto Exclusion tab, check the Property Exclusion box. 

Note that the Property Definition you selected in step 3 above is now named beside the Property 
Exclusion box (arrowed in the figure below). 

8. Click Add. 

A row is added to the exclusion list as shown in the example below. 

 

Figure 136  Example of the Property Elimination list 

9. Select the required item (in the figure above the Complexity property is selected, so the Item Name field 
lists the items registered for the Complexity property. In this case the Low item is being chosen). 

10. Type values into the Days Before… and Days After… fields to set the date range for which the exclusion 
property is to be applied (the date range is applied about the Mailing Date). 

11. If panelists conforming to the property elimination should also have a specific status, then select the 
required status. 

Note: You can add as many rows as required to the list, and set them up such that all the required 
combinations of items, dates and survey statuses are covered. 

12. Save the changes. 

7.1.2.3.6. How to Manually Exclude a Job 
If you wish to exclude potential panelists who have previously been involved in a particular job, proceed as 
follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Exclusion tab. 

3. Go to the Manual Exclusion tab. 

4. Using the filters as necessary, find the appropriate job in the list. 

5. Click in the job’s checkbox at the left side of the job list to flag it. 

6. Click the Exclude button in the Available Jobs toolbar. 

The job is moved down to the Selected Job list, and is colored pink for easy identification. 

Note: You can exclude only those panelists in the job who have a specified Survey Status (you can 
specify more than one status). 

7. Click the … button beside the Filter field to open the Filter dialog as shown below. 
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Figure 137  The Filters Web Page dialog 

8. Create an expression as necessary (go to The Filter Tab on page 106 for more information). 

9. Check the boxes for the statuses you wish to exclude (if None is selected, the other boxes are grayed 
out), and click OK. 

10. The dialog closes and you return to the Manual Exclusion tab. 

11. Click Save to save the changes. 

Any potential panelists who satisfies the criteria in the selected job are now excluded from your current job. You 
can exclude several jobs at one time, and as many jobs as required. 

7.1.2.3.7. How to Include an Automatic Exclusion 
If you wish to include in your current job potential panelists who have been involved with a particular job that has 
been excluded by the general criteria set in the Auto Exclusion function, proceed as follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Exclusion tab. 

3. Go to the Manual Exclusion tab. 

4. Using the filters as necessary, find the appropriate job in the list. 

5. Click in the job’s checkbox at the left side of the job list to flag it. 

6. Click the Include button in the Available Job toolbar. 

The job is moved down to the Selected Job list, and is colored green for easy identification. 

7. Click Save to save the changes. 

Any potential panelists who satisfied the criteria in the selected job are now included in your current job. You can 
relax the exclusion notice for several jobs at one time, and for as many jobs as required. 

7.1.2.3.8. How to Deselect a Job 
You may wish to deselect a job that you have previously selected for exclusion or relaxation. Proceed as follows: 

1. Go to the Sample Management > Current Job menu command. 

2. Click the Exclusions tab. 

The Exclusions window opens at the Auto Exclusion tab. 
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3. Go to the Manual Exclusion tab. 

4. Find the appropriate job in the Selected Jobs list. 

5. Click in the job’s checkbox at the left side of the job list to flag it. 

6. Click the Remove button in the Selected Jobs toolbar. 

The job is removed from the Selected Jobs list, and is returned to the Available Jobs list. 

7. Click Save to save the changes. 

7.1.3. The Filter Tab 
This tab is where you create the selection criteria expression that is the overall filter for the panelists. You can 
select criteria from the list and assemble them using the operators and functions, or if you have the required 
knowledge you can write the expression directly into the data field. 

 

Figure 138  Example of the Universal Criteria tab 

7.1.3.1. The Data Fields 
• Search – type a character or string of characters into the Search field. As you type, Confirmit reduces the 

criteria list to show only those criteria that include that character or series somewhere in the criteria name. 

• The Operators: 

o And – a conjunction operator to be used when more than one criteria must be satisfied. For example, 
the panelist must be male and must be married. 

o Or – a conjunction operator to be used when one or more criteria must be satisfied. For example, the 
panelist must have network access from home or from work. 

o None – this is not a conjunction operator. Use when adding the first criteria in the expression. 

o Not – the negative operator. Use for example when you want panelists who are not in banking though 
any other profession is acceptable. 

• The Functions (these will be active depending on the criteria selected): 

o Equal – use when you want the selected criteria to be equal to a specific value, for example when you 
want panelists of a specific age or you want the criteria to be Yes or No. 

o In – use when the criteria value is to be one of a range or set of values. 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 107 - 

o Between – use when you want the criteria to be between two values, for example between two dates. 

o > (Greater than) - use when the criteria is to be greater than a specified value. 

o >= (Greater than or equal to) - use when the criteria is to be greater than or equal to a specified value. 

o < (Less than) – use when the criteria is to be less than a specified value. 

o <= (Less than or equal to) – use when the criteria is to be less than or equal to a specified value. 

o Contains – you can write an expression that looks, for example, for a certain combination of four 
characters anywhere in a line of text. 

o Left – you can write an expression that looks, for example, for the first three characters in a line of 
text. In this case select Left as the desired string is to be on the left end of the line. 

o Right – you can write an expression that looks, for example, for the last three characters in a line of 
text. In this case select Right as the desired string is to be on the right end of the line. 

o IsNull - you can write an expression that looks for any null-precodes in multi questions; i.e. answer 
options that have not been selected. 

o Any - you can write an expression that looks for instances where any of a specified set of precodes 
are present. 

o All - you can write an expression that looks for any instances where all of a specified set of precodes 
are present. 

• Other data fields 

o Text area – type text as required into this field. The field is only accessible for certain pre-defined 
criteria. 

o Paste area – here you can paste in, for example, a list of values copied from a document. 

o Number – here you can type in numerical characters only. Use in conjunction with a Function (see 
above) when, for example, you want a criteria to have a specific numerical value. The field is only 
accessible for certain pre-defined criteria. 

o End Number – when the Number field is open, if you also select the Between function, a second 
numerical data field appears. This enables you to input a second number such that you can specify 
the criteria must have a value between the two given numbers. 

7.1.3.2. Procedures in the Filter Tab 

7.1.3.2.1. How to Create an Expression 

Note: The procedures for creating expressions in the Filter tab and in the Sample Definition > Group Set 
tab > Expression Editor window are virtually identical. The only difference is that the Expression Editor 
window has Validate and OK buttons while the Filter tab has a Save button. The Filter tab is displayed in 
the main Confirmit window, so clicking Save checks the expression and saves the changes; it does not 
close the window. However as the Expression Editor function opens in a separate window, clicking OK 
checks the expression, saves the changes and automatically closes the window. If you then wished to 
make further changes to the expression, you would need to reopen the window before continuing. The 
Validate button is therefore included to allow you to check that the expression you have entered is valid 
before you click OK to save it and close the window. Therefore, if you are creating an expression in the 
Expression Editor window, click Validate to check the expression before you click OK to close the 
window. 

1. In the left column, search for or browse to the criteria you wish to start your expression with, and click on it 
to select it. 

Any options that may apply to the criteria will be listed in the second column. 

2. Select the radio button for the None operator (you cannot start an expression with the operators And or 
Or). 

3. Select the appropriate function and type any text or values into the Text or Number fields as required. 

4. Click Add Here (see the following figure) to add the criteria to the field. 
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Figure 139  Adding criteria to the data field 

Note that the coding is displayed in the white data field while the logical expression is “written” below the 
field. 

5. Select and add criteria until you have the required expression. 

 

Figure 140   Example of a complete expression 

6. Click Save to save the changes. 

7.1.4. The Sample Definition Tab 
Particular surveys may need groups of respondents with different characteristics. For example, you might want to 
create one group to reflect the people in one city with that city’s male/female ratio and income levels, and another 
group for a different city with that city’s male/female ratio and income levels. The Sample Definition function 
allows you to create such groups. 

To access this function, go to the Sample Management > Current Job menu command, then click the Sample 
Definition tab. 

This tab is divided into two areas: 

• The hierarchy column – displays the various sub-samples and group sets in a hierarchy. 

• The editor page –displays the details of the item selected in the hierarchy column and enables you to edit 
those details. 

In the hierarchy column, either right-click on an item then select Edit from the drop-down menu (go to The Right-
Click Menu on page 109 for more information), or double-click on the item, to open its editor page. 

The following sections describe the editor pages for the various items in the hierarchy. 
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7.1.4.1. The Right-Click Menu 
Place the cursor over an item in the hierarchy then click the right mouse button to open the right-click menu for 
that item. The menu commands available will depend on the type of item selected in the hierarchy. The full set of 
possibilities is listed below: 

• Edit – opens the editor page for the selected item. You can also open the editor page for an item by 
double-clicking on the item. 

• Add Group Set (Below) – creates a new Group Set below (within) the currently selected Sub Sample. 

• Add Group Set (After) – creates a new Group Set after the currently selected Group Set. 

• Add Sub Sample (Below) – creates a new Sub Sample below (within) the Sub Sample hierarchy. 

• Add Sub Sample (After) – creates a new Sub Sample after the current Sub Sample. 

• Refresh – refreshes the window to ensure all changes are displayed. 

• Expand All – expands the entire hierarchy. 

• Collapse All – collapses the entire hierarchy. 

• Duplicate – duplicates the selected Sub Sample and its underlying Group Sets and places the new Sub 
Sample at the bottom of the hierarchy. 

• Delete – deletes the selected item. You are asked to confirm the deletion. 

7.1.4.2. The Sub Samples Folder Editor Page 
In the hierarchy column, either right-click on the Sub Samples item then select Edit from the drop-down menu, or 
double-click on the item, to open its editor page. 

 

Figure 141  Example of the editing page for the Sub Samples folder 

The "main" Sub Samples folder has the following data fields in its editing page: 

• Disregard Sampling Matrix... - you can set up universal criteria with matrices etc. (go to The Filter Tab 
on page 106 for more information). Check this box to switch off the requirement to use matrices and only 
use the filters. Set the filters for each group, sub-sample etc. individually. This method of sampling is 
called Basic Sampling. 

• Matrix List - this is the list of matrices that are available in the Matrix drop-down on the Sub Sample editor 
page (go to The Sub Sample Editor Page on page 110 for more information). This allows you to create a 
small set of matrices from the complete list (which may run into hundreds), thereby simplifying the 
selection process and reducing the chance of errors. Click Add, then select the required matrices from the 
list. 
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• Custom Code - use this field to add custom codes to the job so you can use the codes later in the sub 
samples (go to The Sub Sample Editor Page on page 110 for more information). 

• Global Custom Code - use this field to add custom codes to the job that all in the sample will be given 
(this is similar to the default codes in the sub sample). 

7.1.4.3. The Sub Sample Editor Page 
In the hierarchy column, either right-click on a sub-sample folder then select Edit from the drop-down menu, or 
double-click on the folder, to open the folder's editor page. 

 

Figure 142  Example of the editing page for a sub sample folder 

In the figure above, note the two "CustomCode" fields in the lower part of the page. These are created in the Sub 
Samples editing page (go to The Sub Samples Folder Editor Page on page 109 for more information). 

The Sub-folders have the following data fields in their editing pages: 

• Sub Sample Name – the name for the sub sample. 

• Selected Matrix – the matrix to be used to build up the group. Note that the matrix must be created first. 
The drop-down list will contain those matrices added to the Matrix List in the Sub Samples editing page 
(go to The Sub Samples Folder Editor Page on page 109 for more information) 

• Manage Available matrices - click this link to go to the Sub Samples Folder Editor Page to manage the 
matrices. 

• Use Dynamic Targets - check this box if you wish to set the segment targets according to the 
composition of the underlying sampling population (BitStream set).  

• Apply Filters when Calculating Dynamic Targets - check this box if you wish to include the sampling 
job's universal criteria and the sub-sample filter in the query to calculate the dynamic segment targets.  

• Cellweight – select the cell weight to be used by the Sub Sample. See also Original Cellweight below. 

• Original Cellweight – the customer might have specified a particular cell weight. However if not enough 
respondents can be found who satisfy the selection criteria, the cell weight might be changed to enable 
the job to be completed. In that case the cell weight actually used is given in the Cellweight field while the 
cell weight specified by the customer is given here. 

• Expression – the filter used to select the respondents. Click the … button to open the Expression Editor 
window  (go to How to Create an Expression on page 107 for more information). 

• Total target – this is the total number of panelists you wish to have in the sub sample Each group set in 
the sub sample is allocated its own target, and this total target is the total of the group set targets. 
Confirmit will attempt to fill this requirement while adhering to the selection criteria set in this and the other 
tabs. 
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Note: Confirmit performs two series of checks while creating a sample. The first check is performed using 
the criteria defined in the sampling job (using the Universal Criteria expression and exclusions), then a 
second check is performed to ensure any required percentages, weightings etc. are met. If Confirmit finds 
more than the required number of panelists that comply with the criteria then the program will randomly 
select the total required from those found. If not enough panelists complying with the criteria in the first 
check can be found, then an error message is displayed and the job will stop. If you wish to continue with 
the job you will then have to change some of the criteria. If the first check finds enough panelists but the 
second check cannot meet the required percentages, weightings etc. then Confirmit will try to complete 
the job by making adjustments to the weightings and percentages. Any changes will be notified in the job 
report. 

• Default Code – you can define a code number for each group. If a respondent is found who satisfies the 
general criteria but who does not fit into a specific group, they will be allocated this default code. 

• <custom code> - if a custom code is defined in the sub-sample (go to Adding a Custom Code on page 
112 for more information), then it will appear here. Add a value as required. 

• Weight Parameter – this property is only used during concurrent sampling (go to Concurrent Sampling on 
page 162 for more information), and is only visible on the Sub Sample Editor page if the Expected Return 
Variable box is set to a value other than None (go to The General Tab on page 167 for more information). 
The property enables you to specify the accuracy of the sampling by using the probability that panelists 
are likely to reply to the survey. Enter a value between -1 and +1. A value of -1 will allow the sample to 
include panelists who have a low probability of replying. This will thereby result in a larger sample to 
ensure the required number of responses are returned. A value of +1 will restrict the sample to only those 
panelists who have a high probability of replying to the survey. This will thereby result in a sample closer 
in number to the required size. 

• Disable Balancing – a particular matrix can be used for many jobs. Check this box if you do not want to 
use the cell weights applicable to the matrix. 

• Discard Default Group… – check this box if you do not wish to use potential respondents who have been 
allocated the default code number (see above). 

7.1.4.4. The Group Set Editor Page 
In the hierarchy column, either right-click on a Group Set item then select Edit from the drop-down menu, or 
double-click on the item, to open its editor page. 

 

Figure 143  Example of the Group Set editing page 

• Group Set Name - the name of the group set as it appears in the hierarch column. You can edit this name 
as required. 

• Filter - if you wish to use a filter expression instead of matrices, click the ... button and create the 
expression here (go to How to Create an Expression on page 107 for more information). 

• Custom code field(s) - these are created in the Custom Code field in the Sub Samples editing page (go 
to The Sub Samples Folder Editor Page on page 109 for more information). 

• Group List - the list of groups in the Group Set. Click Add Group to create new groups (go to How to 
Create a New Group Set on page 113 for more information). 
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7.1.4.5. Procedures in the Sample Definition Tab 

Note: Double-click on an item in the hierarchy or right-click on it and select Edit, to open the item’s editor 
page. 

7.1.4.5.1. Adding a Matrix List 
A panel can have a large number of matrices available for use. When you are setting up a group of sub-samples 
you may only need a small selection of the available matrices. Use the Matrix List functionality to build a “short 
list” of the matrices that are to be available for the sub-samples. These matrices will then appear in the drop-down 
list beside the Matrix field on the sub-sample editor page. 

To add a matrix to the drop-down list, click the Add Matrix button and select the required matrix from the full list. 

7.1.4.5.2. Adding a Custom Code 
You can define one or more variables for which you can specify values in the Sub-Sample and Group levels. 
When you add a custom code, it appears in the sub-sample / group window with the name you have given it. If 
you add values to both the Sub-Sample and Group levels, then the Group level takes precedence. 

To add a Custom Code: 

1. In the Sub Samples Editor page (go to The Sub Samples Folder Editor Page on page 109 for more 
information), click the Add Row button for the Custom Code field. 

A new row is added to the Custom Code list. 

2. Type a name for the code into the Name field. 

Note that the name must include only alpha-numeric characters - no special characters or space. 

3. Click Save. 

The new Custom Code will now appear in the Sub Sample Editor page (go to The Sub Sample Editor 
Page on page 110 for more information) 

7.1.4.5.3. Adding a Global Custom Code 
You can define a variable and a value that will be given to all panelists who are selected for the output file. 

Type in the name for the global code and give it a value. If you wish to add more codes, click the Add Row 
button. 

7.1.4.5.4. How to Create a New Sub Sample 

Note: A rule that creates BitStream files from the panel database must be created before sub samples can 
be created (go to How to Create a New Rule on page 85 for more information). For this rule, the Source 
must be Panel Database, the Target must be BitStream, and SurveyStatus must be selected in the Survey 
History Variables field. 

1. Click on the Sub Sample icon after which you wish to create the new sub sample. 

2. Click the right mouse button. 

The right-click menu opens. 

3. Click Add Sub Sample (After). 

A new sub sample is created after the current sub sample, and its details window opens as shown in the 
figure below. 

4. Type the name for the sub sample into the Name field, and fill in the remaining details as appropriate (the 
Total Target must be specified). 

5. Click Save to save the new sub sample. 

Note: You can also select Duplicate from the right-click menu to make a copy of the currently selected 
Sub Sample and its underlying Group Sets. 
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Figure 144  Example of a sub sample editor page 

7.1.4.5.5. How to Create a New Group Set 
The Group Set function allows you to create a number of groups with similar characteristics. Each Sub Sample in 
the hierarchy can contain any number of Group Sets, and each Group Set can contain any number of groups. 
Once a group set is created you can edit the characteristics for each group individually. 

1. In the hierarchy column, right-click the Sub Sample into which you wish to add a new Group Set, then 
from the right-click menu select Add Group Set (Below). 

The Group Set Editor page opens. 

 

Figure 145  The Group Set Editor page 

1. Type the desired name for the new group set into the Group Set Name field. 

2. Click Save to save the changes and apply the name. 

Note: The new Group Set already contains one undefined group. If you only require one group in the 
Group Set then you need only to fill in the details for this group. In this case, click in the data fields under 
Target and Code and type in the appropriate details – see below for the field descriptions. 
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3. If you wish to create more groups, click Generate Group. 

The Generate Groups window opens. 

 

Figure 146  Example of the Generate Groups window 

4. Fill in the details. The fields are as follows: 

o Number of Groups – the number of groups you wish to create in this operation. 

o Group Start Code – each group should have a code number. The number series will be created 
automatically but the system needs to know where to start. Type in here the first code number to be 
used. 

o Group Increment – The code numbers can be set to increase in increments, for example in steps of 
10 (10, 20, 30 etc.). Type the required increment in here. 

o Percent – if you want to use a percentage of the total number of suitable people found by the filter 
instead of a set number, check this box. See also Target below. 

o Target – the total number of people you want to have in the group, or the percentage of the total 
number of people found by the filter. For example, if the filter finds 500 suitable respondents for the 
group and you type in 50 here, the system will randomly pick out 50 people. If you type in 50 here and 
also check the Percent box then the system will randomly pick out 50% of 500 = 250 people. 

5. Click Generate to create the new groups. 

The new groups are added to the Group Set list. 

6. Click Save to save the changes. 

The figure below shows the Group Set editor page with the new groups created according to the 
parameters set in the Generate Groups window in the previous figure. 
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Figure 147  Example of the new groups 

You can edit the group details as required. Click in the data field and make the necessary changes. On 
completion, save the changes. 

7.1.5. The Sample File Fields Tab 
When a person first agrees to make themselves available as a potential panelist, a lot of details about that person 
are registered into a database. The database is constructed as a table of rows and columns where each row 
contains the details of one person and each column contains the answers provided for one particular question. 

The end product of the panel selection process is a text file containing a sample of the database table rows 
(panelists’ details) as defined by the exclusion and selection criteria. 

Some information, such as the panelist’s ID number is always included by default. However you can use the 
Sample File Fields tab to specify which other columns of information about the selected panelists are to be 
included in the text file. The columns included here will define the contents of the results tables that will be 
available after the survey is completed. To add columns: 

1. In the Available Fields list, select the columns you wish to add by clicking in the boxes beside the name. 

2. Click Add. 

The selected columns are moved to the Selected Fields area. 

Click Add All to add all of the columns without having to select them individually. In the Selected Fields 
area, select a column and click Remove to return it to the Available Fields list. 
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Figure 148  The Sample File Fields window 

7.1.5.1. The Sample File Fields Tab Toolbar 
The toolbar for the Sample File Fields tab is as shown below. 

 

Figure 149  The Sample File Fields toolbar 

• Search – starts the search function. 

• Add – moves selected fields from the Available Fields list to the Selected Fields list. 

• Add All – moves all the available fields from the Available Fields list to the Selected Fields list. 

• Field Type – select the field type you wish to use. The options are: 

• Panel fields – the fields pre-defined by the panel. 

• External fields – additional fields made available by uploading a matchfile.txt file (go to How to Upload a 
File on page 96 for more information). 

• Check box – click in a check box to select the associated field. The uppermost check box selects all the 
fields. 

• Field name – the header for the list of fields in the column. 

• Remove – removes selected fields from the Selected Fields list. 

• Remove All – removes all fields from the Selected Fields list. 

• View - select from the drop-down list the field type you wish to view. 

7.1.5.2. Procedures in the Sample File Fields Tab 

7.1.5.2.1. How to Add Fields to the Selected Fields Column 
1. In the Available Fields column click in the check boxes to select the desired fields. 

Selected fields are shaded blue for easy identification. 
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2. If for example the majority of fields are required, click in the check-box immediately below the Search 
button to select all the fields, then use standard Windows techniques and deselect those that are not 
required. 

3. Click Add. 

The fields are moved to the Selected Fields column. 

4. Click Add All to move all the fields to the Selected Fields column. 

7.1.5.2.2. How to Remove Fields from the Selected Fields Column 
1. In the Selected Fields column, click in the check box to select the field you wish to remove. 

Selected fields are shaded blue for easy identification. 

2. Click Remove. 

The fields are moved to the Selected Fields column. 

3. Click Remove All to return all the fields to the Available Fields column. 

7.1.5.2.3. Searching for Field Names 
If the Available Fields list is extensive, you may wish to perform a search to locate the field name or names you 
are looking for. Proceed as follows: 

1. Type an appropriate combination of characters into the Field Name data field. Wildcards are not 
necessary. 

2. Click Search or press the Return key on your keyboard. 

Confirmit will find and display all the instances of that combination of characters that are to be found in the 
Available Fields column. 

For example if you type Zip into the field and click Search, Confirmit will find all fields with the word Zip 
anywhere in the field name. Note that you do not need to type in complete words. For example, type ll into 
the field and click Search to find all fields with ll anywhere in the name. 

If after typing in the first search criteria the list is still long, you can perform a search through the first set of 
results by repeating the procedure. 

3. Once you have found the required field, click in its check box on it to select it, then click Add. 

The selected field is moved from the Available Fields column to the Selected Fields column. 

Note: You can select as many fields as you wish. 

To remove a field from the Selected Fields list, click in its check box to select it and then click the Remove 
button. The field is returned to the Available Fields list. 

4. On completion, click Save to save the changes. 

Note: The Save button flashes while the system contains changes that have not yet been saved. 

7.1.6. The Execution Tab 
Once you have set up all the selection criteria for the job, the job must be executed. This is done via the 
Execution tab. 

To access the Execution tab, go to the Sample Management > Current Job menu command. 
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Figure 150  The Execution tab 

The Execution tab contains two main areas: 

• The Job Execution area - run the job you have set up in the other tabs. 

• The Job Runs area - manage the runs that have been performed. 

The procedures available on this tab include the following: 

• You can test the job settings by performing a dummy run (the database is not updated and the panelists 
are not reserved). 

• You can perform a “real” sample selection procedure with or without final reports. 

• You can define when you want the execution job to be performed, and whether or not you want the job to 
be repeated at specified intervals. 

Once the job has been executed, you can also: 

• Upload the output file into a project (go to How to Upload the Output File on page 129 for more 
information). 

• "Undo" the sampling operation and return to sample to the panel (go to How to Remove a Run from the 
Panel on page 128 for more information). 

• Change the mailing date (go to How to Change the Panel Mailing Date on page 131 for more information). 

• View a snapshot of the panelists in the sample (go to After the Job has been Executed on page 128 for 
more information). 

• Add test recipients (Tester Templates)  (go to Tester Template List on page 165 for more information). 

• Export the sample file (go to How to Export the Sample File on page 131 for more information). 

7.1.6.1. The Job Execution Area 
This area shows general information about the job. 

The toolbar contains a number of buttons and the area contains two check boxes. 

• Save – saves changes to the tab. The button flashes while the tab has unsaved changes. 

• Execute Job – starts the job execution process. Once the job is executed for the first time, additional 
buttons become available (go to After the Job has been Executed on page 128 for more information). 

Note: Once you have clicked the Execute Job button, it is deactivated while the job is running. This is to 
prevent “multiple-clicking” and the job being executed several times by mistake. 
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• Remove Job From Panel - click here if you have performed a number of sampling tasks and updated the 
panel, but then wish to "undo" ALL the panel updates (go to How to Remove a Job from the Panel on 
page 129 for more information). This will free-up the panelists selected for the samples so they are 
available for other projects/samples. Note that this action removes ALL the runs from the panel. To 
remove one specific run use Remove Run From Panel in the Job Runs area of the tab (go to How to 
Remove a Run from the Panel on page 128 for more information).  

• Preapproved – Confirmit can be set up by the system administrator such that an executed job must be 
approved by the user’s manager before it can be mailed. Check this box if you wish to avoid that 
procedure, for example for testing purposes. 

• Disregard in Future Eliminations – check this box if you do not want the panelists selected by this job 
to be excluded from future samples by the time limits set in the Exclusions tab. Use this for example if you 
want to send an information email to a group of panelists without affecting their validity to be selected for 
future questionnaires. 

• Incidence Rate % - here you can set the percentage of the panelists who receive the invitation to 
participate in the survey, who you expect will not be screened for some reason. I.e. the percentage who 
start to reply to the survey. For example, an Incidence Rate of 80% means that you expect 20% of the 
panelists to be screened. The value will be taken into account when the number of panelists selected for 
the sample is calculated. 

• Completion Rate % - here you can set the percentage of the panelists who start to reply to the survey, 
who you expect will actually complete the survey. For example, an Completion Rate of 80% means that 
you expect 80% of the panelists who start answering the survey to actually complete it. This value will be 
taken into account when the number of panelists selected for the sample is calculated. 

7.1.6.2. The Job Runs Area 
The Job Runs area for the Execution tab displays the details of the sampling jobs that have been run. 

The jobs are listed in the order they were performed with the most recent jobs at the top of the list. In the event 
the list is extensive, it will be divided into pages with 30 jobs on a page. 

The area has the following buttons: 

• Rebuild Sample File - regenerates the output file to include new columns, but without selecting new 
panelists. A task pane opens to provide information while the recreation task progresses. On completion, 
click OK to return to the Execution tab. The Rebuild Sample File button is only available once the job has 
been executed. This could be used for example if you have created an output file but need to add or 
change variables. 

• Remove Run From Panel - click this button in the event you have performed a sampling task and 
updated your panel but then wish to "undo" the sample selection (go to How to Remove a Run from the 
Panel on page 128 for more information). 

• Upload - click to upload the sample file to a project (go to How to Upload the Output File on page 129 for 
more information). 

• Change Mailing Date - change the mailing date for the project (go to How to Change the Panel Mailing 
Date on page 131 for more information). 

• Sample File Preview - provides an overview of the first 10 panelists in the sample file so you can check 
that the file is correct.  

• Add Test Panelists  - add test respondents to the database (go to How to Add Test Panelists to the 
Database on page 131 for more information). 

• Export Sample File - once you have created the sample file you can export it to another server or project 
(go to How to Export the Sample File on page 131 for more information). 

7.1.6.3. Procedures in the Execution Tab 

7.1.6.3.1. How to Execute a Job 
When executing a job you have several options available to you: 

• You can test the settings by performing a dummy run (the database is not updated and the panelists are 
not reserved). 

• You can perform a “real” sample selection procedure with or without final reports. 
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• If you create an output file you can specify whether it is to be uploaded automatically into a project, and if 
so, which project. 

• You can define when you want the execution job to be performed, and whether or not you want the job to 
be repeated at specified intervals. 

Proceed as follows (note that the process is divided into sections depending on the selections you make): 

1. In the Current Job > Execution tab, check the details presented on the tab and make the appropriate 
settings. 

2. In the Job Execution (upper) section, click Execute Job. 

The Execute Job Properties dialog box opens as shown below. Use the options in this dialog to select the 
desired type of result. 

 

Figure 151  The Execute Job Properties dialog box 

• Update Panel – ensure this box is checked if you wish to create a sample and update the database. This 
action will reserve the selected panelists for the job, ensuring they cannot be used for other jobs during 
the exclusion periods. 

Click in the box to deselect it if you wish to perform a “dummy-run” of the sample selection process. 
Confirmit will then apply all the expressions and exclusions, will check the system setup, and will present a 
report with all the appropriate information, but no changes will be made in the database and the panelists 
will not be reserved. Use this to test the job setup to ensure you get the required panel. You can perform 
as many dry-runs as you wish. 

Note: If you execute the job with the Update Panel option selected, you can remove the panelist 
reservations from the database afterwards. To do this, click the Remove Job from Panel button that 
appears in the tab’s toolbar. 

• Generate Output File – ensure this box is checked if you require the output file (the list of panelists 
reserved for the job) to be created. Note that you cannot Upload the sample if the output file is not 
created. 

Note: If you select to create the output file but not to update the panel database, then Confirmit will have 
no record that the selected panelists have been involved with this job. These same panelists may then be 
included in later jobs, and will not be excluded automatically by date and/or category. 

• Comments – type any comments into the free-text data field. 

• Upload Sample - check this box if you wish to upload the resulting output file directly into a project. When 
checked, the two options below are activated. Note that if you select this option you must click Next and 
then make further selections (go to The Upload Sample Properties Page on page 124 for more 
information). 

o Existing Project - select this option if you wish to upload the output file to an existing project. 
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o New Project - select this option if you wish to upload the output file to a new project. 

• Start Time – specify the time when the task is to commence. Click the down arrow to open a drop-down 
list of the options available: 

o ASAP – start the job as soon as possible. The job will be queued behind any other jobs awaiting 
processing in the database, and will be run as soon as the processor is available. 

o Schedule for later execution – select this option if you want to run the job execution procedure at a 
later time. If this option is selected, when you click OK, a dialog opens in which you can set the 
required time and date for the procedure to be run, and whether you want the job to be repeated. See 
the next section for details. 

3. Select the required options and click Next or Finish as appropriate. 

If you have selected to upload the sample, when you click Next the Upload Sample Properties page 
opens (go to The Upload Sample Properties Page on page 124 for more information). If you have not 
selected to upload the sample, when you click Finish the sample selection task begins as defined by the 
specified Start Time. While the task is running a Progress and Information window is displayed to keep 
you informed of progress, as shown in the example below. 

 

Figure 152  Example of the Execute Job task information page 

The task may take some time depending on the size of the panelist database and the exclusion criteria 
set. When the Execute function is completed, the text "Task Complete" appears at the bottom of the task 
list. 

3. When the task has completed, click the Back button (see the figure above) to return to the Execution tab. 

Once the task is complete, if the output file has been created, you can upload the file into a Confirmit project. In 
this case, an Upload button appears in the Job Runs (lower) section on the Execution tab (go to How to Upload 
the Output File on page 129 for more information). 

Note: Unless the Preapproved box on the Execution tab has been checked, the sample list you have 
created will now need to be checked and approved by a manager. The manager’s Confirmit access will 
have been set up by the system administrator, and when the manager logs on and opens the job, the 
Execution tab will have two additional buttons; Approve and Decline. The manager will check the sample 
list and then click the appropriate button. 

7.1.6.3.2. How to Set the Execution Time/Date for a Job 
You may want a job to be executed at some time in the future. Confirmit allows you to input a time and date for 
the job to be executed, and define whether or not the job is to be repeated at intervals. Here you can also stop a 
job that has already been input, or reset it to start as soon as possible. Proceed as follows: 

1. In the Execute Job Properties dialog box, go to the Start Time drop-down menu and select Schedule for 
later execution. 

2. Click OK. 

The Execute Job page opens at the Recurrence tab. 
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Figure 153  The Recurrence tab 

The options are as follows: 

o Disable task – select this radio button and click Save to disable the selected task. The task will not 
then run. The task is not deleted; you can access it later and restart it. 

o ASAP – select this radio button and click Save to run the task as soon as possible. 

o Time and date fields – set a time and date for when the task is to run, then click Save. 

o Recurring task – click the down-arrow and select Yes if the task is to recur. Additional options then 
become available in the dialog box. See the next section for further details. 

When you save the settings, the Recurrence tab changes to show the selected settings. 

 

Figure 154  Example of the Recurrence tab when settings are saved 

7.1.6.3.3. How to Set Up Recurring Tasks 
You may want a job to be repeated one or more times during a defined period. If so, proceed as follows: 

1. In the Recurrence dialog (go to How to Set the Execution Time/Date for a Job on page 121 for more 
information), click the down-arrow beside the Recurring Task field and select Yes. 

The dialog expands to display additional parameters – see the figure below. 
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Figure 155  The dialog with the Recurrence function activated 

2. In the New Start Time fields, set the time you want the first job execution to be performed. 

3. In the Recurrence Pattern Type field, click the down-arrow and select the basic recurrence rate (hourly, 
daily etc.).  

The “Schedule” area below changes depending on the selection made here. In this area: 

o For hourly recurrences, type in the rate. For example, if you want the job to be executed every 4 
hours, type 4 into the box. The job will be first executed at the date and time set in the New Start Time 
fields, then will be repeated every four hours. 

o For daily recurrences, type in the rate. For example, if you want the job to be executed every 3rd day, 
type 3 into the box. The job will be first executed at the date and time selected in the New Start Time 
fields, and will be repeated every third day. 

o For weekly recurrences, type in the rate and select the days of the week on which you want the job to 
be executed. For example, if you type 2 into the first box and click in the Monday and Friday boxes to 
select them, the job will be executed every second week; the first time on the Monday, the next time 
on the Friday, the next time on the Monday and so on. 

o For monthly recurrences, type in the day of the month and the rate. For example, if you want the job to 
be executed on the 10th day of every second month, type 10 into the Day box and 2 into the Month 
box. 

4. In the Range of Recurrence fields, set the end-date and time for the recurrences. No recurrences will be 
performed after this date and time. 

5. Click Save to save the settings. 

The Recurrence tab changes to display the settings. 
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Figure 156  The Recurrence tab showing an example of recurring settings 

Note: If you go out of the dialog before saving the settings, the settings will revert to their default values. 

Once you have saved the settings, you can go back at any time to change them or halt the task. To do this, click 
Change(go to How to Change the Execution Settings on page 127 for more information). 

7.1.6.3.4. The Upload Sample Properties Page 
When executing a job (go to How to Execute a Job on page 119 for more information), if you select the Upload 
option and click Next in the resulting dialog, the Upload Sample Properties page opens as shown below. This 
page is where you select the project to which the sample is to be attached. 

Note: If the sample contains text variables that are longer than 255 characters, those variables will be 
truncated automatically to 255 characters when they are uploaded to the survey. 

 

Figure 157  The Upload Sample Properties page 

1. Click Select Project. 
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The Project List window opens. 

2. Select the required project from the list and click OK. 

The window closes and the selected project Id is added to the field. Note that in the event the list is 
extensive, you can search for the required project using the various search criteria available. 

3. Type a comment into the Comment field as required. 

4. Click in the Test Database box to select it if you wish to attach the resulting panel to the project's Test 
database. 

If the selected project contains an email, when you select the Email Sample box the email properties 
become active. 

 

Figure 158  The Upload Sample Properties page with the email section active 

• Email - if the project includes more than one email, click the down-arrow and select from the list the email 
that is to be used. 

• Mail Date - the date on which the email is to be sent (go to How to Set the Mailing Date on page 100 for 
more information). 

• Mailing Time - the time at which the email is to be sent. If a large number of emails are to be sent and the 
transmission is divided into batches, this is the time the first batch is sent. 

• Number of Batches - if a large number of emails are to be sent and you wish to divide the transmission 
into batches, type the number of batches here. 

• Hours Between Batches - specify the number of hours between each batch of emails that is to be sent. 

• Email Reminder - if you wish to send a reminder email to those panelists who do not respond to the 
questionnaire, check the box. The two options then become active. 

• Email Reminder - if the project includes more than one email, click the down-arrow and select from the 
list the email that is to be used. 

• Days to Reminder - type in the number of days after which the reminder email is to be sent. 

5. Make the settings as required. 
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6. If you have several sub-samples and you wish to send different emails to different sub-samples, check this 
box. The Sub Sample list below becomes active. Here you can select the primary and reminder emails for 
each sub sample. 

7. On completion, click Next. 

The Augment Sample Properties page opens (go to The Augment Sample Properties Page on page 126 
for more information). 

7.1.6.3.5. The Augment Sample Properties Page 
When you click Next on the Upload Sample Properties page (go to The Upload Sample Properties Page on page 
124 for more information), the Augment Sample Properties page opens as shown below. 

Use the Augment Sample functionality to ensure you receive the required number of responses to your 
questionnaire. If for example you need 1000 responses, you will probably start by creating a sample of 1000 
panelists. However there is a good chance that not all of the panelists will reply, leaving you with perhaps only 
600 responses. You can therefore set up the Augment functionality to create after a specified period additional 
samples such that you will receive the desired total of 1000 responses. 

The Augment functionality will wait a specified period (Days to First Augment) after the initial mailing date, and 
then count the number of responses that have been returned by the original sample. It will then check whether 
that number is within the Augmenting limits (Lower and Upper Limits), and if so will select a new sample 
calculated to provide the required "top-up" of responses. If the Number of Augments is set to anything other than 
1, the system will then wait a further specified number of days (Days Between Augments), before repeating the 
process. The process will be repeated until either the required number of responses is received or the specified 
number of augments is performed. 

 

Figure 159  The Augment Sample Properties page 

• Days Between Augments - the number of days that are to elapse between each augmenting task. 

• Number of Augments - the number of augmenting tasks that are to be run, if required. 

• New Target factor - the factor in percent by which the difference between the original total target and the 
actual return is multiplied. The calculation will be run for each sub sample, and the new total target will be 
distributed to the groups according to the original ratio. The calculation is: New Total Target = (Total 
Target - Actual Return) * New Target Factor  

• Lower Limit to Run Augment - the percent difference between the original target and the actual return 
must be higher than this limit for the augment to run. The limit is per sub sample.  

• Days to First Augment - the number of days after the mailing date when the first augment task is to run. 

• Upper Limit to Run Augment - the percent difference between the original target and the actual return 
must be lower than this limit for the augment to run. The limit is per sub sample. 
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• Target for Calculating Diff. - the target used for calculating the difference between the target and the 
actual return instead of the original total target. The calculation is: 

New Total Target = (Target for Calculation Diff - Actual Return) * New Target Factor. 

7.1.6.3.6. How to Change the Execution Settings 
Once a job execution task is set up and activated, the job will be listed in the Tasks list. If you wish to make 
changes to the task, execution time or recurrence sequence, proceed as follows: 

1. In the Quick Access pane, go to the Tasks menu command. 

The Tasks window opens listing all the tasks that are scheduled to run, with the task to be performed first 
at the top. 

Note: The list will include tasks for all projects to which you have access. To restrict the list to the tasks 
for one project, type the project ID into the appropriate search field and click Search (go to The Project 
Tasks Page on page 21 for more information). 

 

Figure 160  Example of a Task List 

2. Click the blue Task ID link for the task you wish to change. 

The Execute Job window opens for that job, showing the instances for the job. 

3. Go to the Recurrence tab, and click Change. 

The tab changes to show the current details of the job. 

 

Figure 161  The Execute Job > Recurrence tab ready for changing 

 Here you can make the required changes to the job (go to How to Change the Job Schedule Settings on 
page 161 for more information). 
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4. On completion, click Save to save the settings, then click Close Window to return to the Task list. 

7.1.6.3.7. How to Delete a Job from the Execute List 
Once a job is scheduled for execution it will be listed in the Scheduling window. Go to this window to delete a job 
before it is executed  (go to How to Abort Execution of a Sampling Job on page 161 for more information) 

7.1.6.4. After the Job has been Executed 
Once a sampling job has been executed, the basic details of the job are presented in the Job Runs list in the 
lower part of the Execution tab (go to The Job Runs Area on page 119 for more information). A number of 
procedures and operations can be performed from the Job Runs area. These are described in the following 
sections. 

The reports generated for the various jobs that have been run are accessible through the Reporting tab (go to The 
Reporting Tab on page 133 for more information). 

7.1.6.4.1. How to Remove a Run from the Panel 
In the event you have performed a sampling task and updated your panel, but then wish to "undo" the sample 
selection, proceed as follows: 

Note: This procedure will remove a selected run from the panel. To remove all existing runs from the 
panel, use Remove Job From Panel in the Job Execution area of the tab (go to How to Remove a Job from 
the Panel on page 129 for more information). 

1. In the Job Runs area in the lower part of the Execution tab, click on the Run Number for the sampling run 
you wish to cancel. 

2. Click the Remove Run From Panel button (located in the Job Runs area). 

The Remove Sample dialog opens. 

 

Figure 162  The Remove Sample dialog 

• Repost Sample - you may wish to update the existing sample. Check this box to delete the existing 
sample and then automatically re-run the task. If you check this box, you can then select the time when 
the repost is to occur. 

• Comment - type a comment into the field as required. 

• Start Time – specify the time when the task is to commence. Click the down-arrow to open a drop-down 
list of the options available: 

o ASAP – start the job as soon as possible. The job will be queued behind any other jobs awaiting 
processing in the database, and will be run as soon as the processor is available. 

o Schedule for later execution – select this option if you want to run the task at a later time. If this 
option is selected, when you click OK, a dialog opens in which you can set the required time and date 
for the procedure to be run, and whether you want the job to be repeated. 

3. Make the required selections and click OK. 

The task is run as specified. 

4. On completion, click the OK button to return to the Execution tab. 
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If you selected Repost Sample, once the Repost operation is completed then the Panel Updated column 
will show No for the selected run. 

7.1.6.4.2. How to Remove a Job from the Panel 
In the event you have performed a number of sampling tasks and updated your panel, but then wish to "undo" 
ALL the sample selections, proceed as follows: 

Important: This procedure will remove all the runs from the panel. To remove one specific run, use 
Remove Run From Panel in the Job Runs area of the tab (go to How to Remove a Run from the Panel on 
page 128 for more information). 

1. In the Job Execution area in the upper part of the Execution tab, click the Remove Job From Panel 
button. 

The Remove Sample dialog opens. 

 

Figure 163  The Remove Sample dialog 

• Repost Sample - you may wish to update the existing samples. Check this box to delete the existing 
samples and then automatically re-run the tasks. If you check this box, you can then select the time when 
the repost is to occur. 

• Comment - type a comment into the field as required. 

• Start Time – specify the time when the task is to commence. Click the down-arrow to open a drop-down 
list of the options available: 

o ASAP – start the removal task as soon as possible. The task will be queued behind any other tasks 
awaiting processing in the database, and will be run as soon as the processor is available. 

o Schedule for later execution – select this option if you want to run the task at a later time. If this 
option is selected, when you click OK, a dialog opens in which you can set the required time and date 
for the procedure to be run, and whether you want the job to be repeated. 

3. Make the required selections and click OK. 

The task is run as specified. 

4. On completion, click the OK button to return to the Execution tab. 

If you selected Repost Sample, once the Repost operation is completed then the Panel Updated column 
will show No for the selected run. 

7.1.6.4.3. How to Upload the Output File 
Once you have created the required sample file, if it is not uploaded to the project automatically when it is created 
(go to The Upload Sample Properties Page on page 124 for more information) then it must be uploaded 
"manually". To do so, proceed as follows: 

1. In the Execution tab's Job Runs area, select the run you wish to upload to your project. 

2. Click Upload. 

The Upload Sample Properties dialog box opens. 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 130 - 

 

Figure 164  The Upload Sample Properties dialog - 1 

• Existing Project - select to upload the sample file to an existing project. 

• New Project - select to create a new project and upload the sample file to it. 

3. Select the start time for the job and click Next (go to How to Set the Execution Time/Date for a Job on 
page 121 for more information). 

The dialog changes to that shown below. Note that if you have selected to upload to a new project, the 
field layout will be slightly different. 

 

Figure 165  The Upload Sample Properties dialog - 2 

• Project ID – the ID number of the project into which you wish to load the sample file. 

• Comment – free text field for general comments. 

• Test Database – check to load the data file into a test database such that you can test the survey. 

2. In the Project ID field, write the ID number of the project into which you wish to load the sample file, and 
make the other settings as required. 

3. Click OK. 

The file containing the details of the selected panelists is loaded into the selected survey. While this is 
happening, a task list and progress bar is displayed on the screen. On completion, an OK button will 
appear at the bottom of the task list. 
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4. Click OK to return to the Job Information page. 

The Sampling job is now complete. Refer to the Confirmit Authoring User Guide for further information on 
survey creation. 

7.1.6.4.4. How to Change the Panel Mailing Date 
If you need to change the mailing date (the date the project is to be emailed to the panel), then you can do so as 
follows: 

1. In the Execution tab's Job Runs area, select the run you wish to change the mailing date for. 

2. Click the Change Mail Date button. 

The Change Date dialog opens. 

 

Figure 166  Example of the Change Date dialog 

3. Set the date as required. 

4. Click OK. 

7.1.6.4.5. How to Add Test Panelists to the Database 
Once a job has been executed for the first time, the Add Test Panelists button appears in the tab’s toolbar. To 
add a tester template to the database: 

1. Click the Add Test Panelists button. 

The Tester Template List window opens. This window lists all the tester templates available for this panel 
(go to Tester Template List on page 165 for more information). 

2. Select in the list the template you wish to add to the database. 

3. Click Apply and Close. 

The template is added to the database. 

7.1.6.4.6. How to Export the Sample File 
Once you have created the sample file you can export it to another server or project. Proceed as follows: 

1. On the Execution tab, in the Job Runs area select the job run for which you wish to export the sample file. 

2. Click Export Sample File. 

The Sample File Export dialog opens. 

 

Figure 167  The Sample File Export dialog 

3. The Email Recipient field contains the email address registered for the current user. Change this as 
required. 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 132 - 

4. Type a comment into the Comment field if required and click OK. 

The sample file created by the selected job is zipped, attached to an email and sent to the specified 
address. 

7.1.6.5. The Task Definition Properties Dialog 
Use this dialog to set up recurring jobs, and to view the details of jobs that are already set up to run at some point 
in the future. The tabs in the dialog are: 

• Properties– provides general information on the selected job, and allows you to enter comments on the 
job. 

 

Figure 168  Example of the Properties tab 

• Recurr – once the settings have been saved, this tab displays the initial settings for the current job and 
the dates and times of any recurrences. 

• Instances – One job scheduled for execution can have several instances (recurrences). The Instances 
tab lists those recurrences that have been completed, and the next recurrence scheduled to be performed. 
Click on the link in the Schedule column to check the details for each recurrence. 

 

Figure 169  Example of the Instances tab 

• Parameters – is for information only. 
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Figure 170  Example of the Parameters tab 

• Ownership – All tasks have a specified “owner”; in most cases the user who originally created the task. 
However, a user’s access permission can expire or be deleted, and if a task previously created by a now-
expired/deleted user attempts to run then the task will abort. In this case, the administrator has the option 
of changing the task’s owner. To change the task owner, go to the Ownership tab, type in the new owner’s 
user-name, and save the change. 

Note: To change a task owner, the administrator must have task_admin, system_admin, 
system_project_admin or project_admin permission. Users with other permissions will not see the 
Ownership tab. 

7.1.7. The Reporting Tab 
This tab lists the jobs that have been executed, and provides access to the reports for those jobs. 

 

Figure 171  Example of the Reporting tab 

The tab contains two main areas: 

• The Job Reporting area - provides access to the current Job Definition Report and status (go to The Job 
Reporting Area on page 133 for more information) 

• The Job Runs area - provides access to the Job Definition Reports and other information for each run, as 
the job was defined when that run was executed (go to The Job Runs Area on page 136 for more 
information). 

7.1.7.1. The Job Reporting Area 
The Job Reporting area is in the upper part of the Reporting tab. 

 

Figure 172  The Job Reporting area on the Reporting tab 
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The area displays the current status for the job. Note that the job status is changed automatically by Confirmit as 
it passes through the various development stages. The area has one button: 

• Job Definition Report – click this button to display a report of the current job definition, as shown in the 
example below. Note that the Definition Report links in the Job Runs area provide access to the Job 
Definition Reports as they were when the runs were performed. 

 

Figure 173  Example of a Job Definition Report 

The Job Definition Report report contains three sections: 

• Job Details – the job number, status etc (go to The Job Details Area on page 134 for more information). 

• General Information – the job categories, the expression and exclusions used, and the additional items 
selected (go to The General Information Area on page 135 for more information). 

• Sub Sample Information – details of the sub samples defined (go to The SubSamples Information Area 
on page 135 for more information). 

7.1.7.1.1. The Job Details Area 
This area provides general details of the job, such as the number, a description, the data source etc.. 
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Figure 174  Example of the Job Details area 

Click the green Back button to close the window and return to the Reporting tab. 

7.1.7.1.2. The General Information Area 
This area shows general information about the job, such as which categories are selected, the filter scripting, 
eliminations, etc.. 

Click the up or down arrow button in the area's header row to show or hide the information, and click the green 
Back button to close the window and return to the Reporting tab. 

 

Figure 175  Example of the General Information area 

Note that exclusions are sorted by job number. 

7.1.7.1.3. The SubSamples Information Area 
This area displays details of the various sub-samples in the sample. 

Click the up or down arrow button in the area's header row to show or hide the information, and click the green 
Back button to close the window and return to the Reporting tab. 

 

Figure 176  Example of the SubSamples Information area 
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7.1.7.2. The Job Runs Area 
The Reporting tab's Job Runs area is located in the lower part of the tab. 

 

Figure 177  Example of the Reporting tab's Job Runs area 

This area lists the job runs that have been performed, and provides links to the various reports that are created for 
each run. These are: 

• Crosstab Report - you can build simple tables to analyze the generated samples using the same data as 
the Outgo Reports. Click this button to use the "current" sample settings (go to The Crosstab Report on 
page 136 for more information).   

• Definition Report - specifies the job definition at the moment the run was executed (go to The Definition 
Report on page 138 for more information). 

• Outgo Report - provides the outgo report in HTML (go to The Outgo Report HTML on page 139 for more 
information) and Excel format (go to The Outgo Report Excel on page 140 for more information). 

Click on the button above the run list or the appropriate blue link to open the required report. 

7.1.7.2.1. The Crosstab Report 
This tab allows you to select various fields and segments from the database, and create reports using the 
selected items. You can add the desired fields and segments to the table rows and columns, nest or stack them 
as required, then view the results. 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 137 - 

 

Figure 178  Example of a Crosstab Report under construction 

• Back - click to return to the Reporting tab. 

• Create Report - once you have selected the required fields and/or segments, click to view the resulting 
report. 

• Decimals - you can specify the number of decimals to be used in the results. Type a positive integer into 
the field. Note that you can increase the number of decimal places displayed to reduce the effects of 
rounding and thereby increase the accuracy of the displayed data. 

• Distribution - select the value on which the chart is to be based. Note that the selected option must be 
available in the table for it to be presented in the chart.  

o Count – shows the actual number of responses per series.  

o Horizontal Percent – the results calculated as a percentage, where the columns add up to 100% 
“horizontally” in the table. 

o Vertical Percent – the results calculated as a percentage, where the columns add up to 100% 
“vertically” in the table. 

o Combinations of the above. 

• Remove Empty Headers on Rows/Columns - check the boxes to automatically hide (mask) all rows 
and/or columns that contain no data. As soon as data is received for the row or column, it will be 
displayed. 

To add a field or segment to the report, select it in the Available list and click Add to Rows/Columns as 
appropriate. The selected item is then copied into the Rows or Columns field. Select the Stacked or Nested radio 
buttons as required, then click Add to move the selected items to the Selected Tables field. When you have set 
up the report as required, click Create Report to view the results. 
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Figure 179  The resulting Crosstab Report 

7.1.7.2.2. The Definition Report 
This report specifies the job definition at the moment the run was executed. When the Job Runs list contains a 
number of runs, the Definition reports for the runs may well differ. Note that the Job Definition Report button in the 
Job Reporting area opens a report of the "current" settings (go to The Job Reporting Area on page 133 for more 
information). 
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Figure 180  Example of a Definition Report 

 The Definition Report report comprises three areas: 

• Job Details – the job number, status etc (go to The Job Details Area on page 134 for more information). 

• General Information – the job categories, the expression and exclusions used, and the additional items 
selected (go to The General Information Area on page 135 for more information). 

• Sub Sample Information – details of the sub samples defined (go to The SubSamples Information Area 
on page 135 for more information). 

7.1.7.2.3. The Outgo Report HTML 
This option allows you to create Outgo reports in HTML format, as shown in the example below. 
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Figure 181  Example of an Outgo Report HTML 

• Click Back to return to the Reporting tab. 

• Printer Friendly version – opens a new window containing a version of the report that is set up for 
printing. 

• Sub Sample– the information is presented separately for each sub-sample. Use this field to filter the sub 
sample details that you want to be displayed. Select between the various sub samples that are included in 
the job, or All. 

7.1.7.2.4. The Outgo Report Excel 
This option allows you to create Outgo reports in Excel format, as shown in the example below. 
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Figure 182  Example of an Outgo Report in Excel format 

7.2. Current Matrix 
This window shows the details of the matrix currently selected in the Matrix List. The window contains four tabs: 

• General – gives the general details for the matrix. 

• Dimensions – lists the existing dimensions for the matrix, and allows you to create more as required. 

• Weights – lists the existing weights for the matrix, and allows you to create more as required. 

• Report – displays a report of the current settings. 

The window opens at the General tab. 

Note: In the event no matrix has been selected so far in the current Confirmit session, when you click on 
Current Matrix you will be taken to the Matrix List. Select a matrix to go to the Current Matrix page. 

7.2.1. The General Tab 
This tab provides general information about the selected matrix. 

 

Figure 183  The Current Matrix > General tab 

The tab’s toolbar contains four buttons: 

• Save – saves changes. The button flashes while Confirmit detects unsaved changes. 

• Duplicate – creates a copy of the current matrix. 
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• Export Matrix – exports a matrix to another server. 

• Validate Matrix – checks the matrix to ensure it contains no errors. 

7.2.2. The Dimensions Tab 
A Dimension is a set of segments (answer options). For example, “Gender” would be a dimension, and within that 
dimension would be the segments “Male” and “Female”. 

Go to the Sample Management > Current Matrix window, Dimensions tab. This tab lists the dimensions 
registered for the currently selected matrix. 

 

Figure 184  Example of the Dimensions tab list 

The toolbar buttons are: 

• Delete – deletes selected Dimensions. 

• Move Up/Down – moves selected Dimensions up or down in the list. 

• Combine Dimensions - click to combine the selected dimensions. 

• New Dimension– creates a new dimension for the current matrix. 

• Refresh– refreshes the display. This may be required in the event changes have been made to the list 
that are not displayed immediately. 

Click on a Dimension Name to open the Details page for that dimension. 
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Figure 185  Example of a Details page for a dimension 

The toolbar buttons and data fields are: 

• Save – saves changes for the tab. The button flashes while Confirmit has unsaved changes. 

• Back to Dimension List – takes you back to the list of dimensions registered for this job. 

• Dimension Name – the name of the selected dimension. 

• Collapse Type – in the event a panel does not contain enough suitable panelists to fill 'requested' targets 
in particular segments, this property controls how shortages in segments are to be handled. The options 
are: 

o Nominal collapsing – The targets for the segments with shortages are reduced to correspond to the 
maximum available in the sample population. The excess (un-allocated) target is distributed 
proportionately (according to segment targets) to the other segments within the dimension (go to 
Nominal Collapsing on page 144 for more information). 

o Ordinal collapsing – in shortage scenarios, the total target is kept. The weight targets for the 
segments with shortages are reduced to correspond to the maximum available in the sample 
population. The excess (un-allocated) target is distributed to the next segment within the dimension 
(go to Ordinal Collapsing on page 144 for more information). 

o Non-collapsing adjust targets – the total target is reduced by the amount the segment is short. To 
reach the original target outgo for the other segments, the weight targets for all the segments within 
this dimension are recalculated to suit the adjusted total target (go to Non-Collapsing Adjust Targets 
on page 145 for more information). 

o Non-collapsing keep targets – the total target is reduced by the amount needed to accommodate the 
original weight target for a segment with shortage. All segment weight targets are kept (go to Non-
Collapsing Keep Targets on page 145 for more information). 

Note: The number of dimensions and the number of segments within the dimensions will significantly 
affect the time taken to run the sample job. Depending on the composition of the panel, it may also 
become impossible to fill all cells in the matrix. For extreme matrix definitions with many dimensions 
and/or large lists of segments within the dimensions, the sample extract may become impossible to 
perform. 

Select two or more dimensions in the list and click the Combine Dimensions button to combine the selected 
dimensions. The result is as shown in the example below. 
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Figure 186  Example of two dimensions combined into one 

7.2.2.1. Nominal Collapsing 
Nominal data is a form of categorical data where the order of the categories is not significant. Examples include 
industry ("Accommodation, Cafes and Restaurants", "Agriculture, Forestry and Fishing", "Communication 
Services" ,...), gender, ethnicity etc. In shortage scenarios, the target sample outgo is kept. The segment target of 
a segment with shortage is reduced to correspond to the maximum available the in sample population. The 
excess target is distributed proportionately (according to the segment targets) to the other segments within the 
dimension. 

For example: Assume we have asked for a sample of 40000 in total, spread out evenly across the age groups 
with 10% (4000) taken from each group. In this case, six of the age groups have shortages, but we see that the 
total number of panelists requested is kept by filling up from the four segments where we have an excess. Note 
that the missing panelists are drawn as evenly as possible between these four segments (1413,1412, 861, 1413). 

 

Figure 187  Example of the results when Collapse Type is set to Nominal Collapsing 

7.2.2.2. Ordinal Collapsing 
For ordinal data, the numbers assigned to the objects represent the rank order (1st, 2nd, 3rd etc.) of the entities 
measured. For this type of data, comparisons of 'greater than' and 'less than' can be made. In shortage scenarios, 
target sample outgo is kept. The segment target of a segment with shortage is reduced to correspond to the 
maximum available in the sample population. The excess target (the difference between the requested target and 
the actual quantity available) is distributed to the next segment within the dimension. If the last segment has a 
shortage, the redistribution will be done in reverse order - the next to last segment will be given the excess target. 

For example: Assume we asked for a sample of 40000 in total, spread out evenly across the age groups with 10% 
(4000) taken from each group. We have a lot of shortages, and if we look at the figures we see that the shortages 
for age groups 15-19 and 20-24 are compensated for in the 25-34 segment. The next shortages are in segments 
6,7,8 and 9. These shortage are partially compensated for in the following segment (10). However we don't have 
enough panelists in segment 10 to fully compensate, so then the order is reversed. This means we try to 
compensate in segment 9, then segment 8 etc. but these are already used up. As many as possible are taken 
from segment 5 but there are still not enough, so the remainder are taken from segment 4. 
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Figure 188  Example of the results when Collapse Type is set to Ordinal Collapsing 

7.2.2.3. Non-Collapsing Adjust Targets 
Target sample outgo is reduced by the amount the segment is short. In order to reach the original target outgo for 
the other segments, the segment targets for all the segments within this dimension are recalculated to suit the 
adjusted sample outgo. 

For example: Assume we have asked for 40000 panelists, divided evenly as 50% females and 50% males, which 
should give us 20000 of each. We have more than enough male panelists available (27620), however we have 
only 18122 females, giving us a shortage of 1878 females. The total target is therefore reduced from 40000 to 
38122 (40000-1878=38122). The weight ratio for females is recalculated (18122/38122=0,4754 or 47.5%), and 
the weight ratio for males is also adjusted accordingly (20000/38122=0.5246 or 52.5%). 

 

Figure 189  Example of the results when Collapse Type is set to Non-Collapsing Adjust Targets 

7.2.2.4. Non-Collapsing Keep Targets 
Target sample outgo is reduced by the amount needed to accommodate the original segment target for a 
segment with shortage. All segment targets are kept. 

For example: Assume we are asking for 40000 panelists, divided evenly as 50% females and 50% males. In this 
case we have more than enough (27620) male panelists, but we have only 18122 females. This gives us a 
shortage of 1878 females. To keep the 50/50 weight-ratio the male target is also reduced by 1878, so the final 
target sample outgo is therefore reduced to 36244. 

 

Figure 190  Example of the results when Collapse Type is set to Non-Collapsing Keep Targets 

7.2.3. The Weights Tab 
The segments within a dimension must be weighted. For example, if you are going to use the Gender dimension 
with its Male and Female segments, then you must specify the male-to-female ratio that you want in the result. 
You can create several weighting sets for a dimension, though only one weight set can be used on a dimension 
per sample. 

Use this tab to create a new Weight set for a dimension, and see and/or edit the details of existing weights. 
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Figure 191  Example of the Weights tab Weight List 

The toolbar buttons are: 

• Delete Weight – deletes selected Weights. 

• New Weight – creates a new Weight for the current Dimension. 

• Refresh – refreshes the display. This may be required in the event changes have been made to the list 
that are not displayed immediately. 

Click on a Weight Name in the list to open the details page for that weight. 

 

Figure 192  Example of a Weight Details page 

The toolbar buttons and data fields are: 

• Save – saves changes for the tab. The button flashes while Confirmit has unsaved changes. 
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• Back to Weight List – closes the details page for the Weight and returns you to the Weight List. 

• Duplicate – creates a copy of the current Weight. The new Weight is given the name Copy of (selected 
weight). 

• Weight Name – the name of the currently selected Weight. 

• Dimension – if you only wish to view one of the dimensions listed, use this drop-down list to filter out the 
other dimensions. Otherwise, select All Dimensions to view all. 

7.2.4. The Report Tab 
This tab shows details of the dimensions and weights used in the current matrix. 

 

Figure 193  Example of the Report tab 

The tab has the following button in the toolbar: 

• Printer and Save Friendly version – opens a new window containing a printer- and save-friendly version 
of the report. 

The Weights links in the upper section of the tab allow you to jump down to the corresponding detail lists for the 
weight. 

When dimensions have been combined (go to The Dimensions Tab on page 142 for more information), the 
Dimension drop-down field is displayed. Here you can filter the dimension details to show only those for the 
dimensions you select. 

Click the chevron buttons in the header bar for each section (see the Dimension Details bar in the figure above) to 
collapse and expand the section. 
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7.2.5. Procedures in the Current Matrix Tab 

7.2.5.1. How to Duplicate a Matrix 
1. Click the Duplicate button in the General tab’s toolbar. 

A copy of the current matrix is created and its details are displayed in the General tab. 

2. Click in the Matrix Name field and type in a name for the new matrix. 

3. Click Save to save the changes. 

The new matrix is added to the Matrix List. You can now edit the matrix as required and use it in a job. 

7.2.5.2. How to Validate a Matrix 
1. Click the Validate Matrix button in the General tab’s toolbar. 

Confirmit checks the matrix and presents a result message as appropriate. 

 

Figure 194  Example of a matrix validation error message 

If the matrix is found to be correctly constructed and is approved, the following message is displayed. 

 

Figure 195  The “matrix is valid” message. 

2. Click OK to close the message. 

7.2.5.3. How to Create a New Dimension 
1. Click the New Dimension button located at the right end of the Dimensions tab toolbar. 

The Dimension Name dialog opens. 

 

Figure 196  The Dimension name dialog 

2. Type a name for the dimension into the Dimension Name field. 
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3. Click OK. 

The Edit Dimension Details window for the new dimension opens. 

 

Figure 197  Example of the Edit Dimension window 

4. In the variable list (the left column), using the Search function as necessary, find and select the variable 
you wish to add to the dimension. 

The possible values for the selected variable are presented in the second column. These change as 
appropriate to reflect the selected variable. You can add as many variables to a segment as required. 

5. In the second column, select the required values for the variable. 

6. In the third column select the required operator and function. 

Note: The operator for the first variable selected must be None. 

7. Click Create New. 

The segments are added to the dimension and are listed in the Segments in Dimension column. 
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Figure 198  Example of segments in a dimension 

8. Save the changes. 

Note: If the dimension you are working with is part of a Combined dimension, the Up to Parent button is 
included in the toolbar. Click this button to go to the Dimension Details page for the combined dimension 
(go to The Dimensions Tab on page 142 for more information). 

7.2.5.4. How to Create a Weight Set 
1. In the Sample Management > Current Matrix > Weights tab, click the New Weight button located 

towards the right side of the tab toolbar. 

The Weight Name dialog opens. 

 

Figure 199  The Weight Name dialog 

2. Type a name for the new weight into the data field and click OK. 

The Details page for the new weight opens. 
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Figure 200  Example of the Details page for a new weight 

The target column fields are blank and must be filled in. Note that the Total fields (currently red) for each 
set of rows must sum to 100%. When this is correct, the field will turn green. 

3. Type or copy the appropriate values into the Target fields. 

4. Click the down-arrow beside the Dimension field to open a drop down list of the options available, and 
select the required dimension from the list. 

Each Dimension row has a Copy and a Paste button. Click Copy to copy the target weights for the 
dimension to the clipboard. Click Paste for a different dimension to paste the target weights into that 
Dimension’s weight fields. 

5. When all the target weight fields are correctly filled in, click Save to save the details. 

The weight is saved and added to the Weights list. In the event some target weights are not filled in correctly, an 
error message will be displayed. 

  

7.2.5.5. How to Delete a Weight Set 
To delete unnecessary weight sets: 

1. Go to the Sample Management > Current Matrix > Weights tab, Weights list. 

2. Find the weight set you wish to delete, and click in the corresponding box to select it. 

3. Click Delete Weight. 

A confirmation message box opens. 

4. Click OK to delete the weight, or Cancel to close the message box without deleting the weight. 

7.2.5.6. How to Export a Matrix 
You may wish to export a matrix from the current server so it can be used on a different server. A matrix is 
exported on an email as an .xml file. To export a matrix: 

1. Click the Export button in the General tab’s toolbar. 

The Matrix Export dialog opens. 
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Figure 201  The Matrix Export dialog 

2. The default email address is that of the current user. Change as necessary. 

3. Type any comments into the Comment field. 

4. Click OK. 

The matrix is sent as an .xml file attached to an email. It can now be imported into a different server. To 
import a matrix that has been exported from a different server, see section (go to How to Import a Matrix 
on page 158 for more information). 

7.3. Job List 
This window lists all the sampling jobs that you currently have “in progress”. Once a job is complete, the sample is 
linked to the survey and the panelists are invited to respond, then the job is moved to the Active Job List (go to 
Active Job List on page 155 for more information). 

Use the filters to find the job you are interested in and click on the blue link in the Job Number column to select it. 
You will be taken automatically to the Current Job window. 

 

Figure 202  Example of the Job List window 

Note: If you open a job, then return to the Job List and open a different job, an information box appears 
warning you that you are about to change jobs. Click OK to continue and change jobs, or Cancel to 
cancel the change and remain with the current job. 

7.3.1. The Job List Filters 
In an established company the list of registered jobs may run into thousands, and a search through the list for the 
one job that you wish to select for exclusion or relaxation could be time-consuming. Confirmit therefore provides 
you with a set of filters so you can reduce a long list to a manageable size. 

 

Figure 203  The Job List filter bar 

• Job Number – type in the number of the job you are looking for, then click Search. You can use the * 
character as a wildcard, and type in part of the number. For example, type in 123 to find all jobs where the 
job number starts with 123, such as job number 123456. Typing in *123 will find all jobs with the number 
123 somewhere in the job number, such as job number 45123678. 
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• Description – type in the description of the job you are looking for, then click Search. You do not need to 
type in the entire description, and you can also use the * wildcard. For example, if the job you are looking 
for has the text “Confirmit Customer Survey 1” in the description field, typing in confirm, *sur, or even just 
*1 will find the job. However bear in mind that the simpler the search criteria is, the more jobs the search is 
likely to find. 

• Mailing Date – allows you to search for jobs according to the date on which they were mailed. Click the 
drop-down arrow beside the operator field and select the required operator, then click on the calendar icon 
beside the field and select the date. When you are ready, click Search. For example, select the <= 
operator and a date to list all the jobs that were mailed on or before the selected date. 

• Created By – allows you to search for jobs created by specific users. Type the user’s identification (as 
used by Confirmit) into the field, or use standard Windows copy and paste functionality, and click Search. 

• Project Manager - allows you to search for jobs by specific project managers. 

• CustomJobStatus - allows you to search for jobs by specific job statuses. 

• Outgo - allows you to search for jobs based on the number of emails sent. Select the desired operator 
and click Search. 

• Status – allows you to search for jobs according to their current status. Click the drop-down arrow beside 
the field to open a list of the statuses, select the one required and click Search. 

• Last Executed By - allows you to search for jobs based on the user who last executed them Type the user 
name of the desired user into the field. 

• Alphabetical Filter – the letters of the alphabet are listed along the lower edge of the window. Click a 
letter to show only those jobs in which the Description starts with the selected letter. Click All to show all 
jobs. 

Note: You can use any combination of the above filters to find the required job. For example you can 
perform a search to find all the jobs with a particular status that were modified before a given date and 
that were created by a particular person. You can set all the filters and then perform the search, or you 
can perform separate searches using one filter at a time. 

7.3.2. The Job List Toolbar 
• Delete – delete the selected job(s). 

• Search – commence a search based on the selected filter criteria. 

• Export Jobs - select the jobs you wish to export and click this button to commence the export task. 

• New Job – create a new job. 

• Import Job – import a job that has previously been exported, for example when you wish to copy a job 
from another server into this server. 

7.3.3. Procedures in the Job List Window 

7.3.3.1. How to Create a New Job 
This function allows you to create a new job from the bottom up. Note that you can also create new jobs by 
duplicating existing jobs (see the Current Job > Job Information tab section) and by importing jobs from other 
servers (go to How to Import a Job on page 154 for more information). 

1. Click the New Job button located towards the right end of the Job List toolbar. 

The New Job Properties dialog box opens. 
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Figure 204   The New Job Properties dialog box 

2. Type in a unique job number. 

Note: The Job Number can only include letters, numbers and underscore (_). Do not use space or special 
characters (for example &, /, # etc.). 

3. Type a description of the job into the Description field. 

Note that the first letter used in this description will be used in the alphabetical filter. 

4. Click OK. 

The job is created and added to the job list. You can now select the new job and go to the Current Job 
window to set the details and panelist selection criteria. 

7.3.3.2. How to Import a Job 
Use this function to import a job that has for example been created on a different server and exported to a file 
(see also section (go to How to Export a Job on page 95 for more information)). 

1. Click the Import Job button located towards the right end of the Job List toolbar. 

The Job Import dialog box opens. 

 

Figure 205  The Job Import dialog box 

2. Click Browse to open a standard Windows browse dialog box, and find the file you wish to import. 

3. Type a unique job number into the Job Number field. 

4. Click OK. 

The file is imported and added to the Job List. You can now select it in the Job List and go to Current Job 
to edit it. 

7.3.3.3. How to Delete a Job 
Jobs that are no longer needed can be deleted from the system. Note that once a job has been deleted it cannot 
be undeleted, you will need to rebuild it. You can delete any number of jobs simultaneously. 

1. Go to the Sample Management > Job List menu comment. 

The Job List window opens. 

2. Find the job or jobs you wish to delete. 

3. Click in the check boxes for those jobs to select them. 

4. Click Delete. 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 155 - 

The selected files are permanently deleted. 

7.4. Active Job List 
This window lists all the sampling jobs that are currently “in production”. Once a job is complete, the sample is 
linked to the survey and the panelists are invited to respond, then the job is moved to this list from the Job List. 

 

Figure 206  Example of the Active Job List 

7.4.1. The Search Fields 
You may have a large number of jobs that are active at one time, and a search through the list for the one job that 
you wish to view could be time-consuming. Confirmit therefore provides you with a set of filters so you can reduce 
a long list to a manageable size. 

• Status – allows you to search for jobs according to their current status. Click the drop-down arrow beside 
the field to open a list of the statuses, select the one required and click Search. 

• Date Filter – use to find active jobs based on their dates. Select the “type” of date you are looking for, for 
example the mailing date, select the operator, for example < will give all dates less than (before) the 
selected date, and select a date, then click Search. 

• Days Before Closing – use to find active jobs based on the number of days remaining before the survey 
closes. Select the operator, for example > will give all jobs with more than the specified number of days 
remaining, and type in the number of days, then click Search. 

7.4.2. The List Columns 
• Job Number – the number of the job. Click the link to open the Active Job Details page for the job (go to 

The Active Job Details Page on page 155 for more information). 

• Name – the name of the job. 

• Run Number - a sampling job can be run any number of times, allowing you to check the results and 
adjust the parameters to achieve the desired sample. This column displays the run number for the 
sampling job.  

• Status – indicates the current status for the job. 

• Project ID – the identification number of the survey project to which the sample is attached. 

• Mail Date – presents the date on which the survey was mailed to the respondents in this sample. 

• Days Before Closing – the number of days that this survey and sample will remain active before closing. 

• Size – the number of panelists specified for this sampling job. 

7.4.3. The Active Job Details Page 
Click on a blue Job Number link in the Active Job List to open the Active Job Details page for that job, as shown 
in the example below. 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 156 - 

 

Figure 207  Example of an Active Job Details page 

The properties and data fields are as follows: 

• Mail Date - the date the survey is to be emailed to the selected respondents. 

• Update Completes Rule - this field displays the rule that is to be used to define what is to happen when a 
respondent completes the survey. If you wish to change the rule that is to be used, click the down-arrow 
and select the required rule from the list available. 

• Update Non-Responder Date - this is the date by which the respondents are to have completed the 
survey. If a respondent has not completed the survey by the specified date, then the rule specified below 
will be implemented. If you wish to change the date, click the Calendar button and select the required 
date. 

• Update Non-Responder Rule - this field displays the rule that is to be used to define what is to happen 
when a respondent has not completed the survey by the specified date. If you wish to change the rule, 
click the down-arrow and select the required rule from the list available. 

• Update Non-Responder Performed - once the Update Non Responder Rule has been performed, this 
box is checked by the system to indicate completion. 

• Close Date - the date the survey is closed for the sample. If you wish to change the date, click the 
Calendar button and select the required date 

• Survey Closing Rule - this field displays the rule that is to be used to define what is to happen 
when the survey is closed. If you wish to change the rule that is to be used, click the down-arrow 
and select the required rule from the list available. 

• Status - the current status for the job. If you wish to change this status, click the down-arrow and select 
the desired status from the drop-down list. 

7.5. Matrix List 
This window lists all the matrices currently available in your Confirmit database. 
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Figure 208  Example of the Matrix List 

The list of matrices may be extensive, so Confirmit provides you with a set of filters so you can reduce a long list 
to a manageable size. The filter fields are: 

• Panel Fields – allows you to search for matrices based on specified panel fields, for example all matrices 
with Age as or in a dimension. 

• Name – type in the name of the matrix you are looking for, then click Search. You can use the * character 
as a wildcard, and type in part of the name. 

• Created – enables you to search for matrices depending on when they were created. Click the drop-down 
arrow beside the operator field and select the required operator, then click on the calendar icon beside the 
field and select the date. When you are ready, click Search. For example, select the > operator and a date 
to list all the matrices that were created after the selected date. 

• Created By – allows you to search for matrices created by specific users. Type the user’s identification 
(as used by Confirmit) into the field, or use standard Windows copy and paste functionality, and click 
Search. 

• Modified – enables you to search for matrices depending on when they were last modified. Click the drop-
down arrow beside the operator field and select the required operator, then click on the calendar icon 
beside the field and select the date. When you are ready, click Search. For example, select the >= 
operator and a date to list all the matrices that were modified on or after the selected date. 

• Modified By – allows you to search for matrices modified by specific users. Type the user’s identification 
(as used by Confirmit) into the field, or use standard Windows copy and paste functionality, and click 
Search. 

• Last Job Used – allows you to search for matrices according to the job they were last used with. Type or 
copy the job ID into the field and click Search. 

• Last Used – enables you to search for matrices depending on when they were last used. Click the drop-
down arrow beside the operator field and select the required operator, then click on the calendar icon 
beside the field and select the date. When you are ready, click Search. For example, select the <= 
operator and a date to list all the matrices that were used on or before the selected date. 

• Summary– click on the icon to view a summary of the dimensions included in the matrix. 

Note: You can use any combination of the above filters to find the required matrix. For example you can 
perform a search to find all the matrices that were created before a given date and that were created by a 
particular person. You can set all the required filters and then perform the search, or you can perform 
separate searches using one filter at a time. 

Across the bottom of the window is an alphabetic filter – click a letter to display only those matrices in which the 
Name starts with the selected letter. 

7.5.1. Procedures in the Matrix List Window 

7.5.1.1. How to Create a New Matrix 
1. In the Matrix List window, click the New Matrix button located towards the right end of the toolbar. 

The New Matrix dialog box opens. 

 

Figure 209  The New Matrix dialog 
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2. Type a name for the new matrix into the Matrix Name field. 

3. Click OK. 

The Sample Management > Current Matrix window opens at the General tab. 

 

Figure 210  Creating a new matrix 

You now need to define the dimensions and segments for the matrix (go to Current Matrix on page 141 for more 
information) 

7.5.1.2. How to Import a Matrix 
You may wish to import a matrix from a different server. A matrix is exported from a server as an .xml file 
attached to an email. See section (go to How to Export a Matrix on page 151 for more information) for further 
details on exporting. 

1. Open the email and save the attached .xml file to a logical folder on your server. 

2. Open Confirmit and go to the Sample Management > Matrix List menu command. 

The Matrix List window opens. 

3. Click the Import Matrix button located in the upper right corner of the Matrix List window. 

The Matrix Import dialog opens. 

 

Figure 211  The Matrix Import dialog box 

4. Click Browse to open a standard Windows file selection dialog, browse to the .xml file and select it, then 
click Open. 

The .xml file name is added to the File to Upload field. 

5. Type a logical name for the matrix into the Matrix Name field. 

This name will be displayed in the Matrix List window. 

6. Click OK. 
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The matrix file is uploaded and added to the matrix list. You can now edit the matrix as required and add it 
to a job  (go to Current Matrix on page 141 for more information). 

7.6. Scheduling 
This window lists the jobs that are awaiting execution and those that have been run. To open the Scheduling 
window, go to the Sample Management > Scheduling menu command. 

 

Figure 212  Example of the Scheduling window 

The window contains two lists: 

• Sampling Jobs – the queue of sampling jobs that are waiting to be run. 

• Other Jobs – support jobs, such as importing files or exporting to a different server. 

Both the lists have the following buttons and options: 

• Search – type search criteria into the job number field then click Search to reduce the list to only those 
jobs answering to the criteria. 

• Remove – click to delete a selected job from the list. 

• Move Backward – moves the selected job to 1 minute after the next job in the list. 

• Move Forward – moves the selected job to 1 minute before the previous job in the list. 

• View – select Active or Inactive. 

• Refresh – click to update the lists. 

7.6.1. The Sampling Jobs List 
The Sampling Jobs > Active list contains those jobs that are waiting to be run. 

1. Click the link in the Schedule column to open the Task Scheduling window for the job. 
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Figure 213   Example of the Task Scheduling window 

This window contains the Recurrence Pattern dialog. Here you can change the recurrence settings, disable 
(delete) the task, or override the recurrence settings and start the task immediately. 

In the Recurrence tab, click Change to open the dialog for access to the recurrence settings (go to The Task 
Definition Properties Dialog on page 132 for more information). 

7.6.2. The Inactive List 
1. To view the Inactive job-list, go to the Sampling Management > Scheduling menu command, click the 

down-arrow beside the View field and select Inactive. 

The Inactive list contains all the jobs that have been run. The job status column indicates whether the job 
was completed or aborted by the system. 

Note that a job may be aborted by the system for many reasons, for example the system may not be able 
to find the required number of panelists, or there may be a problem with the date or exclusion setup. 

2. To view the report for a completed job, click the link in the Log Entry column for that job. The Task Log 
window opens. 
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Figure 214  Example of the Task Log for an aborted job 

  

• The Definition tab holds the details of the job. 

• If the job has been set up to recur then the Recurrence tab provides details of when etc. Click Change to 
change the recurrence settings (go to How to Set Up Recurring Tasks on page 122 for more information). 

• The Parameters tab shows the job's parameters. 

• The Instances tab shows the date and time of the task, and how the run progressed (see the figure 
above). If this is a recurring job then there may be more than one run listed in this tab. In this case click on 
the blue date/time link for a particular run to view the progress list for that run. 

Click the Close button located in the upper right corner of the window to close the window and return to the 
Scheduling list. 

7.6.3. Procedures in the Scheduling Window 

7.6.3.1. How to Abort Execution of a Sampling Job 
There may be a time when you need to delete a sampling job from the schedule before it has been performed. 
Proceed as follows: 

1. Go to the Sample Management > Scheduling menu command. 

The Scheduling window opens (go to Scheduling on page  for more information). 

2. In the Sampling Jobs list, find the job you wish to delete and click in its checkbox to select it. 

3. Click Remove. 

The job is deleted from the list and will not be performed. 

7.6.3.2. How to Change the Job Schedule Settings 
After a job has been scheduled, you may need to change the settings. 

1. Go to the Sample Management > Scheduling menu command. 

The Scheduling window opens (go to Scheduling on page  for more information). The jobs listed in the 
Active list are those that are scheduled but that have not yet been executed. 

2. Click on the link to the job that you wish to change. 
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The Task Scheduling window opens with the Recurrence Pattern dialog (go to The Sampling Jobs List on 
page  for more information). 

3. Click Change. 

The Recurr tab opens enabling you to edit the settings. 

4. Make the required changes. 

5. Click Save. 

The Recurrence Pattern dialog is updated to show the new settings. 

7.7. Concurrent Sampling 
Note: The Concurrent Sampling functionality is an add-on and is subject to payment. 

7.7.1. Background 
In a normal sampling task, each sample is calculated from the available resources (the panelists that have not yet 
been selected for other jobs) with no awareness of the requirements of any following samples. This process is 
called Sequential Sampling, and the result is that the first samples extracted have first rights to the resources. As 
later samples are extracted, the pool of resources in certain categories may be exhausted leaving none available. 
The sample selection operator would normally attempt to look ahead at the sample jobs in the queue, and make 
manual adjustments to the earlier job specifications so that some scarce respondents will be available for later 
jobs. This process is dependent on the skill of the operator, but is also rather crude and imprecise. Furthermore, 
comparison of such jobs, presumably of equal priority, is very difficult. 

The Concurrent Sampling functionality processes multiple sample selection jobs simultaneously. Each job will 
have a different selection criteria and structure, with different target sample counts, based on output or returns, 
and will make the trade-offs when allocating scarce panel resources. The result in this case will be that scarce 
resources are allocated fairly across multiple sample jobs. 

7.7.2. The Concurrent Sampling Window 
Go to the Sample Management > Concurrent Sampling menu command. The Concurrent Sampling window 
opens. 

 

Figure 215  Example of the Concurrent Sampling window 
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The window contains two main areas: 

• Concurrent Sampling List – lists the concurrent sampling jobs that are currently available to be run. 

• Concurrent Sampling Job List – the jobs that have been selected to be run in the concurrent sampling 
task. 

7.7.3. How to Run a Concurrent Sampling Job 
1. Go to the Sample Management > Concurrent Sampling menu command. 

The Concurrent Sampling window opens. 

2. Click the New Concurrent Sampling button towards the right end of the toolbar. 

The New Concurrent Sampling window opens. 

3. In the Available Jobs list, find the jobs you wish to run concurrently and select them by clicking in the 
boxes at the beginning of the rows. 

If the list is extensive, you can search using the Job Number, the Description or the Mailing Date. 

4. Click Add to move the selected jobs to the Selected Jobs list. 

5. In the Execute Job Properties column, select and/or set the required options. 

6. Click Execute. 

7. In the event you have selected Schedule for later execution in the Execute Job Properties area, a dialog 
will open to allow you to set up the recurrence pattern. Make the appropriate settings and save. 

The job will run as specified. On completion, the samples can be handled as “normal”. 

7.7.3.1. The Execute Job Properties 
• Pull to Expected Returns – each panelist can be given a grade for the probability that he/she will reply to 

the questionnaire. This variable must be created as a system field in the panel survey, and must be an 
open numeric object with a value between 0 and 1. The value of the variable will normally be calculated 
for the individual panelists using a rule, and will be based on the responses to previous surveys. The value 
is used during the sampling process to calculate how many panelists must be selected for a sample to 
ensure that the required number of responses are received. When the Pull to Expected Returns property 
is selected, the Expected Return Variable will be used for each panelist when creating the sub samples. 

Note: The Expected Return Variable must be included in the Data Source for the selected jobs. To enable 
this, you must specify an Expected Return Variable on the Sampling Settings page (go to The General Tab 
on page 167 for more information). 

• Update Panel – ensure this box is checked if you wish to create a sample and update the database. This 
action will reserve the selected panelists for the job, ensuring they cannot be used for other jobs during 
the exclusion periods. 

Click in the box to deselect it if you wish to perform a “dry-run” of the sample selection process. Confirmit 
will then apply all the expressions and exclusions, will check the system setup, and will present a report 
with all the appropriate information, but no changes will be made in the database and the panelists will not 
be reserved. Use this to test the job setup to ensure you get the required panel. You can perform as many 
dry-runs as you wish. 

Note: If you execute the job with the Update Panel option selected, you can remove the panelist 
reservations from the database afterwards. To do this, click the Remove Job from Panel button that 
appears in the tab’s toolbar. 

• Generate Output File – ensure this box is checked if you require the output file (the list of panelists 
reserved for the job) to be created. 

Note: If you select to create the output file but not to update the panel database, then Confirmit will have 
no record that the selected panelists have been involved with this job. These same panelists may then be 
included in later jobs, and will not be excluded automatically by date and/or category. 

• Comments – type any comments into the free-text data field. 

• Start Time – click the down arrow to open a drop-down list of the options available: 
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o ASAP – start the job as soon as possible. The job will be queued behind any other jobs awaiting 
processing in the database, and will be run as soon as the processor is available. 

o Schedule for later execution – select this option if you want to run the job execution procedure at a 
later time. If this option is selected, when you click OK, a dialog opens in which you can set the 
required time and date for the procedure to be run, and whether you want the job to be repeated (go to 
How to Set Up Recurring Tasks on page 122 for more information). 

7.8. Multiple Sample Upload 
This menu command enables you to upload several jobs simultaneously. Note that the jobs must have been 
executed. 

1. Go to the Sample Management > Multiple Sample Upload menu command. 

The Multiple Sample Upload window opens as shown in the example below. 

 

Figure 216  Example of the Multiple Sample Upload window 

Here you must specify the project the jobs are to be uploaded to. 

2. In the Upload Sample Properties column, click Select Project. 

The Available Survey Project window opens, listing the projects currently available. 

3. Select the project you wish to upload the jobs to, and click OK. 

The Available Survey Project window closes and the project number is added to the Project ID field. 

4. In the Available Jobs list, select the jobs you wish to upload and click Add. 

The selected jobs are grayed out in the upper list and are moved to the Selected Jobs list below. 

5. Click Upload towards the left end of the Multiple Sample Upload window toolbar. 

The task window appears as in the example below. Click the Task ID links to see the details pages for the 
tasks. 
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Figure 217  Example of the task list 

6. On completion, click OK. 

The task list closes and you are returned to the Multiple Sample Upload window. 

7.9. Tester Template List 
Go to the Sample management > Tester Template List menu command. This window enables you to add rows 
to the respondent database that you can then populate with “dummy” respondent information such that you can 
test the survey and the system setup before you send it out to the actual respondents. 

A Template in this instance is a set of dummy respondent information that you can create and store such that it is 
available to be added to the respondent database when required. 

You can set up any number of such templates for a panel, and add different respondent information to each such 
that you can check different parts of the survey logic. 

In the event the list is extensive, Confirmit provides a search facility to assist you with finding the template you 
wish to use. This functions in the same way as the other search facilities in Confirmit. 

 

Figure 218  Example of the Tester Templates window 

7.9.1. How to Create a New Tester Template 
1. Click New Tester Template in the upper right corner of the window. 

The New tester Template dialog box opens. 

 

Figure 219  The New Tester Template dialog box 

2. Type in a name for the template 

3. Click Finish. 

The template is created and the Tester Template page opens. 
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Figure 220  Creating a new tester template 

You now need to add the dummy respondents to the template. 

4. In the lower part of the page, click Add. 

A row is added to the table. 

5. Type a panelist ID into the first field, a valid email address into the Email field, and type a group code into 
the other field. 

This Group Code corresponds to the codes specified in the sub-sample. 

6. Repeat steps 4 and 5 until you have the required number of “Test respondents” in the template. 

 

Figure 221  Example of a tester template 

7. Click Save and Close or Save to save the changes, then click Back to return to the Tester Templates list. 

You can now add the dummy “test respondents” created in the template to the bottom of the respondent 
database. The respondent data fields for these new rows in the database are then populated by data copied from 
the same number of rows at the top of the database. In this way, the test respondents will automatically fulfill the 
category, date and other requirements such that they are accepted as “members” of the sample in the database  
(go to How to Add Test Panelists to the Database on page 131 for more information). 

7.10. Sampling Settings 
The Sampling Settings page allows you to set default values and rules for the panel. These settings apply only to 
the panel currently in use. 
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Go to the Sample Management > Sampling Settings menu command. 

The Sampling Settings page opens at the General tab. 

7.10.1. The General Tab 
Use this page to set the default properties for the panel. 

 

Figure 222  The Sampling Settings page General tab 

This page contains the following properties and information: 

• Panel ID – the unique identification number for the panel. This is allocated automatically by Confirmit 
when the panel is first created and cannot be changed. 

• Date Exclusion Pre Days – this is the default value for the “number of days before mailing date” in the 
date elimination function  (go to How to Set the Date Exclusion Function on page 102 for more 
information). 

• Date Exclusion Post Days – this is the default value for the “number of days after mailing date” in the 
date elimination function  (go to How to Set the Date Exclusion Function on page 102 for more 
information). 
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• Category Exclusion Pre Days – this is the default value for the “number of days before mailing date” in 
the Category Elimination function  (go to How to Set the Category Exclusion Function on page 101 for 
more information). 

• Category Exclusion Post Days – this is the default value for the “number of days after mailing date” in 
the Category Elimination function  (go to How to Set the Category Exclusion Function on page 101 for 
more information). 

• Property Exclusion Pre Days - this is the default value for the “number of days before mailing date” for 
excluding properties(go to The Property Definitions Tab on page 170 for more information). 

• Property Exclusion Post Days - this is the default value for the “number of days after mailing date” for 
excluding properties (go to The Property Definitions Tab on page 170 for more information). 

• Survey History Include Months – the number of months that items in the survey history will be included 
in the BitStream files used by the sampling process. Type in the desired value. 

• Logging Enabled – enables or disables extra logging of the sampling balancing algorithm’s behavior. 

• Set Status of Job to Production… - a job will not normally be given the Production status before first 
real panelist has been invited by email. Check this box to set a job status to Production once the sample 
has been uploaded. 

• Validate Background Variables – check to enable validation that the fields in the sampling file exist in 
the survey to which the sample file is to be uploaded. 

• Job Number Pattern – a regular expression used to determine the legal syntax of a job number. 

• Default Project Filter Length – specifies the length of search-criteria when finding a survey to which a 
sample is about to be uploaded. This property should be used if the survey names correspond to Job 
Numbers. 

• Default Survey Rule Template – the Survey Rule Template that is to be used if no other Survey Rule 
Template is specified based on custom properties  (go to The Survey Rule Templates Tab on page 172 
for more information). 

• Default Sample File Field Template – the Sample File Field Template to be used if no other Sample File 
Field Template is specified based on custom properties  (go to The Sample File Field Templates Tab on 
page 171 for more information). 

• Output Rule – use this to set the formatting rules for a sample file. Here you can specify the format for 
date fields, numeric and Boolean values, and create aliases for the output file headers. Click Edit to open 
the Rule Editor page  (go to Current Rule on page 68 for more information). 

• Posting Rule – you can run a panel rule for a specific sample file. For example, if you have a survey that 
requires specific header names for the columns in the sample database, then use this rule to change the 
headers as required. Click Edit to open the Rule Editor page(go to Current Rule on page 68 for more 
information). 

• Sampling Algorithm - allows you to specify the sampling algorithm to be used for single job execution. 
The options are Sequential Sampling and Concurrent Sampling (go to Concurrent Sampling on page 162 
for more information). When Concurrent Sampling is selected, the Expected Return Variable property 
becomes available (see below). 

• Dimension Collapsing Handling - by default, Confirmit will collapse similar dimensions in the new 
combined matrix as this will minimize the complexity of the combined matrix. Using this property you can 
select to collapse only dimensions that are identical. This will maintain more complexity in the matrix, but 
the data in the resulting report will be easier to understand.  

• Support Overlapping Segments - when running Concurrent Sampling, a new combined matrix will be 
set up to include all the dimensions in the different jobs. Similar dimensions will be collapsed according to 
the Dimension Collapsing Handling setting selected (see above). If Dimension Collapsing Handling is set 
to "Identical" and "Support Overlapping Segments" is not enabled, only the overlapping parts of the similar 
dimensions will be available for sampling. 
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• Expected Return Variable – this property appears in the tab when Sampling Algorithm (see above) is set 
to Concurrent Sampling and saved. This property can only be used if one of the variables in the database 
contains the panelists’ probability of answering a survey - in which case you select from the drop-down list 
the variable to be used. The variable will be a system field in the panel survey, and must be an open 
numeric object with a value between 0 and 1. The value of the variable will normally be calculated for the 
individual panelists using a rule, and will be based on the responses to previous surveys. Note that the 
variable cannot be zero for any of the panelists. This variable will be used when Pull To Expected Return 
is selected when running a concurrent sampling job (go to The Execute Job Properties on page 163 for 
more information). 

7.10.2. Refresh Survey History Job Information 
If under the Panel Setup > Designer menu command, the Panel Variables toolbox > Survey History variables 
have been added with an ID corresponding to the ID of a custom property for jobs, and the Characteristic property 
is set to LoopSupport, and the custom properties for the jobs have the Has Survey History Support property 
checked, then the Refresh Survey History… button will synchronize values in the panel based on existing 
values in existing jobs. 

7.10.3. The Categorization Tree Tab 
Use this tab to create and manage a hierarchy tree for the categories used in the panel. The categories are 
defined by the user (company) and used to classify jobs, with each job belonging to one or more categories. You 
can then use these classifications when for example setting up exclusion rules for sampling (go to The Job 
Information Tab on page 94 for more information). 

 

Figure 223  Example of the Categorization Tree tab 

7.10.3.1. How to Add Groups and Categories to a Panel 
To add a categorization or a group to the tree: 

1. Go to the Sampling Management > Sampling Settings menu command and click the Categorization 
Tree tab. 

2. Right-click on the item after which you wish to create the group or categorization, then select Add 
Category or Add Categorization Group from the drop-down menu as appropriate. 

The Categorization Group Name or Category Name form opens as appropriate. 

 

 

Figure 224  The Category Group and Name entry forms 

3. Type the name for the new item into the Category Name field, then press Return or click Save to save the 
changes. 
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Note: Only alpha-numeric characters, underscore, parenthesis, apostrophe and space may be used in 
these fields. 

The Group or Categorization is added to the tree. 

 

Figure 225  Example of a Categorization Tree with Groups and Categories 

These categorizations will be available to you in the Category fields on the Job Information tab when creating 
and/or editing the current job (go to The Job Information Tab on page 94 for more information). 

7.10.4. The Property Definitions Tab 
This tab lists the existing Property Definitions, as shown in the example below. 

 

Figure 226   Example of the Property Definitions list 

The tab allows you to apply your own properties to jobs. Properties can be used not only to categorize jobs, but 
also in for example panel rules. You can specify which of the custom properties, and how many of them, are 
used. 

To edit an existing Definition, click on the blue Name link. The Properties page opens for the definition. 

 

Figure 227  The Property Definitions page 

Here you define new property items and specify their requirements. The selection boxes are: 

• Is Required – check this box if a job must include this property to be valid. 

• Show in Joblist – check this box to specify that the job is to be included in the job list. 
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• Use Sample File Field Template – in the Property Item List in the lower part of the page, select the 
Template to be used. 

• Use Survey Rule Template – in the Property Item List in the lower part of the page, select the Survey 
Rule Template to be used. 

• Has Survey History Support – allows you to add the value of the custom property to the survey history at 
the time of executing a job. This is so customized properties can be used in expressions in Panel Rules 
later. 

• Use in Elimination – click to use the definition for Property Elimination for the job  (go to How to Set the 
Property Elimination Function on page 103 for more information). 

Note: Only one Property Definition can be used for elimination in a job. Once the Use In Elimination box is 
checked for a Property Definition, the box cannot be accessed for another definition. 

7.10.4.1. How to Create a New Property Definition 
1. On the Property Definitions tab, click the New Property Definition button towards the right end of the 

toolbar. 

The New Property Definition dialog opens. 

 

Figure 228  The New Property Definition dialog 

2. Type a name and an ID for the property into the respective fields, then click OK. 

The Property Definitions page opens. Select the options and add Property Items as required. 

3. Save the changes. 

7.10.4.2. How to Define a Property Item 
1. In the Property Item List toolbar, click the Add button. 

A new line is added to the list. 

2. Type in an ID and a name for the new property, then select the remaining options as required (see above 
for definitions). 

3. Save the changes. 

7.10.5. The Sample File Field Templates Tab 
When a job is run, the output is a text file (respondent list). The job specifies which panelists are to be used, and 
also which columns from the database are to be included. This tab specifies which columns are to be included as 
default. 

Note: To specify any columns that are to be included in addition to these default columns specified here, 
go to the Sample Management > Current Job > Sample File Fields tab (go to The Sample File Fields Tab 
on page 115 for more information). 

 

Figure 229  Example of the Sample File Field Templates tab 
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Click on the blue Name link for a template to open the editing page for that template. 

 

Figure 230   Example of the template editing page 

The available fields are listed in the left column; any fields that are already selected for the template are listed in 
the right column. On completion, save the changes. 

7.10.5.1. How to Create a New Template Definition 
1. In the Sample File Field Templates tab, click the New Template Definition button towards the right end of 

the tab toolbar. 

The Template Editing page opens. 

2. Give the new template a name. 

3. In the Available column, find and select the sample file fields you wish to include in the template. 

4. Click the >> button to move them to the Selected column. 

5. Click Save to save the changes. 

If this template is later used in a job, then the database columns selected here will automatically be included in 
the sample file. 

7.10.6. The Survey Rule Templates Tab 
Use the properties in this tab to specify how information in a survey is to update the panel, and to specify which 
rules are to be used in which event. Three events can be controlled by rules: 

• When and how the database is updated with respect to panelists who have completed the survey. 

• When and how the database is updated with respect to panelists who have not responded to the survey. 

• When the survey is to be closed to respondents. 

7.10.6.1. How to Create a New Survey Rule Template 
1. Click the New Survey Rule Template button located towards the right end of the list toolbar. 

The New Survey Rule Template dialog box opens. 
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Figure 231  The New Survey Rule Template dialog box 

2. Type a name for the new rule into the Name field. 

3. Click OK. 

The Rules page opens, enabling you to edit the rules for the template. 

 

Figure 232  The Edit Rules page 

The properties are as follows: 

• Name – the name of the rule. This can be edited as required. 

• Update Completes Rule – the rule that updates the panel database with information on the panelists who 
have completed the survey since the previous time this rule was run. Note that this rule will only be run 
when the Survey Synchronization task runs (go to Survey Synchronization on page 60 for more 
information). The Survey Synchronization task must therefore be set up to run at suitable intervals such 
that the panel database is maintained appropriately. 

• Update Non Responder Rule – not all panelists selected for a survey will always wish or be able to 
respond to the survey invitation. This rule is intended to be used to free up panelists who have not 
responded to the survey within a set time, so they can be used in new surveys. This rule is usually run 
once between the start and closing dates of a survey, on a date specified by the Update Non Responder 
Days setting below. Note that this rule will only be run when the Survey Synchronization task runs (go to 
Survey Synchronization on page 60 for more information). The Survey Synchronization task will therefore 
need to be set up such that this rule is run at the required time. 

• Survey Closing Rule – this rule is run when a survey is to be closed (when the survey is completed). 
Note that this rule will only be run when the Survey Synchronization task runs (go to Survey 
Synchronization on page 60 for more information). The Survey Synchronization task will therefore need to 
be set up such that this rule is run at the required time. Note also that this rule has the same effect as 
going manually to the survey's Project Management > Overview > Panel Status tab and selecting 
Closed. 

• Update Non Responder Days – the number of days after the start of a survey that the Update Non 
Responder rule is to be run (see also Update Non Responder Rule above). 

• Close Days – the number of days after the survey is first made available to a sample that the survey is 
closed – the life of the survey. 

4. Select the rules and type the required values into the fields as appropriate, then click Save or Save and 
Close to input the settings. 
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8. The Snapshot Panel 
A "Snapshot" panel is one that has been set up to make copies of the data in a standard panel. By setting up the 
snapshot panel to make copies at set intervals, you can plot developments in the data over time. 

Note: The Snapshot functionality is a Confirmit add-on. If you do not have access to this functionality, 
contact your Confirmit account manager for more information. 

The snapshot is a copy of the data in a database up to the point in time for which the snapshot is taken. Note that 
you can set up rules that select which variables are copied, so you do not need to copy the entire database every 
time. 

Important: 
A snapshot task can generate large quantities of data, which is expensive for you to store, and will use 
considerable network and server resources. You are therefore recommended to copy only those variables 
that you need, and remove all others. In addition, if you wish to run a snapshot task as recurring, you are 
recommended to set it to run on a monthly basis (rather than daily or weekly). When you execute the task, 
a warning is displayed on your screen to this effect. 

The variables that are to be included in a snapshot database must be identical to those in the panel database, 
however you are not required to include all the variables that exist in the panel database. Therefore, the easiest 
method of creating a snapshot database is often to duplicate the panel database then remove from the snapshot 
database the variables that are not required. See the following section for further details on duplicating and setting 
up a snapshot database. 

8.1. How to Create a Snapshot Panel 
The variables (type, precodes etc.) that are to be included in a snapshot panel must be identical to those in the 
panel from which the data is to be copied. The names of the variables can be different, but then the variables 
must be mapped (see the procedure below). Note that you can select a subset of the available variables to be 
copied; you are not required to include all the variables that exist in the panel. 

The quickest and easiest method of creating a snapshot panel is often therefore to duplicate the original panel, 
then remove from the snapshot panel those variables that are not required. To create a snapshot panel by 
duplicating a "standard" panel, proceed as follows: 

1. Open Confirmit and in the Quick Access pane to the left of the window, click Community Panels. 

The Community Panel List opens. 

2. Select the panel you wish to create a snapshot for. 

3. In the page toolbar, click Duplicate. 

The selected panel is duplicated and added to the Community Panel List with the name "Copy of <original 
panel name>". 

4. Return to the Community Panel List and open the duplicate panel. 

5. In the Panel Overview page give the project a logical name, for example the original project name + 
Snapshot. 

6. In the Available Categories list, select the Snapshot keyword and click the >> button to move it to the 
Selected column. 

7. Go to the Panel Setup > Designer menu command and in the Designer page remove any loops from the 
snapshot project. 

Note: Snapshots only support top-level data; they do not support loops. If a loop is found in the panel, it 
will be ignored.. 

8. Remove any variables (questions) that you do not wish to keep in the snapshot. 

9. Save the changes. 

10. Go to the Panel Setup > Database Generation menu command, then click Generate Database to 
generate the database. 

A progress window opens and the task is run. 

11. On completion, return to the "standard" panel. 
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The standard panel must now be linked to the snapshot panel such that data from the standard panel can 
be copied to the snapshot. 

Note: A Snapshot panel has a similar layout to a normal panel, but the Sample, Sample Management and 
Report menus are not available (go to The Menus on page 6 for more information). 

12. On the standard panel's Overview page, click Select Snapshot Panel. 

The Project List window opens. 

13. Browse to and select the snapshot panel, then click OK. 

The window closes and the project number for the snapshot panel is added to the field. 

14. Click Save to save the changes. 

15. Create a rule (go to How to Create a New Rule on page 85 for more information) to take a snapshot of the 
panel, recurring at the required intervals. 

16. On the Current Rule > Source tab, set the Source Type to Panel Database. 

17. Select the variables that are to be copied. 

18. If required, on the Action tab create a script to perform for example data cleaning. 

19. On the Target tab, set the Target Type to Snapshot Database. 

20. In the event some of the variables in the snapshot project do not match the variables in the project 
database, then you can map the variables so the data will still be transferred. If this is necessary, click 
Column Mapping to open a mapping window, then map the variables as required. 

21. Save the changes. 

22. In the Rule Details page toolbar, click Execute to execute the rule. 

The Execute Rule page opens with a warning message. Here you can set up the rule to recur as required (go to 
How to Set Up and Run a Snapshot Task on page 175 for more information). This procedure is virtually identical 
to that used when setting up a sampling job (go to How to Set Up Recurring Tasks on page 122 for more 
information). 

 

Figure 233  The warning message displayed when you click Execute for a snapshot task 

The procedure is now complete. The rule will be run according to the settings in the Execute dialog. Each time the 
task runs, the data generated by the task will be added to the snapshot database as new rows. Older rows will 
therefore not be overwritten. Note that the panelists will be allocated new Panelist IDs for each snapshot, though 
their original IDs will be repeated each time so for example you can extract development data for specific 
panelists.. 

8.2. How to Set Up and Run a Snapshot Task 
A Snapshot task is set up and run in the same way as any other task. Once you have created and set up the 
Snapshot database (go to How to Create a Snapshot Panel on page 174 for more information), you can set up or 
edit the snapshot task characteristics for the panel at any time. 

1. In the Community Panel List, find and select the panel project that you wish to edit/run the snapshot rule 
for. 

2. Go to the Panel Management > Rule List menu command to open the Rule List, then select the rule that 
you wish to run. 

Note: If the rule is already set to run or is set to run as a recurring task, you can enter the Rule Executor 
page by clicking the Project tasks or Recurring Tasks links located at the bottom of the Project Overview 
page. 

3. In the Rule Details page toolbar, click Execute. 

The Rule Execution Properties dialog open, with a warning, as shown below. 
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Figure 234  Executing the Snapshot rule 

4. If you wish to run the rule "manually" now, click OK. 

The task progress page opens and the rule is run. 

5. If you wish to set up the rule to run at a later time or date, or if you wish the rule to run repeatedly at set 
intervals, click the down-arrow beside the Start Time field and select Schedule for later execution, then 
click OK. 

The Rule Executor page opens at the Recurrence tab. 

 

Figure 235  The Rule Executor page Recurrence tab 

6. Click Change to access the Recurrence parameters and options. 

 

Figure 236  The Recurrence tab in Editing mode 

Note: Depending on which Recurrence Pattern Type option is selected, different options and properties 
become available. For further details on the options, see also How to Set Up Recurring Tasks. 

Important: 
A snapshot task can generate large quantities of data (which is expensive for you to store), and will use 
considerable network and server resources. Therefore, if you wish to run a snapshot task as recurring, 
you are recommended to set it to run on a monthly basis (rather than daily or weekly). 
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7. When the task is set up to your satisfaction, click Save. 

A list of the next few scheduled occurrences is displayed. 

 

Figure 237  Example of the Recurrence tab with tasks scheduled to run 

To further change or disable the task, click Change to return to the editing page. 
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9. The Reporting Menu 
The functionality accessed via the Reporting menu enables you to set up and manage OLAP cubes (go to OLAP 
Cubes on page 184 for more information), and to produce reports based on the data in those cubes. 

 

Figure 238  The Reporting menu 

Note: The Reporting functionality is a Confirmit add-on. If you do not have access to this functionality, 
contact your Confirmit account manager for more information. 

9.1. Report List 
This page lists the reports that have been created for this panel. From this page you can also create new reports 
using Microsoft Report Builder (go to How to Create a New Report on page 181 for more information) and default 
reports (go to Create Default Reports on page 183 for more information). 

 

Figure 239  Example of the Report List page 

In the event the list is extensive, use the search functionality to find the report(s) you are looking for. 

• Click on a Report Name link to open the report. 

• Delete - select a report by clicking in the box, then click Delete to delete the report. 

• Search - if the report list is extensive, add search criteria to the various fields above the list then click 
Search to find the report you wish to work with. 

• New Report - click to go to Microsoft Report Builder where you can create the required reports (go to How 
to Create a New Report on page 181 for more information). 

• Create Default Reports - click to create a set of "pre-designed" standard reports (for example Number of 
panelists : Time) that are stored on the server (go to Create Default Reports on page 183 for more 
information). You can then either use these reports as they are, or edit them. 

9.1.1. The Report > General Tab 
In the Report List, click on a Report Name link to access that report. The report page opens at the General tab. 
This tab shows general information about the report, such as the creator's user name, when the report was 
created etc. as shown in the example below. 
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Figure 240  Example of the General tab for a report 

Note that you can add comments into the Description field. If you add or change any text in the field, click Save to 
save those changes. 

• To view the actual report, go to the View tab. 

• Click Back to return to the Report List. 

9.1.2. The Report > View Tab 
Go to the View tab to view the report (the page may take a few seconds to generate). 

 

Figure 241  Example of a report 

In the event the report extends over several pages you can select the page you wish to view. You can also zoom 
in or out by selecting the desired magnification, search for words or characters, print out the current report page 
and export the report in a specified format. The export formats available are: 
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• XML file with report data 

• CSV (comma delimited) 

• TIFF file 

• Acrobat (PDF) file 

• Web archive 

• Excel 

Note that any exports must be performed manually - they cannot be automated. 

9.1.3. MS Report Builder 
Microsoft Report Builder is a powerful yet easy-to-use tool that allows users to create and design reports. Using 
Report Builder, you can select data and design reports without having to understand how and where the data is 
stored. Nor do you need to know any complex programming languages in order to create the reports. You simply 
need to be familiar with the information stored in your databases. 

You can create table, matrix, or chart reports. To get started, select a report layout template and then simply drag 
and drop the fields that you wish to use into the design area. You can then manipulate your data by filtering, 
grouping and sorting, or working with formulas. Once you have saved your report to the report server, you can 
manage it just like any other report on the server. You can also export the report to your local computer as a 
different file type, such as a TIFF, PDF, Excel, or HTML file.  

Report Builder builds reports based on a data source, sometimes called a report model, provided to you by the 
model designer, typically an analyst, database administrator, or database developer. A data source contains 
information about the data available in the database and the relationships between that data. When you drag-and-
drop the fields onto the design area, you are laying out the report and providing the information needed to retrieve 
your data at the same time.  

MS Report Builder is a fully integrated component of SQL Server 2005 Reporting Services. 

Refer to the following section for installation instructions. 

9.1.3.1. Installing MS Report Builder 
Confirmit Community Panels uses the Microsoft Report Builder application to create reports, so the first time you 
create a new report you will need to download and install the application. Proceed as follows: 

1. Click the New Report button towards the right end of the Report List toolbar. 

A security warning dialog opens. 

 

Figure 242  The Security Warning dialog 

2. Click Run. 
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A progress dialog is displayed. Once the application has downloaded and installed, this is replaced by the 
Microsoft Report Builder window and the application's login page. 

 

Figure 243  The MS Report Builder login dialog 

3. Type in your Confirmit user name and password and click OK. 

The login dialog closes and the Microsoft Report Builder window is activated. You can now commence creating 
your report. 

9.1.4. How to Create a New Report 
Confirmit Community Panels uses the Microsoft Report Builder application to create reports. The first time you 
create a new report you will need to download and install the application (go to Installing MS Report Builder on 
page 180 for more information). Once you have installed MS Report Builder, proceed as follows: 

1. In the Report List page, click the New Report button located towards the right end of the menu. 

The Microsoft Report Builder window opens along with the login dialog. 

2. Type in your Confirmit user name and password and click OK. 

The login dialog closes and the Microsoft Report Builder window is activated as shown below. 
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Figure 244  The MS Report Builder application ready for use 

3. In the getting Started column, select the report server or library where your data is stored (if necessary), 
and the source of the data that you want to use. 

4. Select the desired report layout, then click OK. 

The report designer page opens, with the available variables listed in the Explorer column. In the figure 
below, the Table layout has been selected. 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 183 - 

 

Figure 245  The Report Builder design area 

5. Click in the Click to add title area and type in the title of your report. 

6. Drag the required Entities and/or Fields into the table. 

7. Right-click on the various areas in the report and select Format to format the font, coloring etc. for the 
areas. 

8. On completion, click Run Report to process the data and view the report. 

9. In the event you wish to edit the report, click Design Report to return to the report design window. 

10. Click Save to save the finished report. 

For further details on using this Microsoft product, use the application's Help system or go to www.microsoft.com, 
then search for Report Builder. 

9.1.5. Create Default Reports 
If you find you often need to create reports that use the same layouts and/or variables, for example a report that 
shows how your panel is developing ("Number of panelists" against "Time"), you can create "default" reports and 
store them on the server. Then when you need such a report, instead of creating it from the beginning you can 
click the Create Default Reports button. This will place into the Report List a copy of each of the default reports 
that have been stored on the server. You can then delete any of the reports that you do not need for this panel, 
and edit those that you do need such that they contain the correct variables, have the desired layouts etc. 

9.2. Cube Management 
This menu command provides access to the OLAP cube functionality. Via this menu you can create, generate, 
edit and process the cubes. See the following sections for further information. 
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9.2.1. OLAP Cubes 
Most databases for online transaction processing are designed for efficiency in data storage, and treat all data in 
the database similarly. An OLAP (OnLine Analytical Processing) cube is a specially designed database that is 
optimized for reporting, and it is designed such that the data is stored in a way that makes it simple and efficient 
to retrieve. 

In an OLAP Cube system, the data in the database array is arranged such that it allows fast analysis of large 
amounts of data. OLAP cubes can be thought of as extensions to the two-dimensional array of a spreadsheet.  

OLAP cubes categorize data into "Dimensions" and "Measures". 

• Measures - represent items that are counted, summarized or aggregated, such as costs or units of 
service. 

• Dimensions - are variables by which measures are summarized, for example hospitals, doctors, or dates 
of service.  

This organization of data greatly facilitates the ability to formulate data requests based on real-life situations. 
Much of the required data can be extracted from the database and processed in advance of the user request. In 
addition, many of the queries that could be posed to the data are "pre-aggregated" in the database such that the 
answers have already been calculated. On request, these results can be reported without further processing, 
thereby saving time for both the server and the user. 

The term "cube" comes from the geometric object that has three dimensions. OLAP cubes can have many more 
dimensions than 3, but the term continues to apply.  

For example: 

Assume a financial analyst has access to a product database and wants to view the data in various ways, such as 
displaying all the cities down the page and all the products across a page. And this layout could be for a specified 
period, product version and type of expenditure. Having viewed the data in this particular way, the analyst might 
then immediately wish to view it in another way. With the data arranged as an OLAP cube, the cube could 
effectively be re-oriented so that the data displayed now had periods across the page and type of cost down the 
page. This re-orientation would normally involve re-summarizing very large amounts of data. However by using 
the OLAP cube system the new view of the data can be generated efficiently and quickly; i.e. within seconds 
rather than the hours a relational database and conventional report-writer might take, so avoiding wasting the 
analyst's time. 

9.2.2. The Cube Details > General Tab 
This tab displays general information about the cube. 

 

Figure 246  Example of the Cube Details > General tab 
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Note that you can add comments into the Description field. If you add or change any text in the field, click Save to 
save those changes.  

• Ignore Error When Key Not Found - a "Key not found" error will occur, and the processing task will 
abort, if a key value exists in a fact table but does not exist in the corresponding dimension. Check this 
box to tell Confirmit to ignore these errors and complete the task. 

The remainder of the information on the tab is read-only. 

9.2.3. The Cube Details > Dimensions Tab 
This is an information tab that displays the dimensions selected for the cube in the cube wizard (go to How to 
Create or Edit a Cube on page 186 for more information). The information is read-only on this tab, though you can 
change the selected dimensions by clicking Edit Cube. 

 

Figure 247  Example of the Cube Details > Dimensions tab 

The dimensions listed under Selected Panelist Dimensions and under Selected Survey History Dimensions can 
be crossed with other dimensions in the same group. Note however that dimensions listed in one group cannot be 
crossed with dimensions listed in the other group. 

9.2.4. The Cube Details > Measures Tab 
This tab shows the measures (numerical data) that have been created/selected in the cube wizard (go to How to 
Create or Edit a Cube on page 186 for more information). The information is read-only on this tab, though you can 
change the selected dimensions by clicking Edit Cube. 
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Figure 248  Example of the Cube Details > Measures tab 

9.2.5. How to Create or Edit a Cube 
Note: A snapshot setup normally incorporates one normal panel, one snapshot panel and one cube. In 
the event a cube already exists for a snapshot panel, then the Create Cube button is replaced by the Edit 
Cube button - the procedure is identical. 

1. Go to the Reporting > Cube Management menu command. 

The Cube Details page opens. 

2. Click Create Cube or Edit Cube as appropriate. 

The Create New Cube wizard opens at the Description dialog. 

 

Figure 249  Step 1 when creating a new cube 

3. Type into the field a description of the cube for future reference, then click Next. 

The Select Dimensions page opens. 
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Figure 250  The Select Dimensions page 

• The From and To dates defines the time span of the data that you will be able to report on. You will have 
access to three attributes for the reports; Year, Month and Date and one hierarchy: Year-Month-Date. 

• Partitions are useful when dealing with large cubes. The data in the cube will be stored in partitions, and 
here you are able to specify how many months of data should be in each, and how many you would like to 
process incrementally. 

o Snapshot Months - specifies how many months of Snapshot data you would like in each partition. 

o Survey History Months - specifies how many months of Survey History data you would like in each 
partition. 

o Additional Partitions to Process - specifies how many partitions should be updated when doing 
Incremental Processing.  

Note: The dimensions selected here are listed on the Cube Details > Dimensions tab (go to The Cube 
Details > Dimensions Tab on page 185 for more information). 

4. Select the required Panelist and/or Survey History Dimensions. 

5. Set the dates to define the time-span of the report data. 

6. Specify the partition details. 

7. Click Next. 

The Select Panelist Measures page opens. 
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Figure 251  The Select Panelist Measures page 

8. Select the Panelist Measures that are required in the cube. To do this, click on a Measure in the left 
column to select it, select a Measure Type, and click Add. 

9. Click Next. 

The Select Survey History Measures page opens. 
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Figure 252  The Select Survey History Measures page 

10. Select the Survey History Measures that are required in the cube. To do this, click on a Measure in the left 
column to select it, select a Measure Type, and click Add. 

11. Click Next. 

The Create and Process Cube page opens. 

 

Figure 253  The Create and Process Cube page 

12. Check the box if you wish to create and process the cube, then click Finish. 

The Generate and Process Cube page opens. 
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Figure 254  The Generate and Process Cube page 

13. Add any comments to the Comments field and select a start time for the task. 

14.  For the Generate Cube and Process Cube properties, select the required functions. 

• Generate Cube: 

o Update cube - updates the cube based on the latest changes performed in the cube editor. This 
option is only available if the cube is already generated.  

o Create new cube - creates a new cube from the beginning. If a cube has been generated previously, 
its database will be dropped removing the cube, dimensions, datasources and datasource views. All 
data in the existing cube will be lost. This could be used if you need to recreate the partition sizes.  

o None - will not update the cube even through changes have been made in the wizard. This option 
could be used if you only need to process the cube. 

• Process Cube: 

o Process full - processes all objects. 

o Process incremental - processes all Dimensions and number of specified partitions. This option is 
only available if the cube has already been generated and processed full. 

o Process none - will not perform any processing. This option could be used if you only need to 
generate the cube.  

15. Click OK. 

The task is run when specified and a progress page is displayed. 

16. On completion, click OK to return to the Cube Details page (go to The Cube Details > General Tab on 
page 184 for more information). 
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10. Changes Made to the Survey 
When a panel is attached to a survey, several changes are made to that survey so it can function correctly 
alongside the panel. This chapter describes those changes, and the additional functionality that becomes 
available within surveys run by companies with the Community Panels functionality. 

Important: 
Surveys using batch statusing must include three “background” variables, named 'JobNumber' 
'RunNumber' and 'PanelistId'. These are open-text variables with a field width of 255 characters. They 
must be added as background variables in the survey tree, and they must be included in the fields 
uploaded in the sample/job. JobNumber should be an open question node with a suitable field width set, 
while RunNumber and PanelistId must be numerical open questions with a suitable number of digits. 

Note: The changes and functionality described in this chapter will only occur or be available to 
companies with access to the Community Panels functionality. 

10.1. How to Attach a Panel to the Survey 
If your company is using the Community Panels functionality, then before you launch a survey you will need to tell 
it which panel you wish it to use. 

Note: This selection must be made before you launch the survey prior to sending it to your respondents. 

1. Within the survey, go to the Project Management > Overview menu command. 

The Project Overview page opens at the General tab. The Community Panel property is located towards 
the bottom of the page. 

 

Figure 255  The Community Panel property 

2. Type the Panel ID into the field, or 

3. Click the Find Panel button. 

The Find Community Panel window opens, with a list of the panels available to you. 

4. Click on the appropriate radio button to select the required panel from the list. 

5. Click OK. 

The window closes and the Panel ID is added to the field. 

6. Click Save to save the changes. 

Now, when you launch the survey, the selected panel will be attached to the survey. 

10.2. Registering a New Panelist 
A special survey is used to register new panelists. This survey must include two scripting functions, while a third is 
optional though strongly recommended: 

• One function must check the database before the panelist is registered to ensure the panelist is not 
already in the database, and close the survey if he/she is already included. 

• The second function must register the new panelist’s information. 
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• The third function can remove the panelist's details from the survey on completion of the registration to 
prevent the database continually growing as panelists register (as this will waste space on the server). 

 

Figure 256  Example of a simple Panelist Registration survey 

Note: Security standards built into Confirmit mean that passwords are validated according to the rules 
specified for the panel. The validation procedure will be run whenever a password is changed. Refer to 
the Confirmit Authoring User Guide for further information. 

10.2.1. Checking for Previous Registration 
A panelist must only be registered in a panel database once. The script shown in the figure below checks the 
email address of a prospective panelist against the database and closes the survey if the email address already 
exists. If the email address is unique, then a new row is added to the panelist database. This script is written into 
the Email question’s Question Details > Validation tab. 

 

Figure 257   Example of script to check whether the email address already exists 

10.2.2. Updating the Information 
Once a new panelist has completed the survey, the information he/she has provided must be uploaded to the 
database. An “update” script, an example of which is shown in the figure below, performs this function. 

 

Figure 258  Example of the database registration script 
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10.2.3. Removing the Respondent Data from the Survey 
Once the database is updated, the script example in the figure below deletes all the current respondent 
information from the survey (not the panelist database) to prevent database overload, and then redirects the 
survey. The redirect script is required to prevent the survey returning an error when it notices that it contains no 
data for the current respondent. 

 

Figure 259   Example of script to delete the information from the survey 

10.3. Updating Existing Panelist Information 
Special surveys are used to update the panelist information. These surveys will need to contain a number of 
scripting objects that are used to perform particular functions within the panel database. 

 

Figure 260   Example of a simple Panelist Update survey 

10.3.1. Fetching the Existing Information 
When a panelist wishes to update his/her information, the first operation the survey must perform is to fetch the 
existing data from the database. This will then be used to populate the survey so the panelist can see the current 
information. 

Note: If the password is fetched, it can be updated but for security reasons it will be encrypted such that 
it cannot be read. 

The first object in the survey will therefore be a script object to fetch the data. This will need a script, for example 
that shown in the figure below. 
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Figure 261   Example of script to fetch the data from the database 

10.3.2. Updating the Existing Information 
As when registering a new panelist, the database must be updated with the information. This will require an 
“Update” script object in the survey, containing a script such as that shown in the figure below. 

 

Figure 262  Example of script to update existing panelist information 

Note: If the password is one of the fields fetched, a validation check is performed. If the check fails, the 
update will not be performed. Note also that for security reasons the password will be encrypted such 
that it cannot be read. 

10.3.3. Remove the Respondent Data from the Survey 
As when registering a new panelist, once the database is updated, the current respondent information must be 
removed from the survey to prevent database overload. And again, a redirect script is required to prevent the 
survey returning an error when it notices that it contains no data for the current respondent. 

 

Figure 263  Example of script to delete the response and redirect 

10.4. Updating the Survey History Variables 
You can update values in a survey history record. The only requirement here is that the survey includes a variable 
field called PanelistID. 

 

Figure 264  Example of script to update the Survey History Record 

10.5. Standard Surveys Associated with a Panel 
A regular survey is associated with a panel (go to How to Attach a Panel to the Survey on page 191 for more 
information). An association from a job to a survey is created when the sample is uploaded to the survey using 
the job upload functionality within sampling. A survey is not regarded as “Open” for panelists before the invitations 
have been emailed, unless the job status has been specifically set to “In production” in the sample system. 

There are two ways to status the information from a survey back to the panel: 

• Standard real-time update – some fundamental fields in the panel are maintained continually up-to-date. 
These fields include the status of the survey, Start Date and Completed Date. 
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Note: Confirmit On-Premise customers can switch off the real-time status functionality at site level. 

• Survey rules – this uses batch processing, usually set up to run as a recurring task. Survey rules provide 
much improved flexibility concerning how the panel status is maintained. 

Note that both real-time statusing and batch statusing can be used simultaneously. Batch statusing (explained in 
previous chapters) can be specified to update the panelist fields and survey history fields based on information in 
the survey, panelist level information, survey history level information and limited information from the job. 

Important: 
Surveys using batch statusing must include three “background” variables, named 'JobNumber' 
'RunNumber' and 'PanelistId'. They must be added as background variables in the survey tree, and they 
must be included in the fields uploaded in the sample/job. JobNumber should be an open question node 
with a suitable field width set, while RunNumber and PanelistId must be numerical open questions with a 
suitable number of digits. 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 196 - 

INDEX 

A 

Abort a Sampling Job, 161 

Aborted tab, 21 

Accept Leading Zeros, 14 

Access Community Panels, 3 

Access Permission Levels, 24 

Accessing Community Portals, 25 

Action Tab, 74 

Active Job List, 8, 155 

Active Languages, 6, 17 

Add a Community Portal to your Panel, 26 

Add a Language to the Portal, 28 

Add a Rule to the Rule Set, 82 

Add a Visual Component to the Page, 45 

Add an HTML Table to the Page, 43 

Add an Object to the Tree, 10 

Add columns, 54 

Add Fields to the Selected Fields Column, 116 

Add Group Set (After), 109 

Add Group Set (Below), 109 

Add rows, 54 

Add Sub Sample (After), 109 

Add Sub Sample (Below), 109 

Add Test Panelists to the Database, 131 

Add Users to the Permissions Tab, 23 

Adding a Custom Code, 112 

Adding a Global Custom Code, 112 

Adding a Matrix List, 112 

Additional Items, 93 

Additional Items Tab 

Menu Bar, 116 

Additional Partitions to Process, 187 

Add-on, 75 

Administrator, 17 

Advanced Filter, 62 

Aggregated Variable List, 87 

All, 102, 103 

All Surveys Tab, 64 

Alphabetical Filter, 153 

Apply Filters when Calculating..., 110 

ASAP, 121, 122, 128, 129, 164 

Attach a Panel to the Survey, 191 

Augment Sample Properties, 126 

Augmenting limits, 126 

Auto Exclusion Tab, 98 

Automatic Exclusion 

Including, 105 

Available Jobs, 99 

B 

Basic Sampling, 109 

BitStream Files, 73 

Boolean, 14 

Button 

Add, 116 

Add All, 116 

Back to Dimension List, 143 

Back to Weight List, 147 

Delete, 142, 153 

Delete Weight, 146 

Dimension, 147 

Duplicate, 94, 141, 147 

Execute Job, 118 

Export Job, 94 

Export Matrix, 142 

Import Job, 153 

Job Definition Report, 134 

Move Backward, 159 

Move Forward, 159 

Move Up/Down, 142 

New Dimension, 142 

New Job, 153 

New Weight, 146 

Printer and Save Friendly version, 140, 147 

Refresh, 142, 146, 159 

Remove, 116, 159 

Remove All, 116 

Save, 94, 118, 141, 143, 146 

Search, 116, 153 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 197 - 

Validate Job, 94 

Validate Matrix, 142 

View, 159 

Weight Name, 147 

C 

Categories and Keywords, 20 

Categorization Tree Tab, 169 

Category, 95, 100 

Exclusion, 98 

Select, 97 

Cell properties, 55 

Cellweight, 110 

Change 

Execution Settings, 127 

Job Schedule Settings, 161 

Panel Mailing Date, 131 

Password, 48 

Changes Made to the Survey, 191 

Characteristic, 14, 15 

Check the Job, 96 

Checking for Previous Registration, 192 

Clear Advanced Filter, 63 

Closing Surveys, 60 

Code Completion, 75 

Collapse All, 109 

Collapse Type, 143 

Column Mapping, 79 

Combine Dimensions, 142 

Comment, 130 

Comments, 120, 163 

Community Panel 

Definition Export, 6, 16 

List, 3 

Community Portal, 33 

Designer, 31 

Languages, 28 

Community Portals, 6, 25 

Company, 3, 4, 20, 21, 22 

Completed, 102, 103 

Completed Surveys Tab, 65 

Completed tab, 21 

Completion Rate, 119 

Concurrent Sampling, 162 

Window, 162 

Concurrent Sampling Job List, 163 

Concurrent Sampling List, 163 

Create 

a Cube, 186 

a Duplicate of a Matrix, 148 

a New Aggregated Variable, 87 

a New Community Portal for a Panel, 26 

a New Dimension, 148 

a New Group Set, 113 

a New Job, 153 

a New Matrix, 157 

a New Page, 39 

a New Property Definition, 171 

a New Rule, 85 

a New Rule Set, 87 

a New Sub Sample, 112 

a New Survey Rule Template, 172 

a New Template Definition, 172 

a New Tester Template, 165 

a Page Master, 32 

a Snapshot Panel, 174 

a Weight Set, 150 

an Expression, 107 

Create Default Reports, 178 

Create new cube, 190 

create new reports, 178 

Created, 3, 20, 157 

Created By, 3, 4, 153, 157 

Creation Methods 

Drag and Drop, 10 

Duplicate, 10 

Insert After, 10 

Insert Inside, 10 

Creator, 20 

Credit Balance, 50 

criteria, 93 

Crosstab Report, 136 

Cube Management, 183 

Current Job, 7, 93 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 198 - 

Current Matrix, 7, 141 

Current Rule, 7, 68 

Current Rule Set, 7, 81 

Custom Code, 110 

Adding, 112 

CustomJobStatus, 153 

D 

Data Source, 95 

Data Write Access, 14 

Database Cleanup, 6, 59 

Database Generation, 6, 15 

Date, 14 

Date Exclusion, 98 

Date Exclusion Function 

Set the, 102 

Days Before Closing, 155 

Days Between Augments, 126 

Days to First Augment, 126 

Decimal Places, 14 

Default Code, 111 

Default Value, 14 

Define a Property Item, 171 

Definition Report, 138 

Definition tab, 161 

Delete, 109, 178 

a Job, 154 

a Job from the Execute List, 128 

a Weight Set, 151 

an Object from the Tree, 11 

cells, 54 

columns, 54 

rows, 54 

Deleted, 14 

Deleted (property), 11 

Deployment, 21 

Description, 20, 100, 153 

Deselect a Job, 105 

Designer, 6, 9 

Designer Log, 6, 16 

Details Tab, 63 

dimension, 144 

Dimension 

Create New, 148 

Dimension Name, 143 

Dimensions Tab, 141, 142, 185 

Disable Balancing, 111 

Disable task, 122 

Discard Default Group…, 111 

Disregard in Future Eliminations, 119 

Disregard Sampling Matrix, 109 

Drag and Drop, 10 

Duplicate, 10, 109 

Duplicate a Job, 95 

Duplicate a Matrix, 148 

Duplicate a Rule, 79 

Dynamic language, 30 

E 

Edit, 109 

a Cube, 186 

Edit a Page, 39 

Edit a Page Master, 33 

Edit Profile, 50 

Edit Profile Link, 51 

Editing your Page Masters and Portal Pages, 54 

editor page, 108 

email link, 37 

Email reminder, 125 

Email Sample, 125 

Enforce HTTPS, 21 

excess target, 144 

Exclude All 

checkbox, 101 

Exclude all jobs, 99 

exclusion, 93 

Exclusion 

Category, 98 

Date, 98 

Exclusions, 93 

Exclusions Tab, 97 

Execute a Job, 119 

Execute a Rule, 80 

Execute Job Properties, 163 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 199 - 

Executing tab, 21 

Execution, 93 

Execution Settings 

Change, 127 

Execution Tab, 117 

Execution Time/Date for a Job 

Set the, 121 

Existing Project, 130 

Expand All, 109 

expiry days, 4 

Export 

a Job, 95 

a Matrix, 151 

Export a Community Portal, 53 

Export a Panel Definition, 16 

Export a Rule, 80 

Export Jobs, 153 

Export Panelist Credits, 89 

Export the Sample File, 131 

Expression, 110 

Create, 107 

External fields, 116 

External Fields, 95 

External link, 51 

External Survey Links, 95 

F 

Fetching the Existing Information, 193 

Field name, 116 

Field Names, Search for, 117 

Field Type, 116 

Field Width, 13 

File Upload, 96 

Filter 

Category, 100 

Description, 100 

Job Number, 100 

Mailing Date, 100 

Outgo, 100 

Filter Tab, 106 

Filters, 100 

Job list, 152 

Folders and Structure, 42 

G 

General Information, 3, 134, 139 

General Tab, 68, 81, 141, 167 

Generate Database, 15, 174 

Generate Output File, 120, 163 

Global Custom Code, 110 

Adding, 112 

Group Increment, 114 

Group Set Editor, 111 

Group Set, Create new, 113 

Group Start Code, 114 

groups, 108 

H 

hierarchy column, 108 

How to 

Abort a Sampling Job, 161 

Access Community Panels, 3 

Add a Community Portal to your Panel, 26 

Add a Language to the Portal, 28 

Add a Rule to the Rule Set, 82 

Add a Visual Component to the Page, 45 

Add an HTML Table to the Page, 43 

Add an Object to the Tree, 10 

Add Fields to the Selected Fields Column, 116 

Add Test Panelists to the Database, 131 

Add Test Respondents to the Database, 166 

Add Users to the Permissions Tab, 23 

Attach a Panel to the Survey, 191, 194 

Change the Execution Settings, 127 

Change the Job Schedule Settings, 161 

Change the Panel Mailing Date, 131 

Check the Job, 96 

Create a Cube, 186 

Create a New Aggregated Variable, 87 

Create a New Community Portal for a Panel, 26 

Create a New Dimension, 148 

Create a New Group Set, 113 

Create a New Job, 153 

Create a New Matrix, 157 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 200 - 

Create a New Page, 39 

Create a New Property Definition, 171 

Create a New Rule, 85 

Create a New Rule Set, 87 

Create a New Sub Sample, 112 

Create a New Survey Rule Template, 172 

Create a New Template Definition, 172 

Create a New Tester Template, 165 

Create a Page Master, 32, 40 

Create a Snapshot Panel, 174 

Create a Weight Set, 150 

Create an Expression, 107 

Define a Property Item, 171 

Delete a Job, 154 

Delete a Job from the Execute List, 128 

Delete a Weight Set, 151 

Delete an Object from the Tree, 11 

Deselect a Job, 105 

Duplicate a Job, 95 

Duplicate a Matrix, 148 

Duplicate a Rule, 79 

Edit a Cube, 186 

Edit a Page, 39 

Edit a Page Master, 33 

Execute a Job, 119 

Execute a Rule, 80 

Export a Community Portal, 53 

Export a Job, 95 

Export a Matrix, 151 

Export a Panel Definition, 16 

Export a Rule, 80, 86 

Export Panelist Credits, 89 

Export the Sample File, 131 

Import a Community Portal, 26 

Import a Job, 154 

Import a Matrix, 158 

Import a Panel Definition, 16 

Import a Rule, 81, 86 

Import Panelist Credits, 89 

Include an Automatic Exclusion, 105 

Make the Portal Dynamic, 27 

Make the Portal Language Dynamic, 30 

Manually Exclude a Job, 104 

Publish a Community Portal, 52 

Remove a Job from the Panel, 129 

Remove a Run from the Panel, 128 

Remove Fields from the Selected Fields Column, 
117 

Remove Users from the Permissions Tab, 24 

Run a Concurrent Sampling Job, 163 

Save a Portal as a Template, 53 

Select a Category, 97 

Set the Category Exclusion Function, 101 

Set the Date Exclusion Function, 102 

Set the Execution Time/Date for a Job, 121 

Set the Mailing Date, 100 

Set Up Recurring Tasks, 122 

Undelete an Object, 11, 59 

Upload a File, 96 

Upload the Output File, 129 

Validate a Matrix, 148 

HTML mode, 56 

HTML Table, 43 

I 

iFrames, 50 

Ignore Error, 185 

Images, 56 

Import 

a Job, 154 

a Matrix, 158 

Import a Community Portal, 26 

Import a Panel Definition, 16 

Import a Rule, 86 

Import Panelist Credits, 89 

In progress, 102, 103 

Inactive List, 160 

Incidence Rate, 119 

Include an Automatic Exclusion, 105 

Indexed, 14 

In-line frame, 50 

Insert After, 10 

Insert Inside, 10 

Instances Tab, 132 

Introduction, 1 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 201 - 

Invitation sent, 102 

Invited, 103 

J 

Job 

Check, 96 

Create New, 153 

Delete, 154 

Description, 94 

Deselect, 105 

Details, 134, 139 

Duplicate, 95 

Execution Area, 118 

Export, 95 

Filters, 100 

Import, 154 

Information, 93 

Information Tab, 94 

List, 7, 93, 152 

Manually exclude, 104 

Number, 94, 100, 152, 155 

Properties, 95 

Reporting Area, 133 

Status, 95, 134 

Job Definition Report, 138 

Job List 

Filters, 152 

Toolbar, 153 

Job Runs Area, 119, 136 

Job Runs list, 138 

Job Schedule Settings, Change, 161 

K 

Keywords, 3 

L 

Language, 30 

Language Selector, 48 

Languages, 20 

Last Job Used, 157 

Last Modified, 21 

Last Used, 157 

Legacy Jobs Import, 17 

Link Target, 51 

Log Entry column, 160 

Login, 47 

login attempts, 4, 5 

Login Name, 48 

Login Status, 48 

Lower/Upper Limit, 14 

Lower/Upper Limit Type, 14 

M 

Mailing Date, 95, 100, 153, 155 

Set the, 100 

Make the Portal Dynamic, 27 

Manage Available matrices, 110 

Managing your Community Portal Templates, 53 

Managing your Community Portal within your Panel, 
53 

Managing your Community Portals, 52 

Manual Exclusion Tab, 99 

Manually Exclude a Job, 104 

Manually Excluded and Included Jobs, 99 

Matrix 

Create New, 157 

Duplicate, 148 

Export, 151 

Import, 158 

Validate, 148 

Matrix List, 8, 109, 156 

Adding, 112 

Matrix List Window, 8 

Measures tab, 185 

Menu 

Panel Management, 7, 61 

Panel Setup, 6, 9 

Panel Utilities, 6, 19 

Sample Management, 7, 93 

Microsoft Report Builder, 178 

Modified, 157 

Modified By, 157 

Multiple Panelist Editor, 7, 65 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 202 - 

N 

Name, 157 

Navigator and Navigator Path, 48 

New Keyword, 20 

New Objects Toolbox, 11 

New Project, 130 

New Report, 178 

New Target Factor, 126 

Nominal, 143 

Nominal Collapsing, 144 

Non-collapsing adjust targets, 143 

Non-Collapsing Adjust Targets, 145 

Non-collapsing keep targets, 143 

Non-Collapsing Keep Targets, 145 

Number of Augments, 126 

Number of Groups, 114 

Numeric, 14 

O 

Objects, 10 

Ordinal, 143 

Ordinal Collapsing, 144 

Original Cellweight, 110 

Outgo, 100, 153 

Outgo Report, 136 

Outgo Report Excel, 140 

Outgo Report HTML, 139 

Output Field Templates Tab, 171 

Output File, Upload, 129 

Overview, 6, 19 

Ownership Tab, 133 

P 

Page Area, 46 

Page Masters Folder, 32 

Page Properties, 41 

Pages Folder, 39 

Panel, 93 

Panel Activity Log, 6, 57 

Panel fields, 116 

Panel ID, 3, 20 

Panel Management Menu, 7, 61 

Panel Name, 3, 20 

Panel Settings, 91 

Panel Setup Menu, 6, 9 

Panel Updated column, 129 

Panel Utilities Menu, 6, 19 

Panel Variables Toolbox, 10 

panelist, 93 

Panelist Credits, 7, 89 

Panelist Editor Tabs, 63 

Parameters Tab, 132 

Password Policy, 4 

Password Recovery, 48 

Percent, 114 

Period, 22 

Permissions Tab, 22 

Portal, 30 

Portal Code property, 28 

Portal Code Variable, 27 

Preapproved, 119 

Process full, 190 

Process incremental, 190 

Process none, 190 

Project ID, 22, 79, 130 

Project Manager, 153 

Project Tasks button, 21 

Properties 

cell, 55 

table, 54 

Properties on a Community Portal, 51 

Properties Tab, 132 

Property Definitions Tab, 170 

Property exclusion, 99 

Publish a Community Portal, 52 

Q 

Question Category, 14 

Question Details Page, 13 

Question Properties, 13 

Quick Access pane, 3 

R 

Rebuild Sample File, 119 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 203 - 

Recurr Tab, 132 

Recurrence Pattern Type, 123 

Recurrence tab, 161 

Recurring, 22 

Recurring tab, 21 

Recurring task, 122 

Recurring Task, 122 

Recurring Tasks 

Set up, 122 

Recurring Tasks button, 21 

Refresh, 109 

Refresh Survey History Job Information, 169 

Registering a New Panelist, 191 

reminder email, 125 

Remove a Job from the Panel, 129 

Remove a Run from the Panel, 128 

Remove Fields from Selected Fields Column, 117 

Remove Job From Panel, 119 

Remove Respondent Data from the Survey, 193 

Remove Users from the Permissions Tab, 24 

Removing Respondent Data from Survey, 194 

Report General tab, 178 

Report List, 178 

Report Number, 22 

Report page designer 

HTML mode, 56 

images, 56 

text, 56 

Report Tab, 83, 141, 147 

Reporting, 94 

Reporting Tab, 133 

Repost Sample, 129 

Reserved, 102, 103 

Right-Click Menu, 109 

Rule List, 7, 84 

Rule Management Tab, 82 

Rule Set List, 7, 86 

Run a Concurrent Sampling Job, 163 

Run Number, 155 

S 

sample, 145 

Sample Definition Tab, 108 

Sample file, 131 

Sample File Fields 

Tab, 115 

Sample management, 93 

Sample Management Menu, 7 

Sampling Algorithm, 168 

Sampling Job 

Abort, 161 

Sampling Jobs List, 159 

Sampling Settings, 8, 166 

Save a Portal as a Template, 53 

scarce resources, 162 

Schedule, 22, 123 

Schedule for later execution, 121, 128, 129, 164 

Scheduled tab, 21 

Scheduling, 8, 159 

Search, 61, 106, 178 

Search tab, 21 

Searching for Field Names, 117 

Secondary Project Toolbox, 12 

segment, 144, 145 

Select a Category, 97 

Select Columns, 61 

Selected Matrix, 110 

Selected Panelist Dimensions, 185 

Selected Survey History Dimensions, 185 

Sequential Sampling, 162 

Server, 21, 22 

Set the Date Exclusion Function, 102 

Set the Execution Time/Date for a Job, 121 

Set the Mailing Date, 100 

Set Up Recurring Tasks, 122 

shortage, 144 

Single Panelist Editor, 7, 61 

Snapshot Months, 187 

Snapshot Panel, 21 

Source Tab, 69 

Source Type > BitStream Files, 73 

Source Type > Database, 71 

Source Type > File, 69 

Source Type > Panel Database, 71 



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 204 - 

Source Type > Survey, 72 

Specify Auto Exclusion, 99 

Standard real-time update, 194 

Standard Surveys Associated with a Panel, 194 

Start Time, 121, 128, 129, 163 

Status, 21, 22, 153, 155 

Stopped by system, 102, 103 

Styles, 33, 37 

Sub Sample, 140 

Create new, 112 

Sub Sample Information, 134, 139 

Sub Sample Name, 110 

Sub Samples, 93 

Summary, 157 

Survey History Months, 187 

Survey History Variables, 194 

Survey Rule Templates Tab, 172 

Survey rules, 195 

Survey Sync, 7, 60 

Surveys List, 49 

Surveys Not Started Tab, 65 

Surveys Started Not Completed Tab, 65 

T 

Tab 

Additional Items, 93 

Auto Exclusion, 98 

Exclusions, 93, 97 

Execution, 93, 117 

Filter, 106 

Job Information, 93 

Manual Exclusion, 99 

Reporting, 94 

Sample Definition, 108 

Sample File Fields, 115 

Sub Samples, 93 

Universal Criteria, 93 

Table, 43 

add colums, 54 

add rows, 54 

background color, 55 

cell padding, 55 

cell properties, 55 

cell spacing, 55 

delete cell, 54 

delete column, 54 

delete row, 54 

height, 55 

properties, 54 

width, 55 

Target, 114 

Target for Calculation Diff, 127 

target sample, 145 

Target Tab, 77 

Target Type > BitStream Files, 78 

Target Type > Database, 78 

Target Type > File, 77 

Target Type > Panel Database, 78 

Task Definition Properties Dialog, 132 

Task ID, 22 

Task Log window, 160 

Task Owner, 133 

Task type, 22 

Task Type, 21 

Tasks Page, 21 

Test Database, 125, 130 

Tester Template List, 8, 165 

Testing your Community Portal, 53 

Text, 51, 56 

The Cube Details > General tab, 184 

Theme Code, 34, 37 

Theme Selector, 34, 49 

Themes Folder, 33 

Time and date fields, 122 

toolbox, 12 

Total Digits, 14 

Total target, 110 

U 

Undelete an Object, 11 

Unique, 14 

Universal Criteria, 93 

Update cube, 190 

Update Panel, 120, 163 



 
Confirmit Confidential Confirmit 14 Community Panels User Guide

  

- 205 - 

Updating Existing Panelist Information, 193 

Updating the Existing Information, 194 

Updating the Survey History Variables, 194 

Upload a File, 96 

Upload Sample Properties, 124, 126 

Upload the Output File, 129 

Use Dynamic Targets, 110 

User ID, 22 

V 

Validate a Matrix, 148 

Validating an Action Script, 80 

View Stylesheet Contents, 38 

Virtual Variable List, 7 

Visual Components, 43 

Visual Components toolbox, 45 

Visual Components Toolbox, 46 

W 

Weight Parameter, 111 

weight ratio, 145 

Weight Set 

Create, 150 

Delete, 151 

Weights Tab, 141, 145 

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  



 
Confirmit 14 Community Panels User Guide Confirmit Confidential

  

- 206 - 

 


